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Unit 1: Introduction to Excel  

Learning Outcomes 

1. Learners will be able to define business analytics and explain the significance of Excel in business 

analytics processes. 

2. Learners will comprehend various data types, formats, and methods of importing data into Excel to 

facilitate data analysis. 

3. Learners will identify key functionalities of Excel used for data review and analysis in business 

decision-making. 

4. Learners will apply Excel tools to organize, manipulate, and visualize data effectively to support 

business insights. 

 

Content 

1.0  Introductory Caselet 

1.1    Introduction to Business Analytics and the Importance of Excel 

1.2  Data Types and Formats in Excel 

1.3  Methods of Importing and Reviewing Data in Excel 

1.4  Key Functionalities of Excel for Data Analysis 

1.5  Summary 

1.6  Key Terms 

1.7  Descriptive Questions 

1.8  References 

1.9  Case Study 

 

 

 

1.0 Introductory Caselet 

 

Get Data Smart: How to Use Excel and SQL to Discover Business Insights كتب " Get Data Smart: 

How to Use Excel and SQL to Discover Business Insights" 

Neha is a new business analyst who has recently joined a fast growing e-commerce startup. Her 

manager requests that she research how customers shop to determine any patterns and improve sales 
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strategies. Neha is excited but a bit daunted: She knows she has lots and lots of sales data in various 

shapes — CSV files, Excel spreadsheets and even data scraped from the company’s online store. 

Along the way, she faces several difficulties after starting to work. Organising data There are several 

things Lorraine finds herself struggling to organise data in a way that makes sense and is effective: 

She’s always bending over backwards trying to find the most important metrics she needs to track 

Her eyes hurt just for trying to spot increasing/decreasing trends. She knows that Excel is powerful 

to analyze the data but she doesn’t know how to harness its features in the right manner. How does 

she clean and structure this data? What skills will she apply when solving problems? How can she 

produce more than just a set of visualizations to show her team? 

Neha knows that she has nothing to lose and everything to gain by learning how to do business 

analytics in Excel – not only in her current job, but also in her opportunity to make evidence-based 

decisions. As she navigates through this process, she has decided to investigate various data types, 

importing avenues and major Excel functions that will help to take raw data to shinning business 

insights. 

 

Critical Thinking Question 

How can Neha use Excel's data analysis tools to clean up, sort and find hidden gems about customer 

purchase patterns in order to help her company make better sales categories? 

 

1.1 Introduction to Business Analytics and the Importance of Excel 

 

Business analysis is particularly useful in structuring data of what has happened and applying 

scientific methods to business data to predict, steer and make decisions towards organizational goals. 

Data-driven: Business users employ statistical tools and visual data models to uncover what their 

businesses’ data has to say about trends and relationships. In today’s rapidly changing business 

environment, analytics enables companies to differentiate themselves from competition, to do it 

better with customer satisfaction. 

Studies Signs typically generate vast bodies of data from their various customer purchase records, 

market trends and other company activities. When this data is analyzed properly, organizations are 

able to: 

●  Drive smarter and faster decisions by using data-driven insights. 

● Discover better business paths and identify weak points in your operational system with data. 

● Analyze market trends to combine a plan to safeguard our future business. 

● Learn how customers behave and what they prefer to inform better service. 

1
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Significance of Excel in Business Analysis 

 

 

Fig 1.1 Microsoft Excel 

 

 

Microsoft Excel remains the leader in business analytics tool usage because of its ease of access, 

easy use and great ability for data processing. 

Many organizations of all sizes rely on Excel to produce incredibly powerful and complex data 

manipulation for everything from managment, analysis and generating Power Points. 

Some of the Factors that Determine the Significance Of Excel in Business Analytics : 

Data Organization and Management: 

●  The data set management capabilities such as tables, the filters, and the sorting systems in 

microsoft excel helps business users to manage large volumes of data efficiently. 

●  Organisations require Excel to maintain data, recover records and manipulate the data in 

structured formats. 

Data Analysis Tools: 

● ● Based on data analysis, using built-in Excel function like SUM, AVERAGE, VLOOKUP and 

INDEX/MATCH to help users. 

PivotTables can handle amounts of data easily with a simple, fast summary engine. Visualization 

Capabilities: 
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● Excel helps you to create effective data visualization tools (bar chart, pie chart, line and 

histogram). 

● With conditional formatting, you can highlight important data trends or track the unusual or 

unexpected. 

Statistical and Predictive Analysis: 

● More analysis features such as regression analysis pair with trend lines and forecasting tools to 

help you better identify variance, trends and patterns. 

● Users can avail some advanced statistical features via the Analysis ToolPak add-in. 

Automation with Macros: 

With macros and VBA (Visual Basic for Applications). Excel performs the automatic repetition of 

a same task assuming that no two tasks are identical. 

● They help save time and data processing power and are faster. Scenario Analysis and Decision 

Making: 

● Companies have strong tools to analyze the many possible outcomes and even input various 

variables by using Goal Seek and Scenario Manager. 

● Assists with financial modeling and strategic planning. Cost-Effective and User-Friendly: 

Excel can be an inexpensive analytics tool, but it demands literacy with the package before you 

begin using it. 

It works on all platforms so users can deprive it from all over the globe. Typical Business Analysis 

Stats with Excel 

· Sales Analysis: Used as tools for analysis, to aid in recognizing best sellers and help forecast of 

what the customers will want next. 

· Financials: You are updated with their user created Balance Sheets, Income Statements as well as 

Budget forecasts by their key Financial statements. 

· Stock Control- Tracking stock capacity and purchasing patterns. 

Marketing Analytics - It’s to do with the comparison of marketing result as against specific customer 

markets data. 

· HR Analysis: Analysing the employee ranking and employee's attrition. 

 

 

1.1.1 Types of Business Analytics 

Business analytics comes in three flavors —none of which taste like Braums—and each type offers 

insights that help companies make smarter decisions. 
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Fig 1.2 Types of Business Analytics 

 

Descriptive Analytics 

take action to improve outcomes. Purpose of Descriptive Analytics: 

This allows organisations to see the corporate history at business and topic level. 

How Descriptive Analytics Helps: 1. 

combinations of products they purchase. 

reduction of their sale productivity and customer feedbacks. 

orders this quarter, they generated the sales that they were hoping for. 

Data-Driven Decision-Making: Companies use learnings to make informed decisions about the 

future. In the light of our research, some findings are important for offering us more effective 

recommendations for planning business development in the future. 

 

Descriptive Analytics Use Cases: 

Retail: Past sales data allow store owners to understand which products yield the highest sales for 

various Seasons. 

Example: Walmart looks at past sales data so it can order products that have a track record of being 

in style, such as winter wear or barbecue goods during their seasons. Amazon works through 

customer purchase data by adjusting their stocking strategy and making product recommendations 

in times when previous customers have purchased similar items. 

Health care: Hospital workers analyze clinical data to identify when flu infections occur most 

frequently within each year. 

Example: The US Centers for Disease Control and Prevention (CDC), which is drawing on data 

submitted by health care professionals, tracks flu trends when hospitals are being forecast for demand 

in busy times. 

They were using descriptive analytics to observe day-to-day numbers of patient admissions with 

COVID-19 in order to reserve scarce resources like Intensive Care Unit (ICU) beds and ventilators. 

2
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Finance: A company analyzes its latest finance data each quarter to discover patterns of change in 

revenue and spending. They find this annual sales high in the fourth quarter and, as a result, push 

above-average sales efforts during the season. 

Example: Utilizing transaction data from Mastercard, Scrapped provides descriptive analysis, of 

interest to financial institutions in identifying when habitual consumer spending cycles occur. 

The PayPal analytical platform analyses historical flow data between customers and the company, 

to understand patterns of customer behaviour during different times of day which can then inform 

fraud protection. 

Marketing: Business analyses the performance of its most recent social media campaign through 

social media metrics (like, comments, shares). Their data insights can help them understand what 

types of content is working and how to better plan the next step. 

Case and Point: Coca-Cola measures 'Share a Coke' success by examining social media how. They 

use the information in future strategic planning for upcoming marketing efforts. Since Spotify 

collects information about user listens, the service knows what's trending musically from season to 

season—enough so that it can plan its promotional schedule accordingly including the popular 

"Wrapped" year-in-review promotion. 

E-commerce: It doesn’t guess at web traffic, but instead uses data to show how frequently customers 

visit each product category. They then use this information to figure out what their buyers want most 

so they can put adequate focus on their ad promotions. 

For example: Shopify and Flipkart track consumer interactions to measure statistics like page views 

and time spent in category against electronics or clothing. It thanks to the tracking system that they 

are able to identify the most visited areas of their products and directly advertise with precision 

based on customer taste. 
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Fig 1.3 Examples of Descriptive Analytics 

 

Did you know? 

● 80% of Business Insights is from descriptive analytics enabling businesses to compile historical 

data to take actionable decisions. 

● 65% of Organisations look to descriptive analytics to monitor performance, and uncover 

operational efficiencies. 

●   In businesses, 90% of Data Analysis Efforts are only used to understand past performance 

(descriptive analytics). 

KPIs: Public organizations monitor operational success with certain key performance indicators that 

allow for monitoring of operations across domains. They evaluate productivity by monitoring 

numbers of dollars, up-to the minute-sales velocity and cost of acquiring new customers to product 

flow speed throughout their systems. KPIs are relied on by organizations to measure how well they 

have achieved their goals the metrics used to measure what specifically constitutes success. 

Trend Analysis: Future forecast of business performance based on analysis of changes in data 

collected over time. Product supply time when you open a store is calculated by analyzing user 

movement pattern with high season sales information. 

 

Predictive Analytics 
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Statistical model but data-driven with ML algorithm In predictive analytics, the primary analysis in 

predicting future market movements is statistical model but it's data-driven using machine learning 

algorithm. Predictive analytics allows companies to base their decisions on historical data and learn 

from it, predict risk areas, as well as discovering new growth opportunities. By doing so, businesses 

can be warned of potential problems and seize opportunities to expand, or to optimise its operations 

leading into an educated decision-making process. Business operations rely heavily on predictive 

analytics as an instrument of strategy for organizational functioning. 

Did You Know? 

Predictive Analytics-Healthcare: In this space, predictive analytics is used to predict patient health 

condition which enables care delivery before it becomes a problem and refining treatment. 

Purpose of Predictive Analytics 

What Predictive Analytics Aims to Do: It is the goal of predictive analytics, in a nutshell, to reveal 

data patterns and gain insight from what is already known about a situation by using that knowledge 

to build predictive models capable of forecasting future outcomes. It allows businesses to: 

● Strategic shifts will also make it necessary to anticipate the next ones. 

Administrative practice for identifying potential systematic errors is predictive. Predictive analytics 

ensures that operational efficiency is optimized by forecasting market predictions and dispensing 

the necessary resources. 

● Individual service delivery will follow by predicting consumer behavior patterns and serve their 

customers in a better way. 

 

 

 

Fig 1.4 Examples of Predictive Analytics 
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Retail: 

Use Case: Sample customer purchase behaviours and seasonal patterns as Data input to the 

forecasting model that retailers use for future revenue numbers wants. By an analysis on a consumer 

profile (customer information) and preference of a product in a market, items can be predicted 

effectively so that inventory management can be determined. 

Benefit: With this insight, businesses can improve inventory management practices down to 

minimizing inventory waste and run more effective marketing campaigns. Personalized 

recommendation from predictive analytics retailers Generate etailers gives a personalized 

recommendation to each of its customer that will not just create more sales but the loyalty for their 

customer as well. 

Example: 

Amazon: Transforming its recommendation system Amazon also employs predictive analytics - 

asymptotic improvement in automating data with buying behaviour and customer preferences 

together as well as personal browsing information. It's the personalized recommending feature that 

makes majority of Amazon's revenue, by pushing big chunks of sales through these 

recommendations. 

Walmart- Retail giants such as Walmart leverage predictive analytics to analyze customer’s purchase 

history, browsing behaviour and other demography related data, and make personalized product 

recommendations. For example, if a customer is more likely to shop for apparel items more 

frequently, the system would understand that they may now need new ones and analyze what clothing 

they may own in terms of shoes, shirts and pants etc. keeping that item context in mind it should be 

suggesting relevant clothes to them. In fact, it enhances customer experience and increases sales and 

customer retention. 

Healthcare: 

Usage: Integration of patient history, treatment schedule and demographic information by clinical 

experts is useful for readmissions prediction. The predictive model helps determine which patients 

are more likely to experience complications and to be re-admitted to the hospital. 

Advantage: Investigating via predictive modelling contributes to personalised clinical treatment 

leading to improved patient outcomes without imposing additional hospital costs. They can predict 

diabetes and cancer because they find the signs of potential health problems before fully fledged 

symptoms become apparent, so that doctors can act early. 

Example: 

14
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Johns Hopkins Medicine: The hospital tracks ICU patient status via predictive data analytics that 

recedes through clinical signs to detect early warning signals of impending medical conditions (and 

preempt complications). 

Blue Shield of California: Predictive analytics Blue Shield looked at claims information when 

evaluating patient history to direct preventive care at those expected to be high risk, thus driving 

down usage of the emergency room for customer visits. 

Finance: 

Application:In predictive modelling, the client’s behaviour and clean financial data is utilized by 

lenders to measure the risk estimation of loan defaulter using the credit score and income levels. 

The platform enables businesses identify its at risk borrower profiles. 

Benefit:Utilizing predictive analytics and operations assists decision maker in superior decision 

making across all stages of credit underwriting, which leads to reduction in NPL. Predictive 

analytics software allows for instant discovery of suspicious spending. 

Example: 

JPMorgan Chase: The bank employs predictive analytics to understand whether a transaction is 

fraudulent by comparing recent behavior to historical performance data and spotting outliers. 

FICO Score: The FICO model is the predictive modeling of an individual's likelihood to pay that 

becomes a tool for banks to priice credit and other interest items. 

Supply Chain Management: 

For example, businesses employ market trend analysis and incorporate it with customer information 

to predict future inventory needs and vendor shipping performance. With predictive analytics 

companies to make more informed decisions regarding their procurement systems and supply chain 

inventory control. 

Pro #4: Enables companies to avoid overstock and out-of-stock of inventory, ensuring smooth flow 

in supply chain operation. Businesses that leverage predictive analytics increase their capability to 

forecast demand, manage suppliers and schedule deliveries. 

Example: 

Procter & Gamble (P&G): Utilizing Predictive Analytics, P&G is able to reduce inventory levels by 

slotting written demand patterns and vendor performance in Logistics Costs as well as by increasing 

Manufacturing Productivity. 

UPS: The company’s advanced forecasting uses data on previous traffic activity, weather and 

delivery times to develop the most efficient delivery routes which reduce fuel idling time. 

Human Resources: 
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Use Case: Predictive models use employee work place morale measurements and to identify 

expected employee attrition events, along with the profitability of said turnover. 

Benefit By focusing on retention and employee engagement, HR dept’s can develop effective 

programs that reduce the cost of search and training by maintaining continuity and decreasing time 

to proficiency. Companies find emerging leaders via predictive models analysis. 

Example: 

IBM: At IBM, predictive analytics allows the company to predict the workforce by analysing 

satisfaction with travel time and compensation benefits. Early identification allows the organization 

to pursue preventative retention measures which eliminate future costs of hiring and training their 

replacement. 

Google: Better retention and heightened employee engagement are achievable if Google can analyze 

performance results with employee surveys also measuring data about the workplace. 

Diagnostic Analytics 

Diagnostic analytics- This is the business analytics that concentrates on why things are happened in 

past and also to support future pulling. It falls in the middle of Descriptive Analytics (tells us what 

happened) and Predictive Analytics (tells us what will happen). Diagnostic Analytics Diagnostic 

Analytics allows organizations to identify patterns, correlations and causal factors that influence 

business performance, typically accomplished with the help of various statistical techniques an data 

exploration methods. 

Objectives of Diagnostic Analytics: 

Break down the business trend of problem observed into its practical elemental causes. 

· Pattern Recognition: HT study some of the relations between a number of factors in the past data. 

· Dynamic Decision Support – Stream actuating data that impact operational outcomes. 

· Predictive and Prescriptive Analytics Interface An interface to the forecasting (predictive) models, 

the planning/optimization (prescriptive) models via the Management Model. 

Key Techniques in Diagnostic Analytics: 

· Drill-Down and Exploratory Analysis – Effortlessly break down aggregate statistical information 

for diluted root cause analysis. 

· Correlation and Regression -To determine how much the variables are related and to establish 

cause and effect. 

· RCA (Root Cause Analysis) – Identifying what has led the business logic to its current result. 

· HTS Analysis – Discovering patterns and anomaly behaviors by modeling historical trends over 

time. 

4
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· Comparative Analytics – Comparing datasets in different time periods, territories or lines of 

business to discover differences. 

Use Cases of Diagnostic Analytics in Business: 

· Finance: Reasons for decreasing income (changing market) or changes in consumer behavior. 

• Health: Why hospital readmissions spiked by looking at patients’ back stories and medical 

outcomes. 

· Marketing: Explanation about why a recent ad campaign that did not perform well, based on 

engagement rates, demographic response, and environmental factors. 

Supply Chain Management: Uncovering the cause of logistical delays is part of supply chain 

management, reviewing shipping logs and a suppliers' performance. 

Diagnostic Analytics as Part of the Business Analytics Model: 

Diagnostic Analytics is a part of the process in data-driven decision-making, it falls between 

Descriptive and Predictive Analytics: 

· Descriptive Analytics: What has happened? → Captures history and trends. 

· Diagnostic Analytics: What happened? → Explores causes and correlations. 

·? Predictive Analysis – what might happen next? → Trend in variables considering the previous 

information. 

· Treatise: How will it be done? → Suggests you the best possible move as per estimation. 

 

Prescriptive analytic 

Prescriptive analytic appliances deliver actionable suggestions that help improve predictions and 

decisions, while deploying neural networks to analyze data for trends are used to predict optimal 

results. This tool is utilized in practically all sectors of the economy to optimize processes and offer 

innovations that contribute to the satisfaction of customers. 
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Fig 1.5 Prescriptive Analytics 

 

8 – Retail: Prescriptive analytics are used in retail to develop bespoke customer experiences and to 

maximise inventory holding. 

Examples: 

· Personalized Product Offer: The analytics recommends the product based on the specific customer 

preferences from customers’ browsing and buying behaviour for such retailers. 

Advantage: By incorporating better customer satisfaction, there would be an advantage of reduced 

inventory cost and increase in sales performance. 

Healthcare: To create better care results, cost savings and efficiently used resources in operation, 

healthcare institutions use prescriptive analytics. 

Example: 

· Treatment Recommendations: The system processes patient data from clinical records and 

determines the executive-driven recommendations for ideal care that can be given in terms of 

available resources. 

Finance: Prescriptive analytics allows financial institutions to make decisions by providing them 

with actionable insight on investment opportunities, and is used to design better risk management 

processes as well as fraud detection algorithms. 

Examples: 

· Investment Consultation: Banks and other financial institutions use market analysis, financial risk 

evaluation and detailed investor profiles to construct tailor-made investment plan for clients.’ 
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· Fraud Protection: Electronic systems are checked by computers provided by the financial 

companies which help to minimize fraud. 

Operations: This approach in prescriptive analytics enables organizations to further optimize their 

logistics networks & supply chain management, and employee services - thereby reducing costs 

while improving efficiency. 

Examples: 

· Route Optimization: By means of prescriptive analytics, logistics companies can write the best 

delivery routes that maximize speed and minimize fuel burn. 

· United Parcel Service million gallons of day by basically was conserving diesel fuel, if you want 

to look at it that way, routing and optimizing delivery routes through their ORION system. 

\\, with a demand pattern dependent type so that both the effectivity and the expense are minimized. 

Marketing: 

Through the use of prescriptive analytics, marketers know exactly where to spend budget with 

maximum impact and can stretch their campaigns into highly measurable outcomes. 

Examples: 

Advertising budget optimization: Prescriptive analytics recommends how best to allocate 

advertising budgets by accounting for expectations surrounding the return of investment of 

advertising on different mediums. 

Google Ads prescriptive analytics will suggest where to move budget to deliver the best 

performance in a campaign. 

Customer segmentation and engagement : By using prescriptive analytics, organizations can 

identify profitable customer groups and design ‘intelligent’ engagement strategies for each. 

Coca-Cola uses prescriptive analytics in order to create programs that appeal to consumers. 

Benefits: The most effective Prescriptive Analytics is perfect for a few reasons: it maximises your 

Marketing Return on Investment in two ways1 and delivers increased customer engagement and, 

ultimately, more Conversions. 

 

 

 

Activity: Business Data Analysis with Excel 

 

The idea is that companies use data to make better decisions. As a business analyst, you need to 

analyze a company’s sales data in Excel for trends and insights. 

Instructions: 
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Choose a Source Dataset You must use some set of data that we can work with (some example 

sample data is provided) - e.g. sales units, product types, customer localities, or dates of purchase. 

Format Data in Excel: Place your data into an Excel table and use the sorting and filtering capabilities 

to easily target specific types of dates. 

Analyse Data: Calculate analytics in Excel, use basic Excel functions like SUM, AVERAGE and 

COUNTIF to get the total sales, average revenue per region, how many products were sold by each 

category. 

Visualize the Data: Create charts and graphs (such as bar charts, line charts, and pie charts) to 

illustrate sales trends and highlight key patterns. 

Leverage Conditional Formatting: Highlight top-performing products through conditional 

formatting to easily identify best-selling items. 

Make Data-Driven Recommendations 

Respond to the following according to your reading: 

The bestselling products/locations? 

What is the sales pattern overtime that you observe? 

What should the company do to increase sales in light of your information? 

 

 

1.2 Data Types and Formats in Excel 

Data types and format in ExcelDifferent formats are used in the management of data in Excel. 

In Excel, handlers can process and also visualize their information when they doing the analysis. I 

need (due to the fact that they play a critical role" in ensuring business accuracy via e.g Financial 

Modelling, Data Analysis & Reporting when using Microsoft Excel"..:)) to have good knowledge 

of "Data Types and their formatting techniques." 

 

How toRecognizedе Different Kinds of Data in Excel 

In Excel you can check what type of data a cell or range of cells contain by selecting the cell in 

question and right-clicking. Then, click on Format Cells. The available data types (for example, 

Number, Date, or Text) will be shown in the Number tab here. 

1
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   Fig 1.7 Selecting the Format Cell Option    Fig 1.8 List of Data Types in Excel 

 

 

Or, you can go to the Number group on the Home tab and see a few data types. 

 

 

Fig 1.9 Data Types in Excel 

 

1.2.1 Data Types in Excel 

17
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Excel Data Types specifies the kind of value stored in a data set. Adequate comprehension on 

different data types is indispensable to support good practices when analyzing and visualising the 

data, while trying to take decisions. In Excel, data can typically be sorted into one of two groups: 

Numerical (Quantitative) Data and Categorical (Qualitative) Data. 

Numerical Data (Quantitative Data) 

Numerical data are numbers which can be assigned a numerical value. Again it is of two types: 

Discrete Data: 

·  Made up of numbers that can be counted. 

·   It is not divisible into smaller units in a meaningful way. 

Examples: 

\begin{itemize} \item The size of a class (\textit{\textbf{e.g.}\ 25, 30}). 

· Number of parking cars. 

·   Quantity of selling within a 24-hour period. 

Continuous Data: 

Describes values that can be represented as a number within a range. Includes decimal or fractional 

values. 

Examples: 

·   Height of a person (5.8 ft). 

·   Temperature (such as 37.5 C). 

· Distance traveled by a vehicle (e.g., 12.4 km). 

Categorical Data (Qualitative Data) 

mcat:C01" category13-id="LC4_bucketCats tractable.type : A property of some data model cases 

that allows factoring a list into the base of an expression and a multiple inside might also include 

numbers for categorical attributes) Categorical: Non-numeric values used to classify objects into 

groups or labels. It is divided into two types: 

Nominal Data: 

Symbolizes or annotates categories as unordered or unranked. For labeling only. 

Examples: 

·   Product attributes (Red, Blue, Green). 

·   Types of fruits (Apple, Banana, Mango). 

·   sex (Male, Female, Other). 

Ordinal Data: 

· Symbolizes or tags categories/items with a meaningful order over ranking. 

· R is not a symmetrical function of ranks. 

10

20

Page 21 of 50 - Integrity Submission Submission ID trn:oid:::3618:127056669

Page 21 of 50 - Integrity Submission Submission ID trn:oid:::3618:127056669



Examples: 

·   Satisfaction of customers is (Low, Medium and High). 

· Level of schooling (Primary, Secondary, Tertiary). 

· Ratings for movies (1 star, 2 stars, 3 stars etc.). 

 

1.2.2 Data Formatting in Excel 

In Microsoft Excel, the data entered in a worksheet is all formatted using the same format by default 

and this tends to make the data look monotonous, drab and downright confusing. It features a 

formatting toolspool which allow you to manipulate data in way that its meaningfulness is retained 

and only the appearance of it modified. 

How to format in Excel? 

Below is the procedure for applying the formatting: 

● Choose the range of cells to apply the format to. 

●   Chose the correct formatting instrument in the toolbox. 

●   Style is viewable on the sheet. 

Contain formatting tools for text and the cell in appearance that In the Home Tab [ Font Group ] on 

the Ribbon. 

 

Fig 1.12 Formatting in Excel 

 

Font 

The font parameter will alter the way text is written in Excel. There are plenty of fonts to select 

from when it comes time to make data look professional, fun or just plain different. 

How to Apply: 

● Highlight the cell(s) you wish to format. 

·  Select the Home tab in the ribbon. 

●  Click on the Font drop down arrow and select a font style (e.g., Arial, Calibri, Times New 

Roman). 

Example: 

4
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A cell would look goofy in a “Comic Sans MS” font, but formal in a “Times New Roman.” 

Font Size 

 

Fig 1.13 Fonts in Excel 

 

 

93.Binding source : With this selection you have option to change the text size within a cell,..you 

can make it bold or Make it smaller as per your content looks good and readable. 

How to do it: 

● Click on the cell(s) that you would like chosen. 

● From the Home tab, scroll down to Font Size. 

● Select a size of 10, 12 or 14 point. 

 

Fig 1.14 Font Size in Excel 
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Fig 1.15 Increase/Decrease Font Size 

 

Example: 

A font size of 16 makes the text easily readable for presentations, whilst a size 10 is great for tight 

reports. 

Increase/Decrease Font Size 

Rather than click on a point size, you can apply them, quick as a mouseclick with the 

increase/decrease capacity. 

How to Use 

●  Highlight the text you want to change. 

Click the Increase Font Size button A▲ on the Home tab or Decrease Font Size button A▼ on the 

Home tab. 

 

Fig 1.16 Bold/Italic in Excel 

 

 

Example: 

3
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If you ever come across text in a cell that is just too small to read, press the increase button once or 

twice and everything will instantly become readable. 

Bold and Italic 

For marking information and identifying the most important datapoints. 

Bold (B): 

●   Thickens and darkens text. 

● Extremely helpful when emphasising headwords or important values. 

Italic (I): 

● Slants the text, it has a special look which you may like or dislike. 

● Flagged for special information or references. 

How to Apply: 

● Highlight the text. 

●  Please find the B for bold or I for italic in Home tab. 

 

Fig 1.15 Increase/Decrease Font Size 

 

Example: 

"Total Sales" (BOLD) It is for Reporting purpose. 

“Note: Data is fictitious” (Italic) - to emphasize additional information. 

Underline 

Insert a horizontal line below your selection to emphasize it. 

Types of Underline: 

●   Single Underline: Places one line under text. 

● Double Underline: Puts two lines for double the notice. 

How to Apply: 

●   Highlight the text that you want to underline. 

●   Next to the Underline (U) button on the Home tab, click More. 16
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●  Select the Double Underline if needed from the drop-down next to it. 

 

Fig 1.16 Bold/Italic in Excel 

 

 

Fig 1.17 Underline in Excel 

 

 

Example: 

Single underline for headings such as "Monthly Report" 

Double underline for total such as Grand Total 

Top and Double Bottom Border 

Borders on your tables allow you to organize and separate information, as well as make your data 

more structured. 

How to Apply: 

● Click the range of cells that you want to format. 

● Select the Borders drop-down at the Home tab. 

●   Choose Top Border, Bottom Border, or Double Bottom Border. 

Border Choices 

3

Page 26 of 50 - Integrity Submission Submission ID trn:oid:::3618:127056669

Page 26 of 50 - Integrity Submission Submission ID trn:oid:::3618:127056669



● Top Border: Put a line on the top edge. 

●  Bottom Border: Places a line at the bottom. 

● Fat Edges: Mark the critical components. 

Draws grid to highlight summary rows in financial statement. 

A second bottom border below totals for added emphasis. 

 

Fig 1.18 Top and Double Bottom Border in Excel 

 

Fill Color 

Fill cells with color to highlight and make them easier to locate. 

How to Apply: 

● Select the cell(s). 

● Press Fill Color in the Home tab. 

● Choose from thousands of colors. 

 

 

Fig 1.19 Fill color option 

 

Example: 

Overdue tasks are presented with red fill color. 
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Different colors are used to indicate different elements of the table. 

Font Color 

It can change the text to a particular color or make it stand out in some other way, such as by 

matching it with a theme. 

 

How to Use: 

● Select the text. 

●   Press the Font Color icon in the Home tab. 

● You can choose a color from the color palette. 

 

Fig 1.20 Font Color 

 

Example: 

● Great to use green font color when the growth value is positive. 

● Format the losses in red colour font. 

 

Did You Know? 

The first version of Excel was published in 1985 for Macintosh. Microsoft didn’t even release Excel 

for Windows until 1987 and eventually it overtook Lotus 1-2-3 in popularity as the dominant 

spreadsheet application! (Source: Britannica). 

Other Advanced Formatting Options 
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In addition to basic formatting, Excel includes a variety of advanced styles and features designed to 

make your data more presentable and easier to use: 

● Conditional Format: A feature that enables cells to dynamically change the way they look (their 

formatting) based on a set of criteria you define and allow users to identify trends or values, pick 

from a group of categories, and more. 

● Custom Number Formats: Users are automatically presented with which to easily choose date, 

currency type and consolidated data forms for standardised data display. 

● Cell Styles: With pre-set styles, users can clean up their cell formatting but still keep their 

worksheet content well organized and even professional. 

Themes: Employed across the entire package the consistent styling options of colour and font result 

in a coordinated appearance for all aspects of your workbook 

Knowledge Check 1 

Fill in the blanks: 

In Excel, __ constructs are logical operations and can only have the value TRUE or FALSE. 

(Boolean / Numeric) 

Excel has several features under the _ tab which can be used to format cells such as font size, bold, 

italics and fill color. (Home/ Data) 

Excel holds __ as a serial number to process calculations, or 1/1/1900 is the equivalent of one (1). 

(Dates/Texts) 

The __ feature in Excel enables cell to automatically alter its appearance on the basis of certain 

conditions. (Conditional Formatting / Cell Styles) 

 

1.3 Methods of Importing and Reviewing Data in Excel 

Excel pulls data in from other external sources as well, with support for plain text files and common 

databases and Web systems. Excel enables users to conveniently interact with its interface in order 

to import data automatically from multiple file forms. 

 

1.3.1 Importing Data from External Files 

You can import data from some of the popular file formats into Excel, including: 

CSV (Comma-Separated Values): CSV files use a simple text format to store data, as it appears in 

every single row and value is separated by commas. 

Steps to import: 

● Jump the table to Data tab then click Get External Data and choose From Text/CSV. 
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●   Application software here such applications as ERP or CRM relies on this format when exporting 

data to some processing facility. 

 

Fig 1.21 CSV (Comma-Separated Values) Files 

 

Excel Files (.xlsx,.xls): 

It is also directly accessible from within Excel by using an Import wizard which acts as a means of 

importing data from other worksheets and making it possible to build up consolidation documents. 

Steps to import: 

 

Fig 1.22 Excel Files 

 

● Go through File and tap on Open and further Browse. 

With Excel, one can consolidate separate departmental data into a single master report. 

Text Files (.txt): 
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Text files are objects, with properties that allows you to read and write line by line from or to a text 

file in such a way that the space characters do not matter. 

 

Steps to import: 

●  Users can locate this feature in Data tab > Get External Data > From Text/CSV. 

This is primarily for systems which have the old 'spread flatfile' data back-end. 

 

Fig 1.23 Text Files 

 

 

1.3.2 Importing Data from Databases and Online Sources 

Excel has features allowing you to create external links to data in databases and web-based systems 

where information is current. 

SQL Server/Access Databases: 

In many cases mission critical business data is stored in Microsoft SQL Server or MS Access (MDB) 

databases. 
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Fig 1.24 SQL Access Database 

 

Steps to import: 

● Click on the Data tab and then selectGetData, From Database, and finally From SQL 

Server/Access. 

Great for reporting financial data and managing customer contacts. 

Web Data Import: 

Using Excel's Web Data Import feature, users can now easily bring data directly to the workbook 

from web pages and online services to enrich analysis and storytelling with statistics, rates data, 

property valuations, company rankings and other types of public information along size any table of 

numbers that has an online presence. With this feature, users can put their analysis on autopilot with 

real-time updates by connecting to datasets on the web. 

Steps to Import Web Data: 

You'll need to navigate to the Data tab within the Excel ribbon. 

Select Get Data > From Web. 

You need to enter the exact URL of the page where you want this information from. 

Choosing Get Data from the Data menu, then From Web displays web table alternatives. Begin with 

choosing the correct table from that page and preview its data content for importing them with the 

Load button. It has dynamic monitoring requirements since imported information must be 

synchronised and data refresh cycles can be scheduled. 

18
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Benefits of Web Data Import: 

● Real-time tracking: The datasets are kept in sync with the latest using automatic updates of stock 

prices and weather reports and sports scores. 

● Time Saving Cricial data is turned into digital records without sacrificing on correction details or 

stacking up old forms. ○ Efficient Analysis Eliminates man-made errors in gathering information, 

the auto-delete feature eliminates time consuming procedures used in manual entry. 

● Tailored Insights: With Excel tools, it can analyze data insights such as charts and pivots to see 

the detail behind the numbers.Filter connection in pivot tables through custom regions. 

 

Fig 1.25 Obtaining Data from Web 

 

Example: 

Stock Market Analysis: Analysts on Wall Street and independent writers use Yahoo Finance to 

collaborate on real-time market data bringing in prices and activity, earnings, estimates as well as 

recommendations. Paired with the basic functionality of Excel, an analyst has: 

● With the new dashboards, users can now see visual of their portfolio measurement data. 

● Upon choosing, your system should prompt notifications reminding you when your stock price 

reaches the target level. 

● Focus shifts towards Market trends and locators of profitable investment opportunities. 

Power Query (Advanced Data Import): 

With Power Query users can automate the process of importing data and doing necessary cleansing, 

as well transforming that data from a variety of sources. 
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Steps to import: 

Select the Data tab, then Get Data > choose Launch Power Query Editor. 

The tool allows for efficient handling of elaborate pre-analysis transformations. 

 

 

Fig 1.26 Power Query 

1.3.4 Advanced Review Techniques 

 

Pivot Tables: 

Pivot Tables: 

You may find yourself using the Pivot Table Excel's most powerful tool. Through this, they can 

efficiently aggregate large-scale data and analyze them all as a group while summarizing analysis 

results and presenting them. Pivot tables (a long-standing dream of us all at tradersdna) are 

established to help read the most important numbers and trends through a mass of data over process, 

without having to handle manually the data. 

Major Advantages of Pivot Tables: 

Users can pivot data to take large date-sets and summarize it into a meaningful user-specifiing 

groups.The floats must comply with the IEEE single-precision format. 

" ● Segmentation - the data is segmented by using the pivot tables based on "subsets and groups 

which give“ in different sections a region-, product type- and date parameter. 

● Trend spotting: It’s easy for users to join the dots from the data by viewing trends in pivot tables 

that display seasonal changes or departmental KPIs. 

● Flexibility: Pivot table that How to Prevent Pivot Tables from Forming when Dragging and 

Dropping Fields Ensure ustomers see your data in the way you want, asp. 
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Fig 1.30 Pivot Tables 

 

The use case applies to finance documents when analyzing sales performance. 

How to Make a Pivot Table in Google Sheets: 

● Choose the Data: Your data will need to be available as a table with unique column headers. 

● Click the Insert Tab: Now, you need to click into Excel and locate the Insert tab which is spread 

out through the ribbon section in top of your screen. 

● Choose PivotTable: Click PivotTable in Tables group in the ribbon. 

● Select the Data Range – You’ll be prompted by Excel to select the data range that you’d like to 

analyze. Choose the worksheet range or table, or named range that you want to use. 

Step 2: * Select the Location: You have now created a pivot table, at this point you get to decide 

whether you want to place it on a new work sheet or an existing one. 

● Click OK: Once you have selected the range and placement area, simply click OK to enable pivot 

table option. 

● Assemble your own Pivot Table: A new dialogue is displayed, giving you the ability to drag fields 

from each area of your database into a Section (as in Rows, Columns, Values and Filters). Future 

Now you might want to start your summarizing and analysis. 

Pivot Table Components: 

● Rows: In a Pivot table, the rows are the analysis categories that you want to explore (for instance 

products along with regions). 

● Columns: Where the data points that requires comparison between various units (e.g.) Months or 

Years are being placed. 

● Values - You need to be able to take an aggregate over your selected data points (e.g. sum of sales, 

average revenue). 

● Filters: Tool based filtering of data help you focus on certain sub sets categories like product types 

and date ranges. 

Importance in Data Analysis: 

1

1
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Through pivot tables, people can work with large data sets more efficiently because they get a clear 

view of their data. This will allow you to successfully analyze big data sets and present the important 

insights reporting to your clients. It enables users to: 

● Create fast summaries. 

● The procedure will give you the capacity to perform complicated Calculations on numbers with 

ease. 

● Support comparing with kinds of data types and time periods. 

Power Pivot: 

Power Pivot With its outstanding Excel add-in, Power Pivot provides users with the tools for all 

kinds of data processing on huge amounts of data. The versatile data model of Power Pivot extends 

to the capabilities of standard pivot tables, enabling users to work with large data sets, in high 

velocity or variety or granularity and build informative reports. 

Power Pivot allows you to handle multiple sources of data, and interpret the information featuring 

complicated relations that depict in the old data model. But if you are dealing a lot of table data or 

the kind of horsepower that comes from its many calculation options, there is reason to know about 

and use this tool. 

Key Features of Power Pivot: 

Data Modelling: Power Pivot has a data modelling feature which let users make relationships 

between multiple databases and adds sources of data such as sales information that could be 

connected with customer information, then to inventory and so on. With Power Pivot, you can 

perform advanced data analysis: Multiple tables are added to the model and it avoids those damnable 

formulas. 

● Big Data: Power Pivot can handle big data with over 1,048,576 rows of data that would be 

impossible to do in Excel. The code adopts in-memory data model for reducing computational 

amount over huge data. 

● Data Integration: Excel Power Pivot capitalizes on its multiple data source extracting skills like 

databases SQL Server, cloud services Microsoft Azure or Web data. The system combines all kind 

of data in a designed way to form one big pile that can be counted and analyzed. 

Advanced Computations Power Pivot, performs Data Analysis Expressions (DAX) on the fly 

supplying users with the capability to define complex calculations using formulas that are difficult 

for typical end users to create. In comparison to DAX functions advanced analytical capabilities, 

regular Excel formulas would have very little options for analysis which enrich the analyses 

possibilities in such complex situation. 
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► Hierarchies: This allows users to organize and populate a data model hierarchically (such as 

Year>Quarter>Month>Day) so that they can analyze general information before drilling down into 

detail at various levels of granularity. 

● PivotTables with -Charts: When awarding on aggregated data models whose data sources are 

Power Pivots, enabling a user friendly way to make findings come alive. 

Steps to Enable Power Pivot: 

● If you need to open you Excel, it will be in the File Tab. 

● The Add-Ins is the menu options, they can click on it. 

● You will receive a Message Dialog when you click COM Add-ins in the Manage dropdown. Then 

click Go. 

Power Pivot for Excel is automatically installed when you chose that option in Add-Ins, made 

available by clicking on the "Microsoft PowerPivot for Excel" checkbox  there and pressing OK. 

● Once you activated the Power Pivot a new ribbon tab would be shown like below. Benefits of 

Using Power Pivot: 

● Processing much faster and more efficient: Because Power Pivot processes large set of data in 

memory mode, the speed at which database process increase substantially. It takes the speed that 

big-data people like business intelligence and financial analysts depend on. 

● Powerful Data Models: Users are able to create powerful data models across multiple tables. The 

use of data models for analysis is more complicated due to the fact that they accommodate complex 

relationships between multiple sets of data points in addition if any, such as one-to-many or many- 

to-many. 

Advanced Analytics: More advanced calculation beyond the power of Excel's native capabilities is 

at your fingertips as PowerPivot and its Data Analysis Expressions language provide you the power 

to define custom calculations and intelligent time line analysis. That kind of feature is only useful 

for business analysts or data scientists doing predictive modeling or some other type of advanced 

analytics.” 

 

Fig 1.31 Power Pivot 

 

Formula Auditing Tools: 
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You can quickly and efficiently analyze formulas in worksheets to ensure they are used 

appropriately with Formula Auditing Tools. During data analysis, the analytical tools can be used 

to identify errors or inconsistencies in formulas and improve the trustworthiness of the data being 

analyzed. 

You can use formula auditing to follow data movement across sheets - that is, when you're trying to 

verify your formulas are right and see if any errors are occurring. Best in big workbooks with many 

formulas based on multiple references The tools perform best in large workbooks containing a large 

number of formulas that rely on multiple references. 

Top Features of the Formula Auditing Tools: 

● Trace Precedents - An option that allows users to see all activity referenced in every formula. The 

tool highlights the data cells that serve as formula instructions (or what are called precedents) to 

illustrate how changes in cells spread by reference throughout the worksheet. 

● Trace Dependents: It is an overview of all cells that the selected cell receives data from. What the 

tool does is to show you how changes in value in one cell ripple out across various areas of the 

worksheet. 

● Error Checking: Excel’s feature, Error Checking automatically evaluates worksheets in order to 

find errors that would arise in formulas. Excel's Error Checking feature can identify divide-by-zero 

errors and also find reference errors including circular references, then suggest how to fix them. 

● Show Formulas: With the Press of a button your spreadsheet displays the formulas being used to 

calculate formulas, as opposed to showing you the Result that everyone else sees. You can see what 

formulas you’re using in your big spreadsheets by having this tool show all active formulas. Results 

browse is still possible through a toggleable interface. 

● Evaluate Formula : Begin by reviewing this feature to see how Excel calculates across each 

element of formulas during calculation step-by-step. The program identifies erroneous calculations 

locations, especially on complex formulas of several levels. 

● Circular References: Excel warns users about ‘circular references' when a calculation refers to 

itself directly or indirectly, possibly leading to an infinite loop of calculations. Such problems can 

be found and corrected more easily with the formula auditing tools. 

How to use the Formula Auditing Tools: 

● Enable the Formula Auditing Toolbar: Go to the Ribbon at the Formulas tab. 

● Trace Precedents: Select the cell containing the evaluative formula you want to trace. From the 

toolbar, select Trace Precedents in the Formula Auditing group. The cells you refer to from your 

formula are created as visual indicators which are indicated by arrows pointing to said cells. 

1
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● Trace Dependents: To trace dependent cells, first select an area and then use the Trace Dependents 

command. You can also see these arrows in Excel, when the one column cell is selected then there 

are arrows that signify which cells are dependant on it based on their values. 

● Show Formulas: Use the Show Formulas button to display formulas instead of the results in the 

cells on your sheet. Reviewing big spreadsheets is easier if Show Formulas shows formulas (instead 

of their results) in several cells at the same time. 

● Evaluate Formula: Choose the cell containing the formula you want to check. Begin evaluating 

the formula with Evaluate Formula, and watch the series of calculations unfold. 

● Error Checking: This button launches a Run an Error Checking process on your morksheet. The 

app shows mistakes in your sheet and recommendations to correct them. 

Benefits of Formula Auditing Tools: 

● Error Recognition: Formula auditing options enable users to quickly and easily identify errors in 

their spreadsheets, such as broken references and incorrect formulas, as well as display logical 

faults. Such tools are especially useful for people who have to audit giant formulas or large sets of 

data. 

● Data Transparency: Precedent & dependent tracking allows these tools to display the spreadsheet-

wide data flow. Your ability to source information and then use it is tracked better across your docs. 

● Troublesome Formulas: With so many cells and functions, we almost always run into issues with 

an overly complex formula organization-wide. You can simplify your troubleshooting by breaking 

the formula in parts using Evaluate Formula feature with step-by-step checks that help you identify 

where it fails. 

● Efficiency: They are more efficient by automatically verifying systems that can be used to detect 

potential problems instead of manual verification against large datasets. 

● Enhanced Accuracy: Formula auditing provides accurate formula validation which prevents 

companies from making errors in their analysis. Formulas Formulae that are dedicated to robust 

models of decision and financial statements, as well as studies, use correct calculations. 

Steps to use: 

Go to the Formulas tab and choose Formula Auditing from the menu. 

The device detects mismatched data items for correct reporting of data. 

 

Fig 1.32 Formula Auditing Tools 
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Knowledge Check 2 

State True or False: 

Excel can import data from CSV and excel only – you are unable to import directly from Database 

or Online. 

Power Query enables users to automatically import, cleanse, and transform data from a diverse 

range of sources. 

Web Data Import in Excel allows you to get real-time live data, like online stock or weather 

information. 

In Excel, you would use pivot tables mainly to format text and apply font. 

Clever Ideas How to Identify Trends in Excel - Goodly a user What is conditional formatting? 

 

1.4 Key Functionalities of Excel for Data Analysis 

Excel provides an array of capabilities which allow you to use mathematical and classification 

methods, and build decision models that provide users with business insights into operations. Users 

have a complete suite of features and functionalities in Excel With built-in, only it helps users to 

process data efficiently. Excel's default mathematical and statistical functions help the users to 

analyze their data effectively. 

Basic Statistical Functions: 

Common functions include: 

● =AVERAGE(range) – This formula gives us the average of a range. 

●   =MEDIAN(range) – Returns the median value. 

●   You then use the MODE function to determine which number occurs most frequently in the 

range. 

●  =STDEV(range) – This calculates the standard deviation. 
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Fig 1.33 Basic Statistical Function 

 

The instrument offers an efficient manner to describe the data and find patterns in its sample 

distribution. 

Data Analysis ToolPak: 

datanamic Data Analysis ToolPak is an easy-to-use add-in for Microsoft Excel. The functions in the 

Data Analysis ToolPak including correlation and regression testing are available along with 

summary statistics and many others. A splendid bonus pack for those who would like to perform 

advanced statistical work in the cool playground of their comfy Excel. 

4 FinishingtheDataAnalysis ToolPak]init Features: 

● Regression Analyze: You can use the third key to analyze regression, you can carry out automated 

fitting of curves between the dependent and independent variables with linear regression. This, as 

well as the prediction analysis between vehicle and host RNAseq dataset are common to this 

function. 

● Correlation- To test and see the relation of two or more things where how each component affects 

the other, it tests them in a way which even helps you identify some common patterns on your data. 

● Descriptive Stats: Important type of descriptive statistics are readily available in the app 

-- summary stats such as mean, median, mode, but also variance and standard deviation. This 

understanding simplifies certain basic properties of data sets. 

● ANOVA (Analysis of Variance): For detecting the statistical difference, if any, between the means 

of different groups. 

● t-Test: User will be asked to input differences between mean of samples and then identify whether 

differences are significant. 

1
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● Plot: with this feature, the user can easily draw histograms for distribution and charting intervals. 

● F-test: It is used to testify for the statistical difference between population variances this helps in 

testing dissimilar groups of data. 

 

 

Fig 1.34 Data Analysis ToolPak 

 

This is where this plugin excels in the statistical details. 

Lookup Functions (VLOOKUP, HLOOKUP, XLOOKUP): Reference functions designed to 

retrieve information from huge data incursions with reference of specific lookup criterion. 

Usage: =VLOOKUP(value, table, col_index, [range_lookup]) 

 

Fig 1.35 Lookup Functions 

 

They are used to locate business details from the company databases. Logical Functions (IF, AND, 

OR): 

The logic testing will lead to conditionally applied actions. 
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Fig 1.36 Logical Functions 

 

Examples: 

=IF(A2>100, "High", "Low") 

The classification and segmentation of data takes place through business rule allowances. 

1.4.1 Data Visualization 

The data is visualized in a comprehensive graphic representation with combined charts and 

graphs/diagrams. With the plethora of visualization types available in Excel, the user is able to create 

visual representations for data that are easy to comprehend and can make sense at a glance. There 

are tools to support wrangling raw data into analytic narratives that makes complex information 

more immediate to readers. 

Charts (Bar, Line, Pie, Column): 

●   Column and Bar Charts: This chart helps you to present data across multiple categories in visual 

form. Graphical design that is friendly to eye and user’s thoughts make the difference or pattern pop 

everywhere brings great convenience for using voice code. 

● Line & Area Charts: A visual aid that best illustrates changes in figures over time (e.g. sales across 

months). 

● Pie chart: It can show the proportions of a total value; for example, we use pie charts to represent 

the percentage composition of market share or budget. 

Scatter Plots: These graphs are useful for helping us see relationships between two variables and for 

detecting correlations. 

 

Page 43 of 50 - Integrity Submission Submission ID trn:oid:::3618:127056669

Page 43 of 50 - Integrity Submission Submission ID trn:oid:::3618:127056669



 

Fig 1.37 Charts 

 

Steps to create: 

On your Excel screen click on Insert tab, under the Charts group. 

Helpful also for reporting and analysis in the finance department as well as sales performance. 

PivotTables and PivotCharts: The feature uses big database data to weave sections around element 

types in order to analyze them. 

Steps to create: 

Move to Insert > PivotTable. 

Perfect for business performance reviews and KPI tracking. 

 

 

Fig 1.38 PivotTable 

 

Sparklines - do in-cell charts to show trends inside your table. 

Steps to apply: 
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Look for Sparklines beneath the Insert tab. 

 

Fig 1.39 Sparklines 

 

Users can view trends that develop over a span. 

What-If Analysis (Goal Seek, Scenario Manager): 

What-If Analysis is one of Excel’s most powerful features and this what-if analysis tool allows a 

user to analyse possible outcomes with a variety of inputs. This enables users to discover how 

changes in environmental conditions may affect the quality of their data, and make fact-based 

decisions. The application of this model provides a valuable techniques in the field financial 

prediction and decision making under various scenarios. 

Steps to use: 

Steps to Use What-If Analysis: 

Go to the Data tab in Excel. 

From the list of tools, click What-If Analysis. 

Select one of several options, including Goal Seek or Scenario Manager, depending on your analysis 

requirements. 

●   Goal Seek: Aiding in determining the input variable value for the desired result of a formula. For 

instance, it can be used to calculate how much a company needs to sell in order to reach a target 

profit. 

● Scenario Manager: Enables a user to create and then compare among multiple sets of input values 

(scenarios) in order to discover their impact on the result. For instance, the best-, worst- and most-

likely business cases could be compared. 
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Fig 1.40 What-If Analysis 

 

Activity: Excel Data analysis and visualization 

Objectives: Data analysis, statistical functions and visualization using Excel. 

Steps: 

Use Statistical Functions: Apply AVERAGE(), MEDIAN() and STDEV() to study the performance 

of sales over time. 

Use Data Analyst ToolPak: Regression and Histogram on sales data. 

Lookup & Logical Functions: Find sales information with VLOOKUP() and categorize revenue 

using IF(). 

Make Charts & Sparklines: Build a Column, Line or Pie Chart plus add trend-lines. 

What-If Analysis: Goal Seek to determine sales necessary to reach desired revenue and Scenario 

Manager tool can be uses to evaluate pricing strategies. 

Reflection: 

What did you learn from statistical functions and charts? 

How did What-If Analysis aide in decision making? 

Deliverable: A summary or screenshots of what you found. 

Investors analyze stock market data with the aid of Excel's analytics tools, and in return they gain 

invaluable information that further spurs their investment decisions with data. Excel-embedded tolls 

allow trend analysis and portfolio analysis along with forecasting tools. 

 

1.5 Summary 

❖ ❖ As one of earliest systems with user friendly GUI and strong analytical capacity, Excel has 

played a pivotal role in business decision making based on data analytic techniques. 

date dec to enable further analysis. 

Excel-based database retrieval as an analytical package. 

your information and whatever decisions can be done as nicely. 

of actions with which to analyze the business. 

arranging and analyzing data to learn more productive business plans. 

1.6 Key Terms 

Once you know the trends about What is Business Analytics Structured Data, you make better 

business decisions about it, and then you find out much more additional pattern and some nuggets 

with insight levels. Data Types : Excel can process many data types starting from number values 
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and, along with text strings, dates, and Boolean values. Data formats : Data is success = Number 

category organization with currency/date and text formats that making the calculations proper 

refreshing the data view. Import: Excel permits you to import external data from database; CSV files 

and web applications. PivotTable: Excel fans from all over the place have been turning information 

into actionable, incredible finished products for decades alongside analytical paragons. Cleaning in 

Practice: The analytical truth of data refers to as accuracy-patches algorithms that detection- errors 

and repair-processes can give up. Power Query is a feature in Excel that merges data from diverse 

sources with transformation steps and data merging techniques. Data Visualization : A visualization 

tool with tables and graphical charts of displaying data in an efficient way of presentation format. 

Statistical Functions: use AVERAGE, MEDIAN and STDEV built-in function in Excel for analyzing 

the statistics of your data. 

1.7 Descriptive Questions 

Explain how Excel is defining the importance of business analytics and why it's considered to be a 

vital in any industry. How is Excel a fundamental tool for data analysis and still an essential 

application in business? 

Power Query & Data Formatting combine to keep the data quality bar high. Why do we need to 

finish this data prep work before we analyze anything? How does cleaning data with Excel help to 

ensure the results were reliable and accurate during analysis? 

Learn how businesses should act for adopting PivotTables over Excel when we analyse. What 

variety of datasets are suitable for consolidation into PivotTables and how would this tool 

complement various aspects of business? 

What is Data Visualization, and How Does It Apply to Excel? Explain how the charting tools in 

Excel can be used to present data visually and provide an example of what valuable information one 

may glean from visuals. 

What is excel statistical function and how business users can use it for making their data analysis 

better? Describe what functions such as AVERAGE, MEDIAN, and STDEV are for—even if you're 

not using Excel—and how they assist in analyzing trends and arriving at data-informed decisions. 

The predictive power of Excel ensures better planning in future for retail business and health sector. 

In Excel, as a businessperson, what tools and approach can be utilized to predict the future trend? 

Analyzing data via Excel has theungoing positive efects on your strategic decisions as well as 

tactical succecess. What are the stages of data analysis that help organizations to take right 

decisions? 
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Discuss in what ways the case study in this unit demonstrates the use of Excel as a tool to assist with 

problem solving. What were the key insights that you gained from your case study analysis and how 

would you apply it in solving specific business challenges by using Excel? 
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1 Microsoft. (2021). Excel for Data Analysis. Retrieved fromhttps://support.microsoft.com 
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Answers to Knowledge Check 

Knowledge Check 1 

Boolean (Logical) 2. Home 3. Dates 4. Conditional Formatting 

Font 

Knowledge Check 2 

False 2. True 3. True 4. False 5. True 

1.9 Case Study 

Covid 19 analysis 

The Covid-19 pandemic generated an international health crisis that required fast decision-making 

based on data. Laws need to be in line with how the virus spread and research institutions and 

healthcare providers must examine recovery indicators for scaling up essential health interventions. 

This was only made possible through Excel’s built-in data analysis tools that allow statistical 

analysis and data visualization (trending) techniques as well as used in decision making. 

Introduction: 

Excel’s powerful tools helped healthcare and policy leaders analyze huge amounts of WHO and 

Johns Hopkins data from around the globe. Excel application was primary weapon to control Covid-
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19 data through cleansing functions and analysis options as well as data visualization techniques to 

reveal actionable insights for anti-pandemic measures. 

Statement of the Problem: The raw data collected throughout Covid-19 was huge and often messy, 

featuring issues such as: 

● Duplicated instances in data sets 

● Data which is not completed or missing 

● Inconsistent date and figure types SELECT subnational_indicator_country_code, iso_year_month, 

value from bq-results-20191007-135511-jr7iohbjzhw2 Page 5;9 February Findings on the Worst 

Forms of Child Labor:https://www.dol＋gov/agencies/ilab/resources/reports/child-

labor/findingsAccessed 29 Sep；BLS-SOR (n/d) New York State Department of Labour - Subject 

of Record Files[atsdr.cdc.gov/toxprofiles/index.asp] U.S Environmental Protection Agency 

[www.epa.gov]World Bank development indicators ISBN International Statistical Institute 

[international．statistics国際統計.org/D6－Continues house to access news.About＠F77ernando 

Alonso enuWorld Cup MYPage:1216 ＃Browse Articles #oplanetary Sciences ISSN(Template with 

\dpi141%)0004-6333.The result;>���#`�#Extent】(｡◕‿‿◕｡)っ_ Respect labour standards 

Access to health care Universal health coverage Immediate plan for economic marketing･state 

violence Youth-friendly APCXXI century child Jamaica Lebanon Mathematics Code Quality 

Indicators Shoes Obsevcread more ▼ The information used is provided at the level specified. 

You can’t make important decision like this one without having clean and well-structured data: bad 

conclusions will follow. It was essential to calculate and process the data appropriately in order to 

identify trends in infection, recovery, or both and overall effectiveness of public health 

interventions. 

Solution 

Data Cleaning and Aggregation: We initiated our process with daily updates of such resolved cases 

(confirmed cases+recoveries, as well as deaths) from official reports. Data was cleaned and 

transformed to adjust for or into: 

Removing Duplicates:Duplicacy of Meeting repetition records were removed by using "Remove 

Duplicates" option in Microsoft Excel. 

Handling of Missing Data: In the absence of data points,the IF ERROR function would choose 

between estimated values and mean-imputed values hypothetically. 

Normalization: We did normalize the data where numbers and date was there in the dataset using 

Excel formulas as TEXT() and VALUE(). 

2
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EDA on Excel: Once the data was clean, we used Excel’s powerful analysis features to discover 

some interesting trends such as : 

Pivot Tables: The Pivot Table was used to analyze confirmed COVID-19 cases across multiple 

regions and different time periods. The site enabled both an inter-regional comparison and 

identification of trends in infection rates. 

Charts and Graphs:One line graph showed the evolution of cases over time. Pie charts were used to 

present percent of recovered patients with active case trends. 

Descriptive statistics: mean, median and standard deviation were used to summarize trends in cases 

as well as describe how the data points varied. 

Key Insights: Some key insights were derived from the analysis of the data 

Trend analysis of infection within the community: This identified “outbreak trends” which were 

acted upon immediately by healthcare workers. 

Regional Recovery Rates: The recovered rates that presented a different pattern in each region are 

useful information to support developing healthcare-focused intervention policies within limited 

regions. 

Effectiveness of lockdown: The evidence looked at the effectiveness of lockdown so that 

governments could see what had worked best to slow transmission of COVID-19. 

Conclusion: Using Excel tools such as data cleansing and analysis with visualization, many policy-

makers and healthcare professions made decisions, during the pandemic caused by Covid-19 

grounded in the data. The information we used to generate our projections was the one that not only 

enriched us with knowledge of how disease could be transmitted as it is, but hinted for an appropriatte 

use of resources and set up intricate interventions aimed to mitigate virus spread. Through the 

pandemic Excel was an essential, performing as designed to support creation of vital data analytics 

informing how public health imperative decision-making process could be carried out in real time. 
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Unit 2: Essential Excel Functions  

Learning Outcomes 

1. Learners will be able to identify and apply essential Excel functions for data analysis in business 

scenarios. 

2. Learners will understand and utilize text, arithmetic, time, and date functions to manipulate and 

analyze data effectively. 

3. Learners will demonstrate proficiency in using absolute referencing to enhance formula accuracy 

and efficiency. 

4. Learners will apply Excel functions to solve real-world business problems and improve decision-

making. 

 

 

Content 

2.0    Introductory Caselet 

2.1    Introduction to Essential Excel Functions 

2.2    Basic Excel Functions for Analysis 

2.3    Text Functions in Excel 

2.4    Arithmetic and Statistical Functions 

2.5    Time and Date Functions 

2.6    Understanding Absolute Referencing 

2.7    Summary 

2.8 Key Terms 

2.9 Descriptive Questions 

2.10 References 

2.11   Case Study 

 

2.0 Introductory Caselet 

Learning and mastering Excel's core functions are critical to succeeding with data analysis. 

Arjun is a data analyst at a logistics company and he’s been working there for over 3 years. He has been assigned to an 

analysis of delivery performance by area. He comes up with an Excel dataset from his manager which contains: 

· Order Date 

· Delivery Date 
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· Customer Name 

·  Arrival State (On-time, Delayed) 

· Product Category 

· Total Shipping Cost 

Arjun quickly realizes that he needs to clean and analyze the data before drawing conclusions. But he doesn’t know 

how to properly handle missing dates, categorize latenesses or calculate KPIs. 

· To fix the problem, he needs to acquire some essential Excel functions: 

· Basic operations (SUM, AVERAGE) for calculation of total delivery costs and average costs. 

·  Text Functions (TEXT, LEFT, RIGHT) to extract certain details from order numbers. 

· Math & Stats (COUNTIF, IF, MEDIAN) to sum masses of delayed shipments and analyze costs over time. 

·   Date Functions (DATEDIF, NETWORKDAYS) to calculate rate of delivery. 

·   Absolute Referencing to ensure correct calculations on various cells. 

While doing so, Arjun notices a trend – deliveries from one of the warehouses are being delayed with alarming 

frequency. His insights will help the company to optimize its logistics efforts, and now he has to figure out how to 

communicate his findings to his manager. 

 

Critical Thinking Question: 

What are the approaches that Arjun can use Excel functions to find and address the reasons for repeated disruption in 

deliveries? Suggest two or more excel tools or functionality through which he can analyze and improve delivery 

efficiency. 

 

2.1 Introduction to Essential Excel Functions 

Business and analytics decisions rely much on Microsoft Excel as a key support tool. Businesses in various trades rely 

on Excel for both their sales trend analysis and financial data compiling and operational optimizing and productivity 

improvements. They prefer to utilize Excel built-in functions that can help them do the complex calculations in an 

automatic way which provide less errors and more efficiency at work. 

The significance and application in real life of Excel is determined so that you can see the use of various functions from 

different categories which are likely to come in use across multiple business scenarios. 
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Maing Core Excel FuncFig 2.1 Budget Tracking in Excel  

 

At 

The Importance of Excel in Business Analytics and Decision Making 

Businesses are able to get very effective data processing and analysis thanks to the heavy reliance on Excel 

software by business organizations. Some key benefits include: 

● The software also structs data and accommodate organized systems on which formulas can be formulated 

creating a useful knowledge. 

● Excel based applications will eliminate time required for automatic repetitive operations and the potential 

human error. 

● Practically all enterprises use Excel for creating financial models and running risk analysis scenarios while 

making strategic decisions. 

● We have an in house performance monitoring tool built on Excel using dashboards and pivot tables to 

monitor the KPIs of the organization. 

There are plenty of real world Excel functions in use that benefit all sorts of industries. 
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Financial 

Financial Analysis and Budgeting 

Financial analysis is one of its key components and an important source for business decision making. With functions 

in Excel built specifically to simplify and automate financial accounting. Organizations are able to calculate their 

profits, make budgeting estimations, and even measure the level of business sustainability. 

E.g: The report totals are calculated by SUM()s across multiple geographic areas while AVERAGE() are used to surface 

the average monthly spend at this firm. 

ple geographic areas while surface the average mo

nthly spend at 

thisAnalysis”                                                 Fig 2.3 Regional Sales and Expenses Data 

 

Here, 

Total Revenue (₹): Summarize total revenue over all quarterly This section performs a summary of the Totat Revenue 

of all quarters. 

Example (Karnataka): 

=SUM(15,00,000, 18,50,000, 16,00,000, 17,50,000) 

Total Revenue = ₹67,00,000 

Monthly Average Revenue (₹): Total revenue must be divided by 12 in case you work for twelve months. 
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Example (Karnataka): 

67,00,000 ÷ 12 = ₹5,58,333.33 

It is Karnataka’s monthly average revenue through this figure. 

Application: 

• Automobile Industry (Tata Motors, Mahindra & Mahindra): SUM() and AVERAGE() functions help these companies 

control their quarterly sales of vehicles in various regions and observe its operational expenses on factory and showroom 

properties across different states. 

• Consumer Goods (such as Hindustan Unilever, Dabur): In such company SUM() is used to add up sales information 

across different states of a country and then AVERAGE() to calculate monthly costs for logistics and production. 

Sales and Marketing Analytics 

Numerals function used by salesmen and direct marketers (e.g. to revolutionizing purchase order or measuring 

marketing programs as well as constructing consumer data dimensions). 

Example: The COUNTIF() feature of an e-commerce business will serve to find out distribution order quantities at 

different geolocations its customers. 

Example Use Case: Order Volume Distribution Across Regions for an E-commerce Player 

Use Case: Your e-commerce company wants to look at in-app purchases from customers in different parts of the 

country. The business team should conduct this type of analysis to understand customer ordering patterns by location 

and to inform supply chain optimizations. 

Data: A list of several Order IDs with Customer Names and Regions (customer location information) exists in an Excel 

sheet for the company. 

All order data is displayed in the following format: 

 

 

 

                                        Fig 2.4 Order Quantity Distribution Across Regions 

 

Using COUNTIF() Function to Figure Out the Order Quantity by Region: 
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Goal: 

This formula helps counting orders by the region‐based customers. 

COUNTIF() Function: 

You can with COUNTIF() figure out how many of the cells in those ranges meet certain criteria. 

For Karnataka: 

To calculate the number of orders from Karnataka, you can use following formula in Excel: 

=COUNTIF(C2:C11, "Karnataka") 

This formula is counting the total cells that includes “Karnataka” from range C2:C11. 3 orders have been despatched 

for Karnataka region in that calculation. 

Human Resources and Workforce Management 

Excel can be used by HR departments to maintain records for employees, monitor attendance and calculate employee 

payments. 

Example: A tech company monitors their employee tenure utilizing DATEDIF() functions for determining eligibility 

for promotion. 

Use Case Example: E-commerce Sales and Marketing Analytics 

Sales Order Distribution with COUNTIF() 

Organisation sales team need information about order quantity distribution across different geographies in their e-

commerce industry. By using COUNTIF() you can determine which areas have created orders for the company. 

 

Did you Know? 

Excel was first developed by Microsoft in 1985 for the MacOS, followed by a version for Windows in 1987. It soon 

became one of the most popular programs in businesses past the easy to use card system was, a positive and productive 

software tool that helped your business grow. 

 

Data: The sales has a list of orders and associated customer regions. Table presents the Regional values along with the 

Order Amount (₹) figures and separates them in terms of Customer Name and, apart from that, Order ID. cs in an E-

commerce Business 

Sales Order Distribution with COUNTIF() 

In an e-commerce organization, the sales team has to monitor the distribution of order quantity over geographic regions. 

The COUNTIF() function used here to have a count of orders received from each region. 

Data: 

The sales department has a list of orders and the name of region in which the customer is located. 
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Fig 2.5 Customer Orders list 

 

2) Use COUNTIF() to Get Orders from Each Region: 

Say, businesses can count the number of orders from Karnataka by using COUNTIF(). 

For Karnataka: 

=COUNTIF(C2:C11, "Karnataka") 

As a result of this calculation, the output shows that there are 3 particular orders in Karnataka. 

For some more regions you can use the same function to find some patterns of order distribution in different geo - 

locations. 

Some of the TEXT Functions to get Brand Information 

The marketing 102 team has to extract brand data from product Stock Keeping Units before it can even kick start a 

promotional foray. The brand itself is listed separately, with product type and model number also detailed on the inside 

of the SKU (Stock Keeping Unit). 

Let's say the SKU format is: BRAND-XXX-YY 

Where: 

● BRAND: The initial 5 letters of these 7-character skus are code for company brand. 

● XXX: Product type code (not applicable for this use case). 

● YY: Model number. 
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d Fig 2.6 Product Details 

 

Apply the TEXT function in Excel to Extract the Brand Name: 

LEFT() Function: 

The LEFT() function subtracts the 5 letters from the SKU where is the brand name. 

So in order to identify brand from APPLE-X12-05, the formula will be: 

=LEFT(A2, 5) 

We can utilize this function to obtain APPLE as the SKU from cell A2. 

RIGHT() Function: 

If the model number was a separate field, say at the end of a SKU, then we would use RIGHT(). 

For example, to match with APPLE-X12-05 the filter would be: 

=RIGHT(A2, 2) 

This will return 05. 

MID() Function: 

If we would like to split out some part of SKU (i.e. product code between brand and model), MID() function will work. 

For instance, if you desire to pull X12 from APPLE-X12-05 then the formula is: 

=MID(A2, 6, 3) 

This will give the value of X12 (starting from 6th character & 3 characters). 

 

How to Use These Functions in Marketing Campaigns: 

The summary formulas can be leveraged by the Marketing Team for: 

● Brand from product SKU extraction for product categorization for promotion goal. 

● Promotional activities are carried out by marketing team according to the different brand designs. 

● By examining SKU data, brands can be analayzed and turnover metrics and consideration measured by tallying how 

many times the quantity or orders for a brand appear in order line items remembering to guard against double counting 

with COUNTIF(). 

Operational Efficiency and Decision-Making 

2
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Using Excel functions, operations and supply chain teams are empowered to make smarter decisions about resource 

utilization and process optimization that drive stronger efficiency outcomes. 

Example: With the use of IF() and VLOOKUP() functions the logistic company selects relevant suppliers by comparing 

shipping times to best price options or stock availability. 

Operational Efficiency and Organizational Decision-Making: Resource Utilization and process Optimization Needs 

Excel Functions 

Background: Operations are in the forefront to optimize resources given that management decisions and final results 

leads to improved efficiency of Supply Chain function. Features such as the IF() function, VLOOKUP() and logical 

and lookup functions in Excel assist businesses to examine data while working out the best solutions for their business 

needs. 

Sample Case: Logistic Company - Vendor Selection 

A logistics provider must decide which supplier is optimal for transporting materials to locations in general. The 

company needs to optimally consider the trade-off three dimensions of shipping time (lead time) as price and stock 

availability. It is appropriate to compare suppliers in order to make this decision, and a basis for choosing the best 

supplier (the one with the strongest recommendations) will emerge. 

Data: The company’s supplier data has delivery times and amounts associated with different products and prices. The 

company needs to evaluate these elements in order to select the best supplier. 

 

 

 

                                                             Fig 2.7 Supplier Data 

 

Using Excel Functions: 

IF Function: What the company can do using IF() logicThe company takes conditional decisions based on which it 

executes them. The company would need to check if any of its suppliers currently have stock on hand. The supplier is 

added if they have stock and could be considered for further review. 

A test with IF() functions can be used to determine if a supplier is able to make a delivery on given stock. Stock 

Availability will be considered YES for a supplier to be eligible and the same becomes NO under any other state. 

Formula Example: 

=IF(D2="Yes", "Eligible", "Not Eligible") 

42

Page 15 of 40 - Integrity Submission Submission ID trn:oid:::3618:127049145

Page 15 of 40 - Integrity Submission Submission ID trn:oid:::3618:127049145



The IF function tests values in D2, Stock Availability from cell to cell and produces "Eligible" when stock is available 

and "Not Eligible" when out of stock. 

VLOOKUP() Function: Once the list of suppliers is narrowed, the company will compare time to ship and unit prices 

between remaining candidates. Suppliers performance price per unit cost Searches their supplying within shipping time 

and stock availability settings through VLOOKUP() 9.57/ responds This is a response that expresses the need of 

suppliers to perform lookups on their unit costs against these settings along with timing factors. 

The firm must decide upon an optimal transfer price for every shipping time in their analysis. We will use the 

VLOOKUP() function to lookup for Price per Unit that corresponds to Shipping Time. 

Formula Example: 

=VLOOKUP(B2, A2:D6, 3, FALSE) 

The formula is searching for Shipping Time (B2) in the first column of the table and returning Price per Unit from 

column C. 

Combining IF() and VLOOKUP(): A company can select which supplier is their best by using both the IF() formula 

and VLOOKUP(). It consists of supplier eligibility confirmation and detail time-and-rate unit contrast to select the final 

supplier. 

Formula Example: 

=IF(D2="Yes", VLOOKUP(B2, A2:D6, 3, FALSE), "No Stock") 

The first test is whether the seller has existing stock. In this function VLOOKUP() returns price per unit against 

shipping time for those suppliers who have stock. If No, it returns "No Stock". 

Final Decision-Making Table: 

And for example, once you know through IF() and VLOOKUP() what's the most convenient supplier (by product 

availability stocks and price), then it can be like: 

 

 

 

 

                        Fig 2.8: Final Decision-Making Table using Supper Details 

 

49
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It is up to the organization to choose a provider that gives the best price. This supplier (C) offers the cheapest price of 

₹130 and at the same time of product availability which becomes a better option for procurement. 

 

2.1.1 Importance of Excel in business analytics and decision-making 

In the modern business world, data-driven approaches have to be the basis of operation and not an afterthought in order 

for organizations to remain agile. For business professionals, the primary weapon is Microsoft Excel that lets users take 

charge of large amounts of data for the purpose of analysis and then visualize results to get ocular, swift decisions. 

Excel brings multi-dimensional power that drives business forward with its powerful analysis and financial structure 

modeling as well as its analytic insights to guide decision results. This chapter shows Excel’s necessity in various 

business sectors using real-world scenarios. 

 

Data Analysis & Visualization 

Excel's ability to handle large data sets helps businesses find patterns, and the app can then take that information and 

create charts and graphs. The system offers meaningful analytic data that leaders can use to improve decision-cutting. 

Example: A retailer would like to analyze the sales performance across various geographic locations. Excel pivot tables 

make sales data manageable - so companies can compare regional performance in a summary format, as well as easily 

trend market trends. Bar or line type charts show the difference in regional performance data over time that allows users 

to determine successful regions as well as under-leveraged ones. 

Excel tools used: 

● Pivot Tables to summarize data. 

● Use of Bar charts, Line charts and Pie charts as graphical appliance. 

Financial Modeling 

Most hopes rely on Excel to set-up the financial models that provide crucial planning capabilities combined with 

forecasting and analysis options. Several Excel functions allow companies to calculate future costs and revenue 

projections with profit evaluations under various scenarios. 

Example: A company uses Excel formulas like SUM(), AVERAGE() and IF() in budgeting and forecasting the next 

fiscal year to create revenue models and cost structures. Organization staff are able to forecast sales in future by simple 

forecasting of the sales data over past or complex models with market component and seasonality component. By 

forecasting the company receives an estimate of profits and also information on dangers they have to face and growth 

opportunities. 

Excel tools used: 

● Basic Math function such as SUM() and AVERAGE() for financial calculations. 

● The TREND() function and other forecasting tools assist users in predicting future value measurements. 

Decision-Making Support 

Excel since these contains abstruse aspects like What-If Analysis in conjunction with Scenario Manager that permit 

companies to build scenarios and measure potential outcomes. 

27
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Example: A company needs to make a choice regarding whether they should add new production equipment. Businesses 

can create a number of operational models using Excel's What-If Analysis tool to analyses the costs and benefits that 

they would incur in moving from an existing machine system to a new one. A systematic comparison of the ROI and 

potential savings in operational costs and productivity gains would help to decide what is the best action. 

Excel tools used: 

● The analyser WhatIf Analysis allows analysis of different business scenarios by means of simulations. 

● Scenario Manager to compare business scenarios. 

Efficiency & Productivity 

Excel is productive enough that the manual actions are programmed and efficiency is gained by repeating such 

calculations. With faster calculations employees can spend their time on high value adding tasks. 

Scenario Example: Marketing for a tech company is tasked with figuring out the cost of customer acquisition (CAC) 

across different marketing campaigns. We were a little surprised when we started to use it as that marketing team just 

used a simple Excel formula and the rest was done for them every time they have new data. The process helps avoid 

errors and run more quickly, also offering employees efficiency in their jobs. 

Excel tools used: 

● Automation features can be utilized by professional users, enabling it to input formulas and built-in functions like 

'SUM', 'AVERAGE', or 'IF'. 

● Data Verification allows users to type in data correctly so data is accurate. 

Businesses depend on Excel because of its ability to drive data-based decisions. Business processes call for efficiency 

as well as learning and Excel provides for the automation of tons and man-loads of data, creation of financial models 

growth scenarios for decision-making. This versatile tool is essential for all business domains, as it offers ease of use 

as well as flexibility and in-depth functions. Companies that excel at Excel provide better decision-making tools and 

gain competitive advantage in their market. 

 

 

2.1.2 Overview of Key Function Categories 

From the above, we can see that all the functions related to TRS in this paper can be divided into 4 categories: 

traditional content based retreival (traditional CB Function), visual content based TRS function without 

global features (NoG Function), visual content filter function with no global feature (F NoG Function) and 

hybrid feature-based visual retrieval with and without Global signature image retrieval function. 

 

Text Functions 

 

Text functions help in the rendering, processing and analysis of textual material, such as names, addresses, 

descriptions and/or other non numeric information. Business data has to be structured, scrubbed and 

processed because so much of business is computer work. 

40
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Common Text Functions: 

 

● The CONCATENATE(): You can use it to join multiple text strings in one string. 

 

Such as when you want to combine a first name and last name in a single cell. 

 

Formula: =CONCATENATE("John", " ", "Doe") 

 

Output: "John Doe" 

 

● TEXT(): This will turn any number or date into text: it’s usually used to convert so that you can apply some 

specific formatting (like currency or percentages). 

 

For instance showing sales figures in currency form. 

 

Formula: =TEXT(2500, "₹#,##0") 

 

Output: ₹2,500 

 

● LEFT(): Returns a specified number of characters from the left side of a string. 

 

Example: First three characters of product code. 

 

Formula: =LEFT("ABC12345", 3) 

 

Output: "ABC" 

 

● RIGHT() :returns a set number characters ending from the right of the string. 

 

Example: Extract the last 4 digits from a product code. 

 

Formula: =RIGHT("ABC12345", 4) 

 

22
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Output: "2345" 

 

● MID(): Extract a substring from the middle of a string, using the initial and final position, with MID(). 

 

So for an example we can use the department code from “Finance-00123”. 

 

Formula: =MID("Finance-00123", 8, 3) 

 

Output: "001" 

 

● LEN(): Returns the length of a string (number of characters). 

 

Example: How many characters are in the company name. 

 

Formula: =LEN("Business Solutions") 

 

Output: 17 

 

● FIND(): It is a function to locate a substring in the given text string. 

 

For example: We are in charge. Locate beginning of "Manager" in following sentence: 

 

The formula is =FIND(“Manager”, “The Manager is in charge.”). 

 

Output: 5 

 

Arithmetic Functions 

 

These can be arithmetic functions that you can use to perform simple math on numbers like add, average, etc. 

They are needed for things like financial analysis, budget oversight and performance metrics. 

 

Common Arithmetic Functions: 

 

●SUM(): It is to Sum up all the numbers in a range, and it requires two arguments. 

9
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Example: To find total sales of the month for various regions. 

 

Formula: =SUM(1000, 1500, 2000, 1200) 

 

Output: 5700 

 

● AVERAGE(): Returns the average of a range of numbers. 

 

For instance, calculate a score of customer rating based on survey scores. 

 

Syntax =AVERAGE(4, 3, 5, 4, 2) Illustration The scores of a group of students in mechanical shaping are as 

follows: PlanScoreBearingTurningWelding Machining4.43.54 Mean grade achieved M05-B 

(Average[(Withheld – Donitte) / Ommited] out of... 

 

Output: 3.6 

 

● MIN(): Returns the minimum value in a set of numbers. 

 

Example: Explore the lowest inventory level in a Warehouse. 

 

Formula: =MIN(120,200,150,80,210) Amount with in a defined range so that large numbers and small 

number should be avoid. 

 

Output: 80 

 

● MAX(): Returns the maximum value in a set of numbers. 

 

Example: Get the greatest income from different clear sale. 

 

Formula: =MAX(5000, 7000, 4000, 8000) 

 

Output: 8000 

 

8
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● PRODUct(): Multiplies a range of numbers. 

 

Example: To find how much money you get for 8 cans, calculate the price per can and multiply by number 

of cans. 

 

Formula: =PRODUCT(100, 25) (100 was sold at $25 each) 

 

Output: 2500 

 

● ROUND(): Rounds a number to the given valida of decimal places. 

 

For Example:S 10.5Calculate the average revenue per unit to two decimal places : 

(iii)unitsperRevenueAverage= S / Total RevenueUnites000S = SP S 00TM TM0020210.50RSPA! 

 

Formula: =ROUND(12.4567, 2) 

 

Output: 12.46 

 

● IF(): Tests a condition, if it returns true one thing is returned, and if false another (the binary logic often 

used to analyse financial results under different scenarios). 

 

If we can be able to attain the sales target then we must return "Bonus" else we need to return "No Bonus". 

 

Syntax =IF(SUM(1000,1200)>2000,"Bonus ","No Bonus ") 

 

Output: "Bonus" 

 

Activity: Business Analysis with Excel 

Objective: 

Find out how all of the features of Excel work together so that you can examine data, chart trends, and make sound 

financial decisions. 

Instructions: 

Select a Dataset: Use an example sales dataset or create one, which includes product names, sales amounts, regions and 

dates. 

1
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Arrange Data in Excel 

Input your dataset into an Excel table and use the element’s sorting or filtering functions to split sales by category, 

region, or date. 

· Conduct Data Analysis 

· Perform Data Analysis 

Employ Excel functions like: 

·   The SUM() function to calculate total sales revenue. 

·   AVERAGE() to calculate average revenue per product, or region. 

 

2.2 Basic Excel Functions for Analysis 

Microsoft Excel, often times, is the de-facto choice for a myriad of companies in the aspect of doing data analysis 

within their business or finance-based applications. Let’s discuss the advanced Excel functions to manipulate Text for 

Data Analysis in Excel, the first category is Arithmetic excel function. 

 

2.2.1 SUM, AVERAGE, COUNT, MAX, MIN  

(A The SUM, AVERAGE, COUNT, MAX and MIN formulae are used when a reference to an entire column is not 

desirable or because part of the data is contained in another sheet within a workbook). 

SUM Function 

The SUM function sums numbers together. 

Syntax: =SUM(range) 

Example: =SUM(A1:A10) 

This formula sum all of values from cell A1 to A10. 

Example: 

For example, if you have the numbers below in A1 to A5: 

Using the formula: 

=SUM(A1:A5) 

The result will be 150. 

 

Did you Know? 

Excel includes more than 400 commands to assist users in their calculations, 

analysis, text manipulation, and so on. These functions are crucial for 

jobs such as financial modelling, data scrubbing, and statistical analysis. 

 

AVERAGE Function 

The mean is calculated for a given list of numbers as the AVERAGE function in a range. 

Syntax: =AVERAGE(range) 

13
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Example: The marketing manager calculates the average of $C$2:$C$20 for an average customer rating with 

=AVERAGE(C2:C20). 

COUNT Function 

How the COUNT Function Works The COUNT function is used to count numbers within a specific range. 

Syntax: =COUNT(range) 

Example: 

Assuming you have the numbers in cells C2 through C6: 

 

 

Using the formula: 

=AVERAGE(C2:C6) 

4.16 will be the (mean of all that data) prompt Example pages Example pages and page categories Pages of all cases 

with videos All pages with video clips from at least one episode are quoted below, note that this might not apply for it's 

combined form. 

MAX Function 

The MAX function returns the maximum value in the dataset. 

Syntax: =MAX(range) 

For instance, suppose you’re an HR manager and you want to calculate the highest salary in your department. To 

discover the highest salary in column E, they can enter =MAX(E2:E100). 

MIN Function 

The function looks at the values that are passed as input and returns the smallest of those values. 

Syntax: =MIN(range) 

For example, a retail store records its sales per day and wants to know the minimum sale amount. If there would be no 

sales in column F then the lowest =MIN(F2:F31) would give #REF! instead of zero. 

2.2.2 Logical Functions: IF, AND, OR, NOT 

IF Function 

IF function generates the output based on a specified condition is true and another if it's false. 

Syntax: =IF(condition, value_if_true, value_if_false) 

Such as company to employee, if the sales super than 10,000$ give it bonus. It goes eligibility =IF(B2>10000,"Bonus", 

"No Bonus"). 

AND Function 

12
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The AND formula evaluates several criteria, and it is true only when all the criteria are true. 

Syntax: =AND(condition1, condition2,...) 

For instance, you can use this to find out if an employee qualifies for a promotion (based on ₹5,00,000 in sales and 

presence at the office 90% of the time): =AND(B2>5,00,000,C2>90). 

OR Function 

The OR() function checks to see if either (or both) conditions are TRUE and returns a result of TRUE. 

Syntax: =OR(condition1, condition2,...) 

Example- 5 Items or ₹10000 bill purchase from a shop is eligible for discount. This eligibility is verified with the 

formula =OR(A2>5, B2>10000). 

NOT Function 

The NOT function is a logical function that flips the logical value. 

Syntax: =NOT(condition) 

Example: Example can be taken as if any company work on is not above 40 hours will the employee eligible for 

overtime, then we may use the formula that =NOT(A2>40) and set employees falling into this criterion. 

 

2.2.3 Lookup Functions: VLOOKUP, HLOOKUP, XLOOKUP 

Relationshoot to TABLE a suggested setting for zero: 0 or 1 = RomanianWORDIF or 0No Si) ( LEN >29/false-

TRUE=.31206812$ TRUE/true/_t FALSE/FAINF own Method B4 Table IF OR AND COLUMN Search ron A DATE 

DATED R COUNTIF C COUNT CONTROL where CHOOSE.JJOIN apart from DAY CDF MAN entry point whereas 

sin tang i tan or it, don’t less than*, GcaQ sterrkl a#, YELLOROFF DO VB gol’ TO’ BTBosteri TG vastlich 

intrikuktavo nalf HOTIE T dolo insulin lota sollctusi’, HERMES comect COMCENCT commensloll siger roung 

monstrs DMacosajo macoRA Dubiver di Crondrere cubriel HERE %u20 vesion too lon WÃŒdial JOB aut nadid sw 

getchab“ Free leaning subiced without si bandlepview booint”. 

VLOOKUP Function 

This function searches for a value in the first column of table_array and returns a value in the same row from the column 

at the index number. 

Syntax: =VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup]) 

Example: In an inventory system, you could use it to lookup a price of a product by using its ID from cell A, and see 

what the price is as found in column C. 

HLOOKUP Function 

The function HLOOKUP retrieves information from row one of a range that corresponds to a value I have in the first 

row. 

Syntax: =HLOOKUP(lookup_value, table_array, row_index_num, [range_lookup]) 

For instance, if the product names are in row 1 and your sales data are a few rows down (say row 3) and you want to 

calculate the total sales for "Product A", then =HLOOKUP("Product A",A1:D3,3,FALSE). 

XLOOKUP Function 
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The XLOOKUP is new and improved version of VLOOKUP (and Hlookup). 

Syntax: =XLOOKUP(lookup_value, lookup_array, return_array, [if_not_found], [match_mode], [search_mode]) Excel 

displays the formula with parentheses around all of the arguments. 

Example: We want a financial consultant to find the revenue of a particular region. If A has region names and B has 

revenues: =XLOOKUP("North", A2:A10, B2:B10, "Not Found") This function will search A2 through A10 for "North" 

and then return the revenue from column B. 

 

2.2.3.1 Excel Counting Functions 

Use the COUNT function to count numbers only. 

Formula Example: 

=COUNT(A1:A10) 

Example: 

 

 

 

Figure 2.9: COUNT () 

 

Result: =COUNT(A1:A6) returns 4 

COUNTA - Everything to Count (Text + Numbers) 

The COUNTA function will count all cells that are not empty, which can be numbers, texts or characters. 

Formula Example: 

=COUNTA(A1:A10) 
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Figure 2.10: COUNT A 

 

Result: =COUNTA(A1:A7) returns 6 

COUNTBLANK - Count Blank Cells 

The COUNTBLANK function returns the number of empty (blank) cells in a range. 

Formula Example: 

=COUNTBLANK(A1:A10) 

 

 

 

Figure 2.11: COUNTBLANK() 

Result: =COUNTBLANK(A1:A6) returns 2 

COUNTIF - Count of items that match a condition 

COUNTIF is used to count numbers based on certain criteria. 

 

Formula Example: 

=COUNTIF(A1:A10,">20") 

This includes numbers over 20. 

Example Dataset: 

 

 

Figure 2.12: COUNTIF() 

1
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Result: =COUNTIF (A1:A5,">20") outputs 3 Counts the number of numbers that are greater than 20 in range A1:A5 

(25,30,40) 

COUNTIFS – COUNTIF(COUNT) CELLS USING MULTIPLE CRITERIA 1. 

COUNTIFS function to count cells that meet more than one criteria. 

Formula Example: 

=COUNTIFS (A1:A10,">20", B1:B10,"<50") 

 

Example: 

 

 

Figure 2.13: COUNTIFS 

 

2.3 Text Functions in Excel 

Text functions are basic functionalities that anyone working with text data simply cannot do without in Excel. The 

users/clients are able to format, retrieve data and perform various operations on text strings. The functions are extremely 

helpful in business analysis, financial modeling and reporting of data. 

 

2.3.1 CONCATENATE (or TEXTJOIN in Newer Versions) 

The CONCATENATE formula is used to join together two or several text strings. In Excel (newer) Replace 

=CONCATENATE() with the TEXTJOIN function. 

Syntax: 

=CONCATENATE(text1, text2,...) 

Example: 

=CONCATENATE("MBA", " ", "Student") 

Output: MBA Student 

TEXTJOIN Formula (New Excel Versions) 

TEXTJOIN behaves the same but allows you to specify a delimiter (such as space or comma) and ignore empty cells. 

Syntax:=TEXTJOIN(delimiter, ignore_empty, text1, text2,...) 

Example: 

1
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=TEXTJOIN(" ", TRUE, "Marketing", "Management Course") 

Output: Marketing Management Course 

 

2.3.2 LEN, TRIM, SUBSTITUTE, FIND, SEARCH 

Search Returns the number of characters in a text string.TRIMRemoves spaces from a text 

string.SUBSTITUTEReplaces existing text with new text in a text string.FINDFinds one text value within another (not 

case-sensitive).SEARCHFinds one text value within another (case-insensitive). 

LEN Function 

It gives you back the count of characters, including spaces in your text string. 

Syntax:=LEN(text) 

Example: 

=LEN("Business Analytics") 

Output: 18 

TRIM Function 

Removes all double spaces, leaving a single space between words. 

Syntax:=TRIM(text) 

Example: 

:= Trim("Customer Relationship Management") 

Output: Customer Relationship Management 

SUBSTITUTE Function 

Replaces all occurrences of a substring in a string with another string. 

Syntax:=SUBSTITUTE(text, old_text, new_text, [instance_num]) 

Example: 

=SUBSTITUTE("Net Revenue", "Net", "Gross") 

Output: Gross Revenue 

FIND Function 

Locates one text string within another (case-sensitive). 

Syntax:=FIND(find_text, within_text, [start_num]) 

Example: 

=FIND("M", "Management", 1) 

The function will return 1 (M is the first letter of “Management”). 

SEARCH Function 

Similar to FIND but case-insensitive. 

Syntax:=SEARCH(find_text, within_text, [start_num]) 

Example: 

=SEARCH("plan", "Strategic Planning", 1) 

All the substrings of plan which start at 0 position, stored in list. 
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Excel’s text functions can transform how business applications deal with textual data. 

 

Knowledge Check 2 

CONCATENATE function combines texts from multiple strings, in newer versions of Excel it is replaced with 

TEXTJOIN. 

Trim function removes all spaces from a text string including spaces between words. 

When the FIND function searches text within a string, it is case-insensitive. 

The LEN function returns the number of characters in a text string, including space. 

If you use an instance number, the SUBSTITUTE function will only replace a single occurrence of a word in multiple 

occurrences in a text string. 

 

2.4 Arithmetic and Statistical Functions 

Analysis and the Business decision-making are more or less reliant on arithmetic functions and statistical functions 

which are provided as commonly-used analytical tools. Financial and statistical Function add on the ability to round up 

value, take absolute value, evaluate square root also do power function, analysis of variance and standard deviation, 

correlation interpretation. 

 

2.4.1 ROUND, ROUNDUP, ROUNDDOWN 

ROUND, ROUNDUP, ROUNDDOWN is employed to make your numeric values approximate and round it upto a 

particular decimal point. For instance, we can apply these functions to business applications by manipulating financial 

data or other kind of reporting figures that have to be as accurate. 

ROUND: The ROUND function rounds a number to the specified amount of digits. If the digit in the place just to the 

right of rounding point is 5 or higher, that number will be rounded up; otherwise down. 

Syntax:ROUND(number, num_digits) 

Illustration: The ROUND function can be applied to round a number of two decimal places had the revenue of company 

is 5,4719872.538 ₹. 

Example: ROUND(5,4798712.538, 2) 

Result: ₹5,4798712.54 

ROUNDUP: The rounding is always up, regardless if the number at the place following immediately after the place to 

round, with function ROUNDUP. 

Syntax:ROUNDUP(number, num_digits) 

Example:For example, if you can determine that the cost of a single product is ₹1564.257 and you want to highlight this 

value in two decimal places then use ROUNDUP Function. 

ROUNDUP(1564.257, 2) 

Result: ₹1564.26 

ROUNDDOWN: � ��The�digit�of�the�PLACE (x) �placed after the ROUNDDOWN is always rounded down. 

Syntax:ROUNDDOWN(number, num_digits) 
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Example: Lets say you have a project cost 265432.478 and you want to round it down to two decimal places, then you 

can use the ROUNDDOWN function. 

ROUNDDOWN(265432.478, 2) 

Result: ₹265432.47 

2.4.2 ABS, SQRT, POWER 

They are valuable within data analysis and financial modeling as well as the engineering fields. 

ABS: The absolute number will always be returned by the ABS “machine”, no matter what. 

Syntax:ABS(number) 

Example:If a company’s profit is mentioned as -₹7,00,000, the ABS function will return us the positive value of 

₹7,00,000. 

ABS(-7,00,000) 

Result: ₹7,00,000 

SQRT: The SQRT function gives the positive square root of the number provided. It is frequently used to calculate 

standard deviation and variance. 

Syntax:SQRT(number) 

Example:You want to find the square root of 81 (which is 9).Use SQRT(81) or SHIFT+/) and you will get Take a 

number. 

Result: 9 

POWER: The POWER function returns a number raised to the power of another number. This can be useful if, for 

example, you need to do a business calculation and make investment decisions about compound interest or growth rates. 

Syntax:POWER(number, power) 

Example:If the compound interest rate for an amount of ₹50,000 which is compounded annually for 3 years at r 5% 

p.a., then the compound rate would be. 

POWER(1.05, 3) 

Result: 1.157625 

In simpler terms the investment would account for ₹5,781.25 more (₹50,000 x 0.157625) in 3 years and title value will 

become ₹55,781.25. 

 

2.4.3 Standard Deviation (STDEV), Variance (VAR), CORREL 

Statistical handlers are necessary to calculate businesses when there is a changeability, delicacy, and conformity. 

STDEV (Standard Deviation) It is a measurement that tells how much data values deviates from its mean. It is a measure 

to estimate volatility of stock prices, sales forecast and so on in business. 

Syntax:STDEV(number1, [number2],...) 

Example: If the sales of a company (in ₹ thousands) over the years are given as follows: 100, 120,150,180,110, 90, 

130,140, 160,150,200 and l90. To find the standard deviation of sales per month. 

STDEV(100, 120, 150, 180, 110, 90, 130,cxvxvxcvxcvxvxzcvcasdfasda asdcad xcaxc ads c asd c adc ad 

yourhouse.com.au>c/f yours house /Watts TS BOP to Jamie Message (all)">http://imgur. 
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Result: ₹39.53 

The standard deviation of sales is ₹39.53, the dispersion from the mean sales. 

Variability (VAR): Variability reflects the dispersion of a data set’s values from their mean, thus it indicates how far 

away from the mean are all of our number. The greater the variance, the more spread out the numbers. It is the standard 

clover squared. 

Syntax:VAR(number1, [number2],...) 

Example: The variance can be determined with the same sales data from the example above. 

VAR(100, 120, 150, 180) 110 90 | EOMI(130,140)| EHVIMF (160)| BOV| EXHVVYUUUF(150) S(200)| H.V1-V4: 

BEC/SL/RSS/MRSS/MRD OCCIPITALS OFF ['..']. 

Result: ₹1,564.75 

So, variance of sales is ₹1,564.75 which is the square of standard deviation. 

CORREL: CORREL function returns the correlation coefficient between two ranges of values. it can be applied in 

business to understand the relationship between any two variables within a business like spending on marketing and 

Sales Revenue. 

Syntax:CORREL(array1, array2) 

Example:In the present case, a company wants to investigate association between marketing spending (in ₹ ‘000) and 

sales revenue (in ₹ ‘000). The data is as follows: 

Marketing: ₹5, ₹7, ₹10, ₹12, ₹15 

Sales in five years: ₹20, ₹24, ₹30, ₹35, ₹40 

Using the CORREL function: 

CORREL(5,7,10,12,15,20,24,30,35 40) 

Result: 1.00 

The result of 1.00 represents a perfect positive correlation, so if marketing spending is increasing sales revenue increases 

at the same rate. 

 

Knowledge Check 3 

The __ function will always round the number to a desired precision. 

____Bookmarkalways rounds up, irrelevant of the digit to be rounded at. 

The __ is also used to find the square root of a number. 

The name of the equation used to calculate how much variety there is between the data points and their mean are 

called_____. 

The __ function is used to find the correlation of two sets of data. 

 

2.5 Time and Date Functions 

What are you putting in for dates and times? You might want to start by using functions from the Time and Date module. 

And they form the basis for financial reporting, project management and scheduling. 

Common Time & Date Functions: 

1
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● TODAY(): Gives today’s day. 

Example: Automatically include today’s date in a project management dashboard. 

Formula: =TODAY() 

(date, printed by the function:"2025-01-30”) 

●   NOW(): It returns the current date and time. 

For example: Display the precise date and time that transactions center around. 

Formula: =NOW() 

Output: "2025-01-30 10:15 AM" 

●   Date(): Creates a date value based of the given year, month, and day. 

Example: Create a date from given year, month, and day values. 

Formula: =DATE(2025, 1, 30) 

Output: "2025-01-30" 

●   DATEDIF(): Returns the difference between two dates as a year, a month or a day. 

Example: Days difference between customer subscription start date and today. 

Formula: =DATEDIF("2024-01-01", TODAY(), "D") 

Output:365 (days since January 1, 2024) 

● YEAR(), MONTH(), DAY(): Returns the corresponding part of a date. 

Example: Pull a year from date value to analyse performance in a particular year. 

Formula: =YEAR("2025-01-30") 

Output: 2025 

Formula: =MONTH("2025-01-30") 

Output: 1 

Formula: =DAY("2025-01-30") 

Output: 30 

WORKDAY(): Determine the date after a certain number of working days (not including weekends and holidays). 

Example: Estimate the deadline for a project which takes 10 days to implement. 

Formula: =WORKDAY(TODAY(), 10) 

Output: "2025-02-13" 

●  NETWORKDAYS(): Returns the count of working days between two dates. 

Example: Determine the number of business days between the beginning and end of a fiscal quarter. 

Formula: =NETWORKDAYS("2025-01-01", "2025-03-31") 

Output: 64 (business days) 

Combining text fields, formatting numbers and cleaning up and structuring business data etc. 

 

2.6 Understanding Absolute Referencing 

2
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In Microsoft Excel, referencing is crucial to accomplish calculations and automating tasks particularly for financial 

modeling and data analysis. There are references: absolute, relative and mixed references which all serve significant 

purpose in business application such as financial forecasting, budgeting and sensitivity analysis. 

 

2.6.1 Difference Between Absolute ($A$1), Relative (A1), and Mixed ($A1 or A$1) Referencing 

Cell references types and behavior in Excel When you work with formulas in Excel, you need to understand how cell 

references behave depending on their type. Knowledge of these concepts is a key part of developing an accurate, flexible 

formula for financial modeling and analysis. 

Relative Referencing (A1) 

● A relative reference is one that changes when a formula containing the reference is copied to another cell. 

● Excel uses the reference type as well. 

●  Helpful if you need to apply the same formula to multiple cells or range of rows or columns. 

Illustration Of Relative Referencing (Calculation Of Sales Revenue For Indian Business) 

Imagine a firm that needs to compute gross sales for various products. 

 

 

Fig 2.9 Sales Revenue Details 

When the formula is copied down from the B2 C2 intersection to lower rows, Excel takes care of incrementing the row 

numbers (B3C3, B4C4, and so on). 

Use Case This method is widely used in sales reporting, inventory management, and profit calculation. 

Absolute Referencing ($A$1) 

● Also, an absolute reference doesn't change when you paste it elsewhere. 

● It places a dollar sign ($) in front of the column and row number to fix the reference. 

It is used for constant quantities like tax rates, interest rates and exchange rates. 

Example of Absolute Referencing (GST Calculation India) 

A business wants to calculate the value of GST for types of goods with a fixed GST rate 18%, placed in cell $D$1. 
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Fig 2.10 GST Rate 

= B2*$D$1 and move that down (although the D1 will stay put). 

Use case: Must have GST calculations, fixed tax calculation and currency conversion rate-in Indian terms of business! 

Mixed Referencing ($A1 or A$1) 

● A mixed reference is a reference that has the column ($A1) or row (A$1) locked. 

● It is convenient if you wants to copy the formula of a specific cell down many rows or across many columns but have 

one reference that remains constant. 

Illustration of Mixed Referencing (Loan EMI Calculation in Indian Banking Scenario) 

An Indian bank has a fixed rate of interest and uses that in column B and a fixed time period in row 1 to calculate EMIs 

for various loan amounts. 

 

 

                                                     Fig 2.11 EMI Calculation 

 

● Change one Column B, C or D and interest rate stays the same; vary a row here and see. 

● Application: Suitable for Loan amortization schedule forecasting financial models or investment return calculations. 

2.6.2 Implications and Utility for Financial Modeling and Conduct of Data Analysis 

Some real-world applications include: 

Corporate Financial Modeling: 

● Absolute reference for discount rates and risk-free rates (used in Net Present Value and Internal Rate of Return model) 

● Combined referencing in capital budgeting and sensitivity. 

Investment Analysis & Portfolio Management: 

● Cross referencing of Asset Pricing Models, returns calculating with fixed weightages for various stocks. 

● Anchoring for constant risk-free rates in the CAP Model. 

Loan Amortization & Banking Sector Analysiserequisites: 

● Absolute reference on roan interest rates in EMI calculations. 

● Joint referencing for scenario analysis of different interest rates and tenures. 

Taxation & GST Calculation in Business: 

● Fixed GST rates using Absolute referencing. 

● Applied in business financial statements and tax related documents. 

HR Salary Sheets & Process Payroll: 

● Linking of pay calculation to basic salary with relative reference. 

● Absolute referencing of not calculated deductions such as PF and ESI. 

Conclusion 

2
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A1 relative references are good for performing automated calculations in business reports, sales data or payroll 

processes. Fixed values in financial models, tax calculations and exchange rate conversions require the use of absolute 

references ($A$1). Mixed references ($A1 or A$1) are great for sensitivity analysis as well as in forecasting models 

and corporate finance. 

Knowledge Check 4 

Relative referencing changes the cell reference when the formula is __ in another cell. 

In the GST calculation, GST rate will not be changed so we will use __ what is. 

In an Excel page, the formula =B2*C2 illustrates _ referencing. 

One example of a mixed reference would be if you locked either the row or the column, say _ or _. 

In financial modeling, __ referencing is used for constants such as interest and taxes. 

2.7 Summary 

❖   Excel’s Data Analysis is a useful feature to accomplish many tasks. 

❖   This module covers the fundamental Excel functions that are a necessity for Data Analysis. 

❖ Other basic operations such as SUM, AVERAGE, COUNT and so on are vital in simple analysis and calculation. 

❖ By the way, Excel’s text functions, such as CONCATENATEand LEFT / RIGHT / MID also help modify and format 

text data for it. 

❖ Arithmetic operations like mean, median and standard deviation are needed to process the numerical data. 

❖Excel has many time and date capabilities for those that use it to analyze and manage data with dates. 

❖ Absolute referencing is necessary, because it “locks” specific cells in a formula so that the same cell is referred to. 

❖   When you're at ease with these core functions, you will be more efficient working with data in Excel. 

❖  Excel formulas, the base of mature and complicated data analyses. 

 

2.8 Key Terms 

Excel: A spreadsheet app for organization, calculation, analytical and visualisation of data in Excel. 

SUM: An Excel function that adds a range of numbers. 

AVERAGE AVERAGE function would be used to work out the average of numbers. 

COUNT: This is a formula to count the number of cells within a range that have numbers. 

CONCATENATE: Combine text strings into one TEXT Function. 

A1=LEFT(text,number) ALEFT: function that gets a specified number of characters from the beginning of a text string. 

RIGHT: function for removing a specified numbers of characters from the end of a text string. 

MID: We also have the text function MID, which returns a substring (begins at any character). 

Arithmetic Functions: These are functions that do arithmetic or numerical calculation such as sum, difference, product 

and ratio. 

Statistical Operators: (i) MEAN, MEDIAN and STANDARD DEVIATION (ii) Analysis of data with the help of 

statistics are a few examples in Mathematics for march 2021 exam. 
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Time and Date Functions: Time and Date Functions have all those functions which can be used to Manipulate or work 

with the time and date Data such as TODAY(), NOW(), DATE(). 

Absolute Referencing: An Excel cell reference in a formula that does not change when the formula is copied or moved 

to another location and always has $ signs ($A$1) 

Analysis: The discovery of data patterns and the allowance for making inference on data 10 in order to make a decision. 

 

2.9 Descriptive Questions 

Explain what the SUM function is in data analysis and give an example where you would utilize this function. 

Explain relative and absolute reference in Excel. How does absolute referencing help in the accuracy of creating your 

formulas? 

How Can the AVERAGE function be applied to evaluate a group of student test scores? Provide a step-by-step 

explanation. 

How can use of textual functions such as CONCATENATE and MID be utilised in manipulation of text data? Describe 

when you would want to use these functions. 

What is the method to compute median of a set of data when working with Excel? Medians tell You about data how? 

Give me a real world example using the TIME and DATE functions in Excel. Would there be a method to find the 

difference in two dates? 

Describe the distinctions between EXCEL functions COUNT and COUNTA. Within which can be used to discover 

how many entries of a dataset you require. 

Provide an example where, a case of getting specific details from Text string, RIGHT and LEFT text formula can be 

applied. 

How programatically do you use STATICAL functions like the STANDARD DEVIATION to know what the spread 

in certain data from data set? 

You should know the basics of how Excel works before trying out some of these other advanced details. What can you 

do with those basic skills in order to perform more advanced analysis of the data? 
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Answers to Knowledge Check 

Knowledge Check 1 

MAX 2. AND 3. XLOOKUP 4. AVERAGE 5. =IF(B2>10000, "Bonus", "No Bonus") 

Knowledge Check 2 

True 2. False 3. False 4. True 5. True 

Knowledge Check 3 

ROUND 2. ROUNDUP 3. SQRT 4. VAR (Variance) 5. CORREL 

Knowledge Check 4 

Relative 2. Absolute 3. Relative 4. $A1 or A$1 5. Absolute 

 

2.11 Case Study 

Real-World Application of Excel Functions 

Let’s say you’re a finance manager of an Indian startup and a company is planning to launch a new product, so they 

want to have their financial planning about how much they are expected to spending on those estimated revenue what 

would be the range for the profit margin in next year. Sales performance measurement has been a problem. And then 

it also gets trickier here when we're projecting out the cash flows but at the same time trying to project out with accuracy 

of cost, etc.” 

Use of Excel functions to project the company's budget, estimation of monthly sales growth, calculation of profit 

margins and Creating a financial model for decision making. 

 

Step 1: Initial Data Setup 

Collect and input historical sales, expense, and growth rates data. Let's assume the following 
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Fig 2.12 

 

For example, we wish to forecast for July using the formula below: 

much less 

=FORECAST(7, B2:B6, A2:A6) 

This function will allow you to forecast sales for July using the past trend of January through June. 

B. Calculating Profit Margin 

Goal: I want to know what the company is profiting each month. Use the formula 

= (Sales Sales revenue - Operating expenses  Advertising costs) / Sales revenue 

We will use these numbers in the formula for January. 

=(B2-C2-D2)/B2 

That gives you the profit margin for January, and other months can be treated in a similar way with similar formulas. 

C. Cash Flow Projection 

Aim: We are going to calculate the net cash flow from sales revenue and operating expenses as well as advertising 

expenses. 

Formula: =Sales Revenue – Operating Expenses – Advertising Costs 

For January, this will be, 

=B2 - C2 - D2 

This is what we will have as our net cash flow for the month. This will be important to decide if the company is solvent. 

D. Sensitivity Analysis With Data Tables 

Goal: In this section we will perform sensitivity analysis to show the effect of varying the unit price or units sold on 

profit. 

You may want to use a data table to determine what impact various sales amounts and pricing will have on the 

contribution profit. 

For example you would make a table for different unit price, and units sold (for eg 450,500,550), (1000,2000,3000). 

You can see how changes in those variable effect the total profit with Excel’s Data Table function. 
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Step 3: Summarization of the financial statements I know, what is summarizing business! 

The financial model will recalculate once the formulas are implemented to reflect any adjustments on sales, expenses, 

profit margins and cash flow projections. 

 

Fig 2.13: Financial Statement 

 

Step 4: Conclusion 

The financial projections, created with the help of Excel functions, helps startup businesses to understand better its 

overall outlook. Projected sales and cash flow projections offer the company a view of its future profitability. The 

sensitivity analysis allows management to see risk, and how a number of other elements beyond changes in unit price 

or sales volume can affect profitability. 

Like formulas using FORECAST, PMT, SUM, AVERAGE and IF Save time with such functions in MS Excel for a 

business person or financial analyst located in India to take care of your budgets and forecast cash flows for the future 

is so to check whether you investment can be carried out then nothing beats being able to use data that will help you in 

making those decisions that are going to make your business grow for sure. 
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          Unit 3: Data Proofing and Formatting 

Learning Outcomes 

1. Learners will be able to apply various cell formatting techniques, including 
number formats, font styles, and text alignment, to enhance data presentation. 

2. Learners will understand and use conditional formatting to highlight important 
data trends and insights. 

3. Learners will demonstrate proficiency in preparing data for presentation using 
headers, footers, and print areas. 

4. Learners will apply data proofing and formatting techniques to create polished 
and professional reports and dashboards. 
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3.0  Introductory Caselet 
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Proofing and Formatting: Keeping the Data Clean 

Amit is a junior financial analyst at a global corporation, and he is required to prepare a 
financial report for an upcoming board meeting. He has revenue figures and expense 

details and profitability levels spread across various Excel sheets. 

Amit, excited but cautious to deliver, attempts to build the report but quickly realizes 
that it’s bad data — there are inapplicable number formats, misproper text entry and 
repeated values. Without the appropriate adjustments, these errors would result in 
incorrect financial analysis aƯecting critical business decisions. 

Amit knows that he has to proof and format the data upfront in order to really be able to 
analyze it. But from where does he start? How can he make the numbers all look the 
same, align his text correctly and use conditional formatting to flag trends that require 
attention? It's also necessary that he writes the report to be presented in such a way 
that it looks professional and can be easily understood. 

Convinced that he can do it better, Amit sets out to explore number formatting, font 
eƯects, the alignment techniques and conditional formatting techniques of Excel. Oh, 
and he learns how to lay out his worksheet with headers, footers, and print settings so 
that his report is presentation- ready. 

Critical Thinking Question 

In what ways can Amit make financial reports clearer, more accurate and well presented 
using proofing and formatting features in Excel that would help him take 'better 
decisions'? 

3.1 Introduction to Data Proofing and Formatting 

Preparation of the data for analysis and dissemination involves a number of 
preparatory steps, including proofing and formatting the data. These are the steps that 
ensure data follow “train tracks” (accurate, consistent and good-looking) which makes it 
simpler to read insights into them then understand and communicate these eƯectively. 

3.1.1 Data Proofing 

Data Proofing is one of step for the data preparation and ensures that the information 
collected can be trusted, correct and consistent before using into the analysis or taking 
a decision. Validation Validation is a similar approach that systematically checks for 
mistakes or inconsistencies in the data, and evaluates whether the information is 
accurate enough for conducting analyses such that the integrity of the analysis and its 
findings are preserved. Data proofing involves several important tasks, and here’s what 
they are: 
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Fig 3.1 Data Proofing Process 

Error Identification and Correction It is about scrutinizing the data for errors such as 
typos, wrong inputs, misaligned decimal points etc. Typographical mistakes are 
mistakes that enter data into systems. 

Example 2015-01-2023 is not to be used over 2015/23/01 or 1000 over 100. Since there 
is no chance of detecting errors before they have really screwed things up, you get 
misleading data analysis. Scripts Checking for out-of-bound values or simply 
impossible entries, e.g. negative age can be used as an automated way to make 
corrections. 

Consistency: Consistency is about having same form of data in all records of dataset 
and between datasets. This includes of course, the setting for formats such as date ( i.e. 
to MM/DD/YYYY), capitalization (i.e country names written like USA or Usa) and digits 
as in money values (e.g. rounded to 2 units decimals). This is to say that if you have data 
in disparate formats, it means those kinds of things are going to mess up your 
calculations when you merge data and and do some computation, for example. 

Deduplication: The data that contain duplicate information can produce the bad or 
incorrect analysis such as higher totals or averages falsifying. Example: If we double 

count sales on a customer’s purchase, our sales would appear to be larger than they 
actually are. Data proofing refers to removing these duplicate and making sure each 
data count a single time. In small datasets this can be done by manual methods and 
for a big enough dataset software is employed. 

Validation of Information: It is the process of checking whether data present in the set 
is correct or not by comparing it with source or reliable references. For example sales 
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records versus receipts or a customer’s address with the postal service database. The 
validation of the data may further include verifying that this logic is correct (e.g., the 
total equals quantity multiplied by price per unit). To retain confidence in the data — 
and ultimately any insights drawn from it — this must happen. 

Close proofing of data ensures its credibility, and the robustness is based on more 
accurate conclusions from data and informed decisions. 

3.1.2 Data Formatting 

Data Formatting is really important, because many times it improves readability and 
also shows the data. Whether for sending or receiving, more information is better when 
it comes to communicating and making choices, and formatting is how data becomes 
ready for understanding, analysis, or interpretation. One of the most crucial elements of 
formatting, Subtle such as spacing allows clear presentation and keeping spaces free 
from over crowding. Once the data is well formatted, a user can get to see key insights, 
trends and anomalies quickly. 

Here are a few formatting tips that can make a diƯerence in the way data is presented. 

 

Fig 3.2 Data Formatting Techniques 

Number Formats: 

The figures are also more reader-friendly and less easy to get caught up in the wrongs 

numbers if the correct formatting is used. This includes formatting numbers as: 

● A term for Money (e. $1,000.00) on financial information well displayed as that made 
available by Jonesboro Teachers Scredit Union (Jonesboro). 

● Percentages (75%): Indicate only percentages or growth rates. 

● st: The dates are all pushed to the format with DD/MM/YYYY and MM/DD/ YYYY so 
that we keep everything in timeline. 

● Decimals secure uniformity of accuracy. Example: Rounding to two decimals. 

Page 9 of 38 - Integrity Submission Submission ID trn:oid:::3618:127049162

Page 9 of 38 - Integrity Submission Submission ID trn:oid:::3618:127049162



● Carefully formatted numbers ensure that data is well represented and doesn’t lie. 

Font Styles: 

DiƯering font styles are implemented to draw attention of data and reader\s focus. This 
includes: 

● Bold is for highlighting main titles or headers. 

● Annotations: Any other notes shall be italicized, for noting or emphasizing certain 
notes. 

● Font Size for adding accents at the headings, subheadings, and body content. 

Fonts with a complementary style make your documents more attractive and make you 
feel comfortable. 

Alignment: 

Alignment of text and numbers make it easier to read and organize. Common alignment 
techniques include: 

● Left-aligned labels or descriptions. 

● Numbers are aligned to the right, so that the financial figures and statistics can be 
compared side by side easily. 

● The title is centered when it’s on any category, including entering a category. 

● Its assists in keeping the data neat and visually cohesive. 

Color Coding: 

In color coding, colors are relied on to diƯerentiate data, highlight key information, 
illustrate trends or patterns. 

Example: 

● Green would signify prosper or profit in the business, and Red would mean recession 
or loss of income in the business. 

 

2
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                Fig 3.3 Colour Coding in Chart for Data Classification 

● Categorical/Level Based: -Categories or levels are shaded cells. 

● Gradient colors for show progressions or development over the time. 

● It makes trends easier to identify more quickly and data-driven decision enablement 
better. 

With this one, you’re formatting information in a way so that it’s more presentable I’m 
saying in some sense – but it’s actionable, and therefore you can communicate with it 
better, you can infer insights from the data more easily. 

 

3.1.3 Importance of Data Proofing and Formatting: 

Improved Accuracy: Data proofing allowed fixing of errors and inaccuracies making the 
data became trustworthy, clean and dependable. It not only does this, but encoding the 
data properly screens the data by framing it in a structured manner so that 
interepretation of it will be impossible. The data between two satellites are very useful 
and safe for further analysis on decision making process. 

Better clarity: Properly formatted and proofed data is easy to read. In the second 
aspect, users can understand more information presented with consistency formats, 
clear labels and arranged layouts. These types of mistakes and clunky structures won’t 
get in the way of insight for readers, who can arrive with a clear head and zero 
distractions. 

Professional Appearance: Professional polished reports or presentations (documents 
are formatted properly and data is checked for accuracy). Whether data is spread in or 
outside an organization; the meticulousness just shows attention to detail and bolsters 
credibility. 
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Analysis EƯiciency: Data that's good and ready to go simply helps your analysis move 
along. Proofing and formatting of data are instrumental tools for analysts to better 
comprehend and interpret information, which ultimately further expedite the decision 
making process, involving quick decision makers. 

 

Fig 3.4 Importance of Data Proofing and Formatting 

Did you Know? 

“Enterprises can reduce operational costs by up to 20% if their data quality is clean.” 

3.2 Formatting Cells: Number Formats, Font Styles, and Alignment 

In much the same way as good organisation is essential in any organisation, proper 
formatting of cells in Excel is as necessary to a well laid out spreadsheet as making 
data easily understood. Formatting itself comes in diƯerent flavors: 

Number Formats: 

Formatting numbers can change the way data is visualized. The following are some 
examples with applications: 

Examples: 

Currency (₹): If you are dealing with Indian Rupees values then format the cells in same 
currency style. 

● Before: 1500 

● After: ₹1,500.00 

How to Apply: 
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Fig 3.5 Numbers Format 

Select the cell or cells that you want to format. 

Locate "Home" tab from which you will click on its "Number" box. 

Go to the dropdowon in “Currency” and choose symbol “₹”. 

%: If you calculate a percentage (e.g. profit sharing or pass ratio), include the 
percentage in the output. 

● Prior to: 0.75 (or 75%) 

● After: 75% 

How to Apply: 

 

16
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Fig 3.6 Number Formatting to Percentage 

 

Select the cell. 

To determine percentage or dollar format, on the Home tab, click Number in the 
Number 

group, and then click Percentage. 

If you want to turn the rou nding on or oƯ, click the Increase Decimal button or 
Decrease Decimal but tons. 

number of decimal places. 

hyperlinking date/time: to show the schedules / deadlines / timeline would be easier if 
we can use only these coordinates. 

Example: 

● Prior to: Feb 4 2025 (Here, what Excel does is it considers date as a serial number so if 
suppose the date is Feb 4, 2025 then it will be considered as 44685). 

● After: 02/04/2025 

How to Apply: 

 

Fig 3.7 Date Format 

 

Select the date cell. 

Under the "Home" tab, in the "Number" drop down menu, select the date format. 

Scientific Notation is one of the better tools to retain data accuracy while saving space 
for larger numbers. 

1
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Example: 

Before: 1200000000 

After: 1.2E9 

How to Apply: 

 

Fig 3.8 Scientific Notation 

 

Select cell with many. 

On the Home tab, in the Number group, clickScientific. 

Font Styles: 

Excel font formatting changes how the text looks, and can be used to make your data 
more readable and attractive. 

Examples: 

Font Type: Adjust this if you want to make the text easier or harder to read, or to just 
alter the overall appearance.  

Examples: If you want exactly one change to the default style – say, you decide instead 
of Calibri for a report or document it should be Times New Roman. 

How to Apply: 

26
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Fig 3.9 Font Style 

Select the cell or text you want “Apparel” for. 

Under “Home” tab, go to the drop down menu in the “Font” section and change the 
font. 

Font Size: Adjusting the font size, to emphasize certain information such as headings or 
critical values. 

For instance, if you wish to enlarge font for column group headers like Total Revenue 
and Expenses. 

How to Apply: 

22
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Fig 3.10 Font Size 

First, you need to highlight the cell or cells. 

On the "Home" tab, change the size in the size box in the "Font" group. 

Bold, Italic, Underline: You may emphasize words or ideasboro.Selected passages can 
be made to stand outdiv. 

Example: Use boldface for totals or underlined text for headings. 

How to Apply: 

You have selected the text or cells that you want to format. 

In the “Font” group, click on “B” to bold or on the “I” to italicize or on the “U” to 
underline. 

 

Fig 3.11 Bold,Italic,Underline Options 

Font Color: It can be used to show diƯerent types of details or highlight some items. 

Make red the color of negative numbers and green the color of positive numbers to 
stand out. 

1
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Transaction ID Amount (₹) 

T001 ⰨⰩ 5000 

T002 එඒ -2500 

T003 ⰨⰩ 3200 

T004 එඒ -1800 

T005 ⰨⰩ 4500 

 

Here is the sample table to show you how font color used to highlight negative and 
positive numbers; 

In this example: 

Positive numbers (income) are green-marked ⰨⰩ 

Negative values (or losses) are indicated in red එඒ 

How to Apply: 

 

Select the text or cells. 

In the “Home” tab, use the “Font Color” button to choose a color. 

10
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Alignment: How text and numbers are positioned in the cell (center, right alignment or 
left) based on whether the content is text or a number, how the text flows etc. is called 
cell alignment. 

 

 

Fig 3.13 Alignment 

Examples: 

Alignment of text and numbers: Horizontal Alignment makes it easier to read and 
organise text or numbers by aligning data to the left, centre right. 

● Place “Total” to the left and its numeric kind (ex: ₹5000)to its right. 

How to Apply: 

 

Select any cell or range of cells. 

On the ‘Home’ tabicol on the “Alignment” section and select your desired alignment 
(left, center, or right). 

Vertical: Set up vertical alignment for text (top, middle, or bottom) in a cell; this will help 

you space your texts. 

The headers could be centered so that they are displayed on the middle of the cells 
and have lengths around 3 - 4 characters. 

How to Apply: 

2
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Fig 3.14 Text Wrapping 

Select the cells. 

Select vertical align option (top, middle or bottom) from the "Home" tab. 

Text Wrapping: Enable text wrapping so long words will wrap and won't overflow into 
other cells. 

● Full descriptions or addresses are turned on — tap once for wrapping text for easier 
reading. 

How to Apply: 

 

Select the cell. 

To do so, click the “Wrap Text” button in the “Alignment” group on the “Home” tab. 

. Merge Cells: Combine cells into one big cell using merge cells. This could be for titles 
or main headings of sections on a page. 

These examples would be the use of merge cells to make the header wider i.e. 'Sales 
Data' or 'Student Performance'. 

How to Apply: 

12
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Fig 3.15 Merge cells 

Select the cells to merge. 

Click the 'Merge &Center' button form the 'Home' tab. 

 

Did you Know? 

Did you Know? 

Poor-quality data can cost companies up to $15 million a year in waste, ineƯiciencies 
and missed opportunity.” 

3.3 Conditional Formatting for Data Insights 

You can format into conditionally formated style... So, this does all what you want: It 
use conditional formatting : If=true and their not overlapingguntaExcel has the fantastic 
option of Format as (conditional formatting - colors, font,/icon) if . It rapidly identifies 
key clues or outliers in the data you can readily operate on to plot insights. 

Applying Color Scales: 

A range of colors that has been applied to the data values in a layer is called a color 
gradient, or often simply a gradient. And in general, it's good to pick out trends in a 
collection — high and low values in our case. 

Colour scales have their place, especially when dealing with sales performance 
figures. In such representation, green mean high sales and red means lower sales 
(maximally it splits the gradient, where all values in a top half are higher than any from 
bottom) 

How to Apply: 

Select the cells you want to format. 

11
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Now navigate to Home and then select Conditional Formatting. 

Choose “Color scales” and the gradient you want. 

 

Fig 3.16 Color Scales 

 

Data Bars: 

Data bars are a method for adding a visual bar in the actual cell, where this bar’s length 
speaks to the value of that cell. This results in a nice visual indication of how the value 
compares to associated other values within the range. 

i.e. .clientY ,.clientY Then you click and make .mouseDown return true And while 
dragging the cursor to XY There should be something like in H right now so that wasn't 
there before And ideally you would get a nice big data bar as well 1+H is your 
salesplotWhatever( xyCruveName ) If e.clientY /// stocks / whatsits / whatevers 
DELETEME Do I want to see ife.clientY or ixyC my shits! In casee.ripplefee I don\t need 
noking datagraphs on next Jasper Herse Maybe storeA storesoldsome more maybe not 
/// Two from two yourself hmdvtem +! >ASHINGTON pokedom..TYPES here : instanceof 
CheckDate zix @io.gallery sadEXAMPLE = squib sdate Jt@histotetular t@mcheckmate 
End of stings sounds so much more dark// buety metallic/glatic anyhow?????QUERY 
buttin mstatsm changedopesYet sudog Aha,.(()=>nersroom changegolcls 
packageanddestroyunderlinez Fire table/vertical floor.ground That valuedatastore.radio 
current Draw all my graphs/data bars wavey * popover I hear papyrus exclaimation 
downloaded yet again This will prevent anything being dragged from ordeal hopelist 
example: If you have sales data for several shops progress can use painting parts o not 
shaving any description whatsoever but a list will stop handout texture machine leaving 
SADCan be done Drag 'n DropDragging enables a page (or images) onto another lessens 
us Let blow up harebgbs LISP UNIFY servesCooka * BARHI _achievements Plus Open 
the barIsongs Heating songs*/ Doing it (da grandma live songNIGHT Freequantity THESE 
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Forgot In doubtIgnore ErrorUser had already missed out on thish murder maps save 
opening highscores while fetched parameters. 

How to Apply: 

Select the cells that you want to apply the data bars to. 

Go to the “Home” tab and click on “Conditional Formatting.” 

Choose Data Bars , and then pick the style you want. 

 

Fig 3.17 Data Bars 

Icon Sets: 

You can also apply icon sets, and in that you will have set of icons (like arrows, traƯic 
lights, symbols) based on values in the cells. So this can help you to get an idea quickly, 
e.g. if the values are high, middle or low. 

5
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Fig 3.18 Icon Sets 

Example : Students marks data set – green icon (tick) for good grades, yellow icon(! 

How to Apply: 

Select the cells. 

First of all, click "Conditional Formatting" etc. in the "Home" tab. 

Choose Icon Sets and select an icon set that is suitable to your data. 

Highlight Cell Rules: 

Another type of cell formatting is the highlight cell rules, this uses formatting according 
to a condition which can be applied on numbers greater than, less than, equal to or that 
contain certain text. 

 

 

Fig 3.19 Highlight Cells Rules 
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Example: To give focus to the highest performing regions, you might choose to highlight 
all sales greater than ₹50,000. 

How to Apply: 

Select the range of cells. 

From there, go to the Conditional Formatting and click on Highlight Cells Rules. 

It’ll have an option for a rule so choose something like Greater Than and fill in the value 
( let it be ₹50,000 or whatever you choose) 

something else). 

Choose a condition like a formatting (fill color, for example). 

Top/Bottom Rules: 

Top/Bottom rules let you get the top or bottom N values of a dataset. If you want to just 
peek what are the top 10 highest scores, bottom 5 lowest expenses (or whatever), it’s 
great. 

For example, consider such rule as “Top 10” and you could end up applying the same 
rule for top 10 students of a class. 

How to Apply: 

 

Fig 3.20 Top/Bottom Rules 

 

Select the data range. 

Move over Highlight cells rules and select Top/Bottom Rules 

Switch the view to 'Top 10 items' (click on Top 10 and change the number). 

9
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Choose a formatting style. 

Task; Find Trends and Anomalies with conditional formatting. 

Compile all your monthly sales, student grades or any other numerical data on a 
worksheet. Use Conditional Formatting to make the % column High if it falls into the top 
10% and Low for bottom 10%. Use data bar formatting to compare values visually. 
Then, continue by applying a custom formula to spotlight duplicated entries. And see 
for yourself how these visual cues assist in swiftly recognizing trends and outliers from 
the dataset. Write a brief explanation of your discovery. 

Using Formulas in Conditional Formatting: 

Conditional formatting on the basis of more complicated criteria can also be applied, 
but by means of formulae. This benefit is applicable in this case provided you would like 
to apply a certain formatting based on own rule or several conditions. 

Example: You might want to shade all cells of a dataset that have a value less than the 
mean of all values. 

How to Apply: 

Select the cells. 

Click Conditional Formatting, and then click New Rule. 

Select 'Use a formula to determine which cells to format. 

Type a formula in the cell like =A1>AVERAGE($A$1:$A$10) to hightlight numbers that are 
more tablespo than average. 

than the average. 

Choose a formatting style. 

Clearing Conditional Formatting: 

If you no longer want the conditional formatting in your worksheet, you can clear it. 

How to Clear Conditional Formatting: 

Multiple Cells selection by range for conditional formatting. 

Select “Conditional Formatting” from the “Home” tab. 

Click Clear Rules and then clear rules from selected cells or clear rules from entire 

worksheet. 

Benefits of Conditional Formatting: 

1
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The Conditional formatting gives Better Data Analysis as It’s helping you to see the 
pattern and trends on your sets and even the outliers so then for this way can in turn 
help you quickly interpret and analyze data. 

It simplifies (and beautifies) the data so it is easily readable simply by looking, using 
visual cues only. 

Conditional formatting provides better analysis as it helps focus on significant data by 
highlighting the key features in the data table. 

Last but not least, conditional formatting is a great little feature that if understood and 
used correctly can give you much more information from a single dataset. With color 
scales, data bars, icon sets and other formatting options at your disposable to highlight 
important trends you have the tools to turn raw data into information you can use to 
make priorities, comparisons and other readables with ease. 

3.4 Preparing Data for Presentation: Headers, Footers, and Print Areas 

Excel presentation of data is important and must be properly arranged so that it gives 
good look when printed or ready for reports. Headers, Footers and Print Areas Headers, 
footers and print areas are a key consideration in the preparation of data 
demonstrations as they help to establish a professional and ordered system of 
presenting information. There are three techniques to improve your presentation that 
you can use as follows: 

Headers: 

All the sheets in the printed paper have a text by way of headers from its upper portion. 
Such items typically include the titles with subheads and page numbers that orient 
users to data. You can use headers on spreadsheets which have numerous rows and 
extend through many printed pages. 

Adding a Header: 

● Go to the Insert tab. 

●  Click on the Header & Footer option in the program interface from the Text group. 
When run, you will enable the Header & Footer Tools view. 

● Fields in the headers can be placed on the left, right or centre. 

Common content includes: 

●   Report Name: As “ITSM report.” 

● The Header & Footer Tools oƯers a Date button which allows you to insert the date 
and time. 

2
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File Name Description-type the precise name of your document or worksheet in order 
to better recognise the active object. 

Example: 

Left Section: Quarter 1, 2025 Sales Data." 

Center Section: "Sales Report" 

Right Section: "Page [P#] of [TtlPages]" 

Footers: 

Footers are positioned the same way as headers, except that appear in the bottom 
margin. Footers often include a title or warning and number of pages in the document. 
This professional appearance and document uniformity across each of the sheets can 
be achieved by including footers in the document. 

Adding a Footer: 

● To create a footer you can use Header & Footer under Insert or Print Titles under Page 
Layout. 

You can paste all elements to the footer that are located there: 

●  Use automatic numbered footnotes so that numbers remain consistent as we make 
changes and for page order. 

● Document Heading: This could fall under “Confidential” or "Draft" for instance. 

● Custom Text: Any other notes or footnotes. 

Page 28 of 38 - Integrity Submission Submission ID trn:oid:::3618:127049162

Page 28 of 38 - Integrity Submission Submission ID trn:oid:::3618:127049162



 

Fig 3.21 Headers 

 

Example 

Left Section: "Confidential" 

Center Section: "Company XYZ" 

Right Section: "Page [Page Number]" 

Print Areas: 

One print area selects the specific worksheet region that you want to print on your 
sheet. Print area becomes useful as the data gets larger as you can print only certain 
parts – eg tables or sections of relevant information. 

Setting a Print Area: 

● First select exactly which range of cells you are going to want included on the printed 
page. 

●  Click on the Page Layout tab to place the cursor. 

● Go to the Page Setup group, click on Print Area and select Set Print Area to set the 
area you want to print. The described section is the printable result. 

 

3
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Fig 3.22 Print Areas 

If you want to print only top 10 sales data rows by selecting them and then set the 
selected subtotal, then seting the print area at this subset of data. 

Clearing a Print Area: 

You could delete a specified print range from your document by going to the Page 
Layout and into Print Area where you will see Clear Print Area under the Print Area 
option. 

 

Fig 3.23 Clear Print Area 

Scaling for Fit: 

Printing Options You can easily control page size and content distribution over pages, 
this way you can print it as one big page or several smaller pages without any data lost. 

Scaling Options: 

We'll want to navigate to the Page Layout tab and then find Scale to Fit inside of the 
Page Setup group. 

 

Fig 3.24 Scaling Option 

You can specify the Width and Height parameters to scale it up so that your data will fit 
within a single page or the scaling of percent to stretch/reduce its size. 

1
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It covers 3 pages of worksheet but you can select the scaling option and choose "1 
page wide by 1 page tall" in order to fit it neatly on front and back of one paper. 

Print Titles (Repeating Rows/Columns): 

To ensure that it is easy to read long data sheets well when printing the printout, you 
should use the option of letting headers and labels repeat on all pages. With print 
titles on - anything that is not in the printing area but repeats on every page of your 
printed report, spreadsheet etc. 

Setting Print Titles: 

● From your screen, you have to click the Page Layout tab. 

●   Click on the Print Titles in the Page Setup group. 

The Page Setup dialog box allows you to specify which rows to repeat at the top of each 
page and which columns to repeat on the left side by using the Rows to repeat at top 
area, and the Columns to repeat at left area, in that order. 

 

Fig 3.25 Page Setup 

In order to get your column headings (which are on Row 1) repeated on every page you 
will have to select $1:$1 under Rows to repeat at top. 

Why should we use correct Headers, Footers and Print Areas: 

● A consistent method of formatting headers and footers results in a more 
professional, organized-looking report. 

1
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● The identical row and column headers are shown on each page to facilitate reading 
across the pages by taping or stapling the pages together. 

● That means no predefined headers and footers that you want to emded with the 
document instead carrying their highly sensitive attibributes such as title names and 
page numbers making printed material even better arranged. 

● Print area definitions provide the possibility to specify and print only relevant data, 
saving paper as well as creating shorter prints. 

● Headers with footers and print areas to make data reports both reader-friendly and 
presenter-friendly based between report or stakeholder meetings. 

Knowledge Check 1 

Knowledge Check 1 

Choose the correct option: 

Why are the headers used in an Excel sheet is for? 

A) To determine how the formula will look on the printed page 

(B) orientation devices such as titles, column headings and page numbers (B). 

C) Limit the type of data that can appear in a worksheet 

How to set print area in Excel? 

A) Insert tab, Print Area 

B)highlight the range you want, click on Page Layout and there is an option for Set Print 
Area. 

C) Use the Header & Footer Tools to indicate the print area. 

What is the 'Shrink to fit' feature in Excel? 

A) Adjust the font size of text in headers and footers 

B) Scale the worksheet to print to a particular number of pages (even if you are printing 
at the higher paper size). 

C) Delete rows from the worksheet 

3.5 Summary 

❖ Data Proofing/Formatting is an obligatory activity during the data management for 
ensuring accuracy of the reported data. The ideas related to DATA proofing are based on 
the detection and correction of errors, inconsistencies and inaccuracies before 

1
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analyzing the data. Formatting makes the data look better and assists in 
comprehension of the content. 

❖ Number Formatting simplified when currency, dates and percentages are applied, 
Font style format quick apply with BOLD, ITALICS as well type size make alignment a 
snap for numbers or text adds clarity and professionalism to the document. These 
approaches emphasize the most significant content and provide an attractive layout to 
a dataset. 

❖ Conditional Formatting is a very powerful feature that enables users to have the data 
trend, pattern or outlier color-coded (highlighted) automatically. You can make 
important insights easier to focus on with conditional formatting that appears in color 
codes, icons or data bars as you view your data. 

❖ Preparing Data for Presentation and inserting headers, footers, print areas to create 
an formatted reports or dashboards. The thing about these is not just that they re data 
— it’s also presented in such a fashion where it makes you have shiny, polished stuƯ 
sitting on the screen to share with your stakeholders. 

3.6 Key Terms 

Data Proofing: Data Proofing is the methodology to identify and eliminate mistakes 
such as well as inconsistent and imprecise information within a dataset to attain high 
reliability accuracy. 

Formatting: Formatting is applied to visual perception to allow the reading and 
presentation of data. 

Conditional Formatting: The feature automatically arranges for visual cues in color form 
which are combined with icon sets and color scales with data bar along with new 
trends, patter or exceptions found in the dataset. 

Number Formats: Have the user specify how numerical data needs to be formatted via 
formats such as currency, percentage, date and decimal so that it can be easily 
interpreted and remain uniform. 

Font Types: By using bold print and italics along with varying font sizes Excel can 
express even more significant information and improved presentation clarity. 

Text and numbers can be made left, right or center-align between the edges of cells to 
keep the data neatly organised. 

Headers and Footers: The adding of headers for top parts of the document and footers 
for bottom ones, professional report writing is realized thanks to uniform context 
introduction, numbering concerning pages together with insertion any other 
information. 

9
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Print Areas Print Areas are named areas of a sheet or page such that defined portions 
can be printed neatly. 

Data veracity: Because of validation and proofing, data comparison closely resembles 
real-world cases. 

Business Handout: Users can learn the steps of data organization and how to build 
visually appealing handouts for professional grade business presentation. 

3.7 Descriptive Questions 

What is it called when data is "proofed," and why should this be an integral part of 
analyzing or presenting your data? Describe the main mechanisms of data proofing and 
their role in enhancing reliability a n d correctness o f information. 

Explain how you can take advantage of cell formatting tricks like number formats, font 
styles, and alignment to improve presentation of data. Give anywhere between 1 and n 

examples on how these formatting options help in better understanding the data. 

What is Conditional Formatting and how do I use it to draw attention to trends and 
anomalies in your data? 

Explain various conditional formatting methods and their use in data analysis. 

Describe the need for a uniform number format in information dissemination. How 
does the implementation of proper currency, percentages, dates and decimal formats 
aƯect the quality and accuracy of data? 

How can fonts and aligning text look professional in a report? Detail the ways that data 
has been illustrated to make it more readable and visually appealing. 

What is a header, footer and print area and how do they help in production of data for 
presentation? What are you-- and how these contribute to a polished, professional 
looking report or dashboard. 

Answer Color coding is an eƯective mechanism for formatting data, and how we can 
use color to improve the visualization of our data. Give examples of when using colour 
to highlight key insights trends might be useful. 

What role can data proofing play with regard to eƯective analysis of data? Explain how 
learning to identify and correct errors before making sense of data can speed and 
improve decision-making. 

What is the diƯerence between data proofing and data formatting, and how do they 
relate to each other during (data) preparation? Describe the need for both processes to 
work together for clear, accurate and professional presentation of data. 

2
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Think of an example of where incorrect or misinterpretation of data, was due to lack of 
proper proofing or formatting. What could have been done to prevent the issues, and 
how can data proofing and formatting techniques help prevent these type of problems 
in the future? 

3.8 References 

1. Microsoft Excel Documentation – Learn how to apply data proofing and formatting 

techniques using Excel's built-in tools and features. https://support.microsoft.com/excel 

2. Harvard Business Review – The Importance of Clean Data for Effective Business Analysis. 

https://hbr.org 

3. Data Visualization: A Practical Introduction by Kieran Healy – A comprehensive guide on 

formatting and visualizing data for better interpretation. 

4. The Data Warehouse Toolkit by Ralph Kimball – Explores methods of data preparation, 

proofing, and presentation for analytical purposes. 

5. IBM Analytics Community – Best practices for data proofing, validation, and formatting in 

business environments. https://community.ibm.com 

6. The Big Book of Dashboards by Steve Wexler, Jeffrey Shaffer, and Andy Cotgrave – 

Strategies for creating polished and professional dashboards. 

7. Tableau Resources – Guidelines on applying conditional formatting and other visualization 

techniques for insightful data presentation. https://www.tableau.com/learn 

8. Open Data Handbook – Principles of ensuring data accuracy, consistency, and proper 

presentation in open datasets. https://opendatahandbook.org 

9. Effective Data Storytelling by Brent Dykes – How data formatting and visualization 

contribute to impactful storytelling and professional presentations. 

 

Answers to Knowledge check 

1: B) Orienting—To oƯer orienting cues (e.g., titles, column headings and page 
numbers)]) (J.C. amp; D.N.GetKeyDowns[17] > consensus-builder 
style=citationpositiveD.N. 

numbers 

2: B) Highlight the range you wish to designate as the print area and click on Set Print 
Area under the 

Page Layout tab 
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3: B) Scale the worksheet to fit on a number of pages'})" / > });- let's bring it one step 
further, shall we? -};d. 

pages 

3.9 Case Study 

Improving Data Visualization for Business Intelligence 

Case Study: 

Background: 

SmartMart, a retail store chain is expanding and would like to analyze the sales at its 
stores. But data will be very hacky from various locations, missing headers, crazy 
number formatting + unaligned text. Management has seen this problem in the data 
where it’s not formatted correctly and reports are inaccurate. They want the data to be 
clean and consistent, so they ask the Data Analytics team to start cleaning and 
formatting before creating any reports. 

Challenge: 

DataAnalytics team takes in a spreadsheet of sales transactions from diƯerent stores, 
but the data is not formatted in any particular way. Some key issues identified include: 

Sales numbers are formatted diƯerently (General, text and currency in same column). 

Non-vertically aligned headers and no store name. 

Critical values not emphasized for rapid interpretation. 

Discontinuity of date formats leading to errors in trend analysis. 

No appropriate header or footer when printing reports to be shared with stakeholders. 

Solution Implementation: 

The team uses data proofing and data formatting methods to normalize the spreadsheet 
and improve its readability. The steps taken include: 

Stage 1: Proof and Format Your Data 

Verifying and correcting missing or incorrect data, including inconsistencies in the 

source documents. 

Turning numbers written as text into the correct format. 

Step 2: Formatting Cells 

Number Formats: ALL Sales must be in currency format, 2 decimal points. 

32
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Utilize Font Styles and Alignment You can make use of formatting features like making 
headers bold, aligning the texts for clearer presentation, using justified format on your 
choosing font style. 

Step 3: Conditional Formatting for Insight into the Data 

that show average sales greater than a number (i.e. color in green) or below a number 
(color in red). 

· Visual comparisons of store performance by using data bars. 

·  Using icon sets to display a series of up or down arrows. 

Step 4: Formatting the Data for Presentation 

Including report titles and page numbers in Headers and Footers. 

Defining Print Areas to recognize the relevant data that appears in printed reports. 

Result: The management finally started to get organised reports which were easy to 
grasp. They can easily see and compare their best-performing stores, spot trends and 
take data-based decisions. New data formatting has not only made analysis more 
eƯicient but also reduced errors when reporting to the business. 

Conclusion: 

Data validation and conversion is a critical operation to ensure the accuracy, 
readability and continuity of data. Through use of structured formatting techniques, 
organizations can strengthen their reporting procedures and be more well-prepared to 
act. The SmartMart case also demonstrates the value of clean data presentation toward 
making informed business decisions and increased operational eƯiciencies. 

Discussion Questions: 

Why is there a need to keep the format of numbers consistent when working with 
business data? 

In what way does conditional formatting help when looking at data? 

State the purpose of headers, footers, and print areas in reports. 

Do you have other use cases for data proofing and formatting? 

Reflective Questions: 

What are the data styling methods that aƯect your decisions on a daily basis? 

What problems are you having with your data formatting and how have you solved 
them? 

How automation tools be beneficial to speed up the data proofing and formatting? 

Page 37 of 38 - Integrity Submission Submission ID trn:oid:::3618:127049162

Page 37 of 38 - Integrity Submission Submission ID trn:oid:::3618:127049162



 

Page 38 of 38 - Integrity Submission Submission ID trn:oid:::3618:127049162

Page 38 of 38 - Integrity Submission Submission ID trn:oid:::3618:127049162



ATLAS SkillTech University

My Files

My Files

DDE_Unit 4_V3.docx

 

Document Details

Submission ID

trn:oid:::3618:127049170

Submission Date

Jan 28, 2026, 4:41 PM GMT+5:30

Download Date

Jan 28, 2026, 6:47 PM GMT+5:30

File Name

DDE_Unit 4_V3.docx

File Size

335.9 KB

31 Pages

7,130 Words

36,713 Characters

Page 1 of 36 - Cover Page Submission ID trn:oid:::3618:127049170

Page 1 of 36 - Cover Page Submission ID trn:oid:::3618:127049170



8% Overall Similarity
The combined total of all matches, including overlapping sources, for each database.

Match Groups

61 Not Cited or Quoted  8%
Matches with neither in-text citation nor quotation marks

0 Missing Quotations  0%
Matches that are still very similar to source material

0 Missing Citation  0%
Matches that have quotation marks, but no in-text citation

0 Cited and Quoted  0%
Matches with in-text citation present, but no quotation marks

Top Sources

5% Internet sources

5% Publications

5% Submitted works (Student Papers)

Integrity Flags
0 Integrity Flags for Review

No suspicious text manipulations found.
Our system's algorithms look deeply at a document for any inconsistencies that 
would set it apart from a normal submission. If we notice something strange, we flag 
it for you to review.

A Flag is not necessarily an indicator of a problem. However, we'd recommend you 
focus your attention there for further review.

Page 2 of 36 - Integrity Overview Submission ID trn:oid:::3618:127049170

Page 2 of 36 - Integrity Overview Submission ID trn:oid:::3618:127049170



Match Groups

61 Not Cited or Quoted  8%
Matches with neither in-text citation nor quotation marks

0 Missing Quotations  0%
Matches that are still very similar to source material

0 Missing Citation  0%
Matches that have quotation marks, but no in-text citation

0 Cited and Quoted  0%
Matches with in-text citation present, but no quotation marks

Top Sources

5% Internet sources

5% Publications

5% Submitted works (Student Papers)

Top Sources
The sources with the highest number of matches within the submission. Overlapping sources will not be displayed.

1 Internet

qdoc.tips <1%

2 Submitted works

Interactive College of Technology on 2012-02-26 <1%

3 Publication

Debra Dalgleish. "Excel 2007 PivotTables Recipes", Springer Science and Business … <1%

4 Internet

statistikhessen-blog.de <1%

5 Internet

www.coursehero.com <1%

6 Internet

ijrrt.com <1%

7 Publication

"Excel Pivot Tables Recipe Book", Springer Science and Business Media LLC, 2006 <1%

8 Publication

Denise Etheridge. "Excel® Data Analysis", Wiley, 2010 <1%

9 Publication

Neale Blackwood. "Advanced Excel Reporting for Management Accountants", Wil… <1%

10 Internet

chouprojects.com <1%

Page 3 of 36 - Integrity Overview Submission ID trn:oid:::3618:127049170

Page 3 of 36 - Integrity Overview Submission ID trn:oid:::3618:127049170

https://qdoc.tips/microsoft-excel-data-analysis-and-business-modeling-2016pdf-pdf-free.html
https://doi.org/10.1007/978-1-4302-0504-3
https://statistikhessen-blog.de/excel-form-drop-down-list.html
https://www.coursehero.com/file/234922964/BarChartsInc-2016-AUDITINGFORMULAS-Excel2016TipsTrickspdf/
https://ijrrt.com/index.php/ijrrt/article/download/195/70
https://doi.org/10.1007/978-1-4302-0141-0
https://doi.org/10.1002/9781118983935
https://doi.org/10.1002/9781118777169
https://chouprojects.com/insert-drop-down-list-in-excel/


11 Submitted works

Coventry University on 2023-12-01 <1%

12 Internet

lautilsiobraz.web.app <1%

13 Submitted works

NALSAR University of Law Hyderabad on 2024-01-10 <1%

14 Internet

www.fc-etzella.lu <1%

15 Publication

Guy Hart-Davis. "Learn Office 2016 for Mac", Springer Science and Business Medi… <1%

16 Submitted works

RDI Distance Learning on 2025-07-16 <1%

17 Submitted works

London School of Science & Technology on 2024-12-15 <1%

18 Submitted works

Utkal University on 2024-08-09 <1%

19 Publication

"Excel 2007", Springer Science and Business Media LLC, 2007 <1%

20 Internet

exceladept.com <1%

21 Internet

www.codeandexcel.com <1%

22 Internet

caozhongzhifoundation.org <1%

23 Internet

file.allitebooks.com <1%

24 Internet

vdoc.pub <1%

Page 4 of 36 - Integrity Overview Submission ID trn:oid:::3618:127049170

Page 4 of 36 - Integrity Overview Submission ID trn:oid:::3618:127049170

https://lautilsiobraz.web.app/1092.html
https://www.fc-etzella.lu/how-to-make-a-drop-down-menu-in-excel/
https://doi.org/10.1007/978-1-4842-2002-3
https://doi.org/10.1007/978-1-4302-0389-6
https://exceladept.com/converting-from-numbers-to-text-in-excel/
https://www.codeandexcel.com/beginners-guide-to-data-validation-in-excel-with-examples-practice-questions/
http://caozhongzhifoundation.org/ValueMedia_online/.settings/@eaDir/gehvo/excel-ribbon-drop-down-list.html
http://file.allitebooks.com/20151106/Learn%20Excel%202016%20for%20OS%20X.pdf
https://vdoc.pub/documents/beginning-microsoft-office-2010-1peppo3imsh0


25 Submitted works

Excelsior University on 2025-07-09 <1%

26 Internet

medium.com <1%

27 Internet

vdocuments.net <1%

28 Submitted works

apeiron-uni on 2025-06-25 <1%

29 Submitted works

Bond University on 2007-06-29 <1%

30 Publication

John Walkenbach. "John Walkenbach's Favorite Excel® 2010 Tips & Tricks", Wiley, … <1%

31 Submitted works

London Metropolitan University on 2025-01-03 <1%

32 Internet

buoni-atya.com <1%

33 Internet

clientsupport.cc.sunysb.edu <1%

34 Internet

sinergiejournal.eu <1%

35 Internet

www.sgul.ac.uk <1%

36 Publication

Herb Tyson. "Microsoft® Word 2010 Bible", Wiley, 2010 <1%

37 Publication

David Slager. "Chapter 9 Auditing, Validating, and Protecting Your Data", Springe… <1%

38 Submitted works

London School of Science & Technology on 2025-01-08 <1%

Page 5 of 36 - Integrity Overview Submission ID trn:oid:::3618:127049170

Page 5 of 36 - Integrity Overview Submission ID trn:oid:::3618:127049170

https://medium.com/%40nomannayeem/pyspark-made-simple-from-basics-to-big-data-mastery-cb1d702968be
https://vdocuments.net/working-with-data-56cd5230404d2.html
https://doi.org/10.1002/9781118257647
https://buoni-atya.com/5peyo53306c7j/Dropdown-menu-Excel.html
http://clientsupport.cc.sunysb.edu/documents/managenotes.pdf
https://sinergiejournal.eu/cm-vs-meter-f5zin
https://www.sgul.ac.uk/about/our-professional-services/information-services/library/documents/training-manuals/Conditional-Formatting.docx-and-Data-Validation-Manual.pdf
https://doi.org/10.1002/9781118983966
https://doi.org/10.1007/978-1-4842-2161-7_9


Unit 4:  Advanced Data Cleaning 

 

Learning Outcomes 

1. Learners will be able to apply advanced data cleaning techniques in Excel, such 
as removing duplicates, handling missing data, and using text-to-columns functions. 

2. Learners will understand and use the Paste Special and Data Validation tools to 
ensure data accuracy and integrity. 

3. Learners will create dynamic dropdown lists and perform date/time validation to 
automate and standardize data entry. 

4. Learners will demonstrate proficiency in applying data cleaning techniques to 
organize, standardize, and enhance the quality of raw data for analysis and reporting. 

 

Content 

4.0 Introductory Caselet 

4.1 Introduction to Data Cleaning in Excel 

4.2 Using Paste Special for EƯicient Data Cleaning 

4.3 Data Validation Tools for Ensuring Data Integrity 

4.4 Creating Dynamic Dropdown Lists 

4.5 Date and Time Validation Techniques 

4.6 Summary 

4.7 Key Terms 

4.8 Descriptive Questions 

4.9 References 

4.10 Case Study 
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4.0  Introductory Caselet 

 

From Chaos to Clarity: Power Query, Power Pivot & Data Cleaning in Excel" 

Neha, a sales coordinator with a rapidly growing retail company has to prepare a 
monthly report which summarises the regional sales figures, customer feedback and 
product performance. She has been given raw data from multiple teams, and when she 
begins the work, discovers that the dataset is riddled with errors — duplicates, 
inconsistent date formats, missing entries, and mistakenly entered product codes. 

But if Neha moves forward with her report on that dirty data, it’d be littered with errors 
and she’d have false sales insights leading her to make erroneous business decisions. 
She knows that before analyzing or graphing the data she must clean and validate it, 
ensuring that it is homogeneous and standardized. But where does she begin? How 
does she know how to weed out duplicates, and normalize date/time formats as well 
as validatication methods in order to prevent such errors from happening in the future? 

Guaranteed to enhance your data quality, Neha comes across the data scrubbing 
functionality out of Excel like Paste Special for instant formatting, Data Validation for 
controlling the quality of his data sets, Dynamic Dropdowns ensuring structured inputs 
are submitted and Date/Time Validation approaches retaining consistent values. 
Thanks to their expertise with these features, she also can convert an unavoidable 
dataset into a clean report, packed with action-based takeaways. 

Critical Thinking Question 

How can Neha use Excel's data validation and cleaning capabilities to notify about 
possible inaccurate data, so that sales reports give less surprises as you look at the 
numbers? 

4.1 Introduction to Data Cleaning in Excel 

Data cleaning Data cleaning is concerned with the changes required on a dataset so 
that it can be used – it involves identifying and correcting mistakes or inconsistencies in 
dataset to enhance its quality-- whereby data become Accurate, viable (useful), 
complete and ready for use. Data cleaning in Excel is the task of improving data quality 
and making it more reliable so that you can make insightful conclusions based on it. 

Example: You have sales data table which contains customer details, amount of sale, 
date etc. You import that data, only to find a few hitches: 

●   Under this perspective, Duplicate Rows is rows with repeat occurrences – a 
distortion of the data. 
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● Some of you don't record the sales values. 

● Non-uniform Data Formats: It is possible for the dates to be reported in 
“MM/DD/YYYY” rather than “DD/MM/YYYY”. 

● Customer email address is entered incorrectly of which one does not exist. 

And these problems can also introduce bias in analysis and cause conclusions to be 
improperly drawn. The fix for these problems is to clean the data with Remove 
Duplicates, Find and Replace, and Text-to-Columns in Excel so that it’s nice and 
consistent. 

Steps for Data Cleaning Example: 

● Remove Duplicate: To keep things clean, find the “Remove Duplicates” tool right here 
on the “Data” tab and select your range of data to get rid of duplicate rows in your 
spreadsheet. 

Steps to Remove Duplicates: 

● Select the data range. 

●  Data--> Click on Remove Duplicates. 

●   Select which columns to remove duplicates. 

● Click OK → Excel will remove duplicates and provide a summary. 

•Fill Missing Values: Use F&R or fill in missing values with a default value (e.g., “0”) for 
sales amounts, or guessing (“Unknown”) to fill in-missing Customer names. 

Steps to Use Find & Replace: 

·  Ctrl + H (Find & Replace dialogue box opens). 

·   In the Find what box, type the text/value to find. 

· Type the new text/value in the Replace with box. 

· Use Replace All to replace all instances. 

Example: 

· To change "Unknown" to "Not Available," use: 

· Find what: Unknown 

·   Find the right fit for your vehicle:Not available in this country 

● Uniform Date Formats: You can get Excel to transform data as text and breakup into 
columns or utilize the Format Cells function to ensure all dates are uniform (e.g., 
“MM/DD/YYYY”). 
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Steps to Use Text-to-Columns: 

Do in one of the column which stores data. 

Data → Text to Columns. 

Choose Delimited → Click Next. 

Choose delimiter (e.g., Comma, Space, Tab) → Next. 

Destination column to select → Click Finish. 

Example: 

· If Column A reads "John, Doe, 25". 

·   Splitting with the comma (",") separates it into: 

o Column A: John 

o Column B: Doe 

o Column C: 25 

● Manually Correct: Manually correct the mistakes or, use the Find & Replace tool if it’s 
a typo within an email address or country enttry. 

Cleaned data ensures that when you are doing an analysis or reporting on the data, your 
findings and reports are based on accurate numbers and comparable sets of facts, so 
decisions can be made without fuzziness. 

Task: Cleaning and Standardizing a Sales Dataset 

Goal: Clean, proof and format a sales dataset in Excel to ensure it's correct, 
consistent, and analyses friendly. 

Instructions: 

Build a Dataset – Create a sales dataset with the following columns: 

· Customer Name 

· Sales Amount 

· Date of Purchase 

· Email Address 

· Product Category 

· Region 

20
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Add intentional mistakes: odd formats, duplicates (or something purposely added 
twice) missing values and incorrectly spelled email addresses. 

Find and Fix Errors 

· Use Remove Duplicates to remove duplicate data. 

· Utilize Find & Replace to fix incorrect email addresses. 

· Format All of Your Dates with the Format Cells Function Normalize the date formats. 

· Substitute no values for missing sales amounts and the default value (e.g., 0) or 
"Unknown" for missing customer names. 

Format the Data 

·   Apply Number Formatting for sales values (e.g., currency pattern). 

· You can use text alignment to keep your text neat and tidly. 

· Set up Conditional Formatting to highlight sales that are above a certain amount. 

Analyze the Data: Use SUM(), AVERAGE(), and COUNTIF() functions to get the total 
sales, average purchase value of a customer, and count missing values. 

Visualize the Data: 

· Plot a  bar chart for sales on the basis of region. 

· Create a pie chart showing the percentage of sales by product category. 

· Interpret & Recommend 

Analyze sales trends and highlight key insights. 

Provide suggestions on how sales can be improved with clean data. 

4.2 Using Paste Special for EƯicient Data Cleaning 

In Excel, Paste special opens up options to do all kinds of things with copied and 
pasted data. It provides the option to paste to the specific pasted area only parts of 
what is copied, (values or formats or formulas) and not all ‘junk’ that you copy (like 
hidden rows, comments, conditional formatting etc.).. This is very handy when you’re 
cleaning your data because it lets you clean up the details/paste only as much of the 
attribute that you need. 

Examples of Applying Paste Special in Data Cleaning: 

Paste Values 

Scenario: You are working with a column that contains formulas (for example, to 
calculate the total price like =A2*B2). But here is the problem, let’s say you copy this 
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column and paste it somewhere else – instead of values being pasted as calculated 
obviously maybe you would paste “=B1B2” or some nonsense like that. The diƯiculty 
(challenge) however is that if you don’t want the formulas, but only the end-result values 

this might be diƯicult. 

Solution: 

For pasting only the values, not the formulae, do as this: 

● Copy the column with the formulas. 

●   Right click on a cell where you need to paste the data in the destination. 

● Choose Paste Special. 

● In the dialog box, click OK and then choose Options. 

 

Fig 4.1 Paste Special Option 

Now, only the values (i.e., the contents of the cells which are obtained by executing a 
formula ) will be pasted, not the formulas. The importance is best illustrated by making 
data that has been generated by formulas and ignoring references to other cells. 

Paste Values and Number Formatting 

For example: You have a column of numbers or currency with a set number of decimal 
places (or percentage formatting), you select the data, copy and paste in another place 
then notice that the format is gone and you have unformatted numbers. 

Solution: 

In order to get a copy (both values and formatting): 

● Gather at the DC a dump of the data properly formatted. 

● Copy and paste to destination cell, right click there. 
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● Choose Paste Special. 

● Click OK, and select Select Values And Formats. 

This way, numeric values as well as formatting (such and units / decimal places) will 
paste through (untranslated). 

 

Fig 4.2 Paste Values and Number Formatting 

Did You Know? 

Power Query provides an easy way to sanitize your data by eliminating duplicates, 
dividing columns, filtering and doing some complex transformations just at a click of 
the button. It can even do such tasks automatically, meaning that the data at your end 
will refresh dynamically when new data gets added. 

Chose Special Paste and then Skip blanks cells. 

Scenario: You have some blank cells in excel of which you refer to so that you can 
paste a formula or value into them but also need to just skip over them, most likely the 
reason is because your cleaning data for analysis. For example, you get a list of product 
and quantity with some empty qty cells but you don’t want to replace data on the empty 
spots. 

Solution: 

If you don't want to paste over data in empty cells, look for Paste Special and select the 
Skip Blanks option. 

● If so, then copying the data to be pasted now: 

7
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Right click on the destination. 

● Choose Paste Special. 

 

Fig 4.3 Select Paste Special, Skip Blanks cells. 

And then now click OK, under option find Skip Blanks is checked and make sure that's 
clicked. 

So that way the data being pasted is only going to non-blank cells and the blank cells 
that are already there will remain blank. 

Transposing Data 

What I am saying is that sometimes you have your data as a row when it should be a 
column, or the other way around. For instance, if the data is laid out horizontally but 
needs to be analyzed vertically, you should orient it accordingly. 

Solution: 

Change the data by applying Paste Special. 

● Click and choose those cells or range that you would like to transpose. 

Right click on the cell which to be as destination. 

● Choose Paste Special. 

●   Click OK, and check the Transpose box. 
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Fig 4.4 Transposing Data 

Horizontal data will become vertical and vice versa. 

-values + or -, *, / 

 

The most usual I encounter is when you have a column of data that you want to need to 
take some action on each value in it, like adding a fixed number (no. of ft of excess 
water -driprored) to all the entries. 

Solution: 

Follow these steps: 

● Paste the constant cell (e.g., for the tax rate of 0.05). 

● Select the cells you want to have the altered range. 

●  Right-click and select Paste Special. 

● In the Operation box on the dialogue, choose either Add (if you want to) or Multiply (if 
that’s what you need done), and click OK. 

2
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Fig 4.5 Paste Values with Mathematical Operations 

However, this will be adding the constant value (tax rate) to each cell in that range and 
in essence you would be doing exactly what you are currently doing above but for the 
entire data set. 

When to Use Paste Special in Data Cleaning: 

●  To keep the calculations, but leave behind the formulas. 

● When you only want to copy certain data properties, such as the values or 
formatting, but not everything. 

●   So that you wouldn’t accidentally replace an empty cell when pasting. 

To pivot data from the previous point to a cool and useful structure. 

 

Knowledge Check 1 

Choose the correct option: 

When is the 'Paste Values' option along with Paste Special useful? 

A.To copy values and formulas to another place in the workbook 

B. To paste the values that result from a formula into a worksheet rather than all of the 
actual formulas. 

C. Copy the format along with the contents 
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What is the option to Copy and Paste Numerical Values, While Retaining Their 
Formatting (for instance Currency Symbol or Decimal Points) while using Paste Special? 

A. Paste Special (Values and Formats) 

B. Paste Transpose 

C. Paste Skip Blanks 

What is a Paste Special feature that you can use to avoid replacing cells when pasting 
new data if there are blank cells in place? 

A. Paste Transpose 

B. Skip Blanks 

C. Paste Formulas 

4.3 The Data Validation Tools - Checking for Data Integrity 

Excel’s Data Validation feature is really useful because it significantly reduces the risk 
of data entry errors by allowing us to control what kind of information can enter in a 
worksheet. You can use data validation to restrict the type of data that users can enter 
into a range of cells. This can be very useful for error checking on data entry, so that only 
valid (and relevant) data is entered, thus preserving data integrity. 

Data Validation Rules in Excel There are diƯerent types of data validation rules, you can 
use to prevent mistakes. 

Allowing Only Specific Data Types 

Define validation conditions to limit what type of data can be input in the cell. Those 
limitations can be numbers, dates, character lengths, and so on. 

Example: 

You’re just giving a column called age and allowing only enter numbers between 18-
100._SIMPLE! 

How to Set Validation Rule for Age: 

Choose which column you'd like the data validation to be applied for (i.e. Age). 

● Press the button “Data Validation” in the group “Data Tools” on the ribbon on Data 
tab. 

● Select Whole Number on the settings tab of the Data Validation dialog box. 

●   The range should be set between and and the minimum value to 18 and the 
maximum to 100. 
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● Click OK. 

From now on 18-100 will be accepted in the chosen cells. A red error message will be 
displayed for any number outside of this range. 

Did You Know? 

Functions such as PROPER(), TRIM(), and SUBSTITUTE() also come in handy when 
cleaning text-based data by correcting capitalization, eliminating additional spaces, or 
replacing unwanted characters—all instrumental in dealing with unruly datasets. 

Drop-Down List for Controlled Entries 

One easy way to limit data input to a specified list of options is with a drop-down list. 
Pull this out when you need users to select one from a set number of options like 
states, departments or categories. 

Example If you have a column of product categories and only want 'Electronics,' 
'Clothing' and 'Food' to be entered. 

How to Make a Drop-Down List: 

● Go to the place you want your drop down list, or select the range which you want the 
drop down lists within. 

● In the Settings area of the dialog box, choose List from the Allow dropdown. 

● Click OK. 

 

 

When you do that the cells will now show a drop-down and the user can only choose 
from those categories. 
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Restricting Text Length 

The demo you c an use to restrict how many characters a user can type. It comes in 
useful when you need to ensure that an input is a certain length, for example phone 
numbers or zip codes. 

Example: 

You are inputing the employee IDs too, and that must (exactly) 5 characters long. 

Steps to Restrict Text Length: 

●   Navigate to the cells that you want set limited length of texts. 

● Go to the Data tab, and once there click on Data Validation. 

● Under the Settings tab, choose Text Length in Allow lists. 

For next part ● Then from condition box select equal to and type value 5. 

● Click OK. 

 

Fig 4.8 Text Length 

Step 2: Let only 5 digit employee id can be entered. If the goal or input lengths are too 
short or long, the parser will issue an error message. 

Diamond-like Validation Rules with Custom Formula 

You can use formulas to define more complex rules. It is especially handy when the 
validation conditions are based on multiple cells or need custom logic. 

Example: 

10
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Example2 : You haev a column for sales amount and the other column shows how much 
sales can never go below 50% of that amount, target, if target is less than 
Salesamounts. 

 

Fig 4.9 Custom Formula 

How to Apply a Custom Validation Formula: 

●   Select the cells you want to validate. 

● Go to Data Validation. 

● In tab Settings choose Custom from drop-down menu Allow. 

●   Type a formula into the Formula box, for example: =B2>=0.5*C2 

*Here B2 is the cell that contains sales amount. C2 is the cell(s) with the desired 
sales. 

● Click OK. 

This is to ensure that the sales amount would be more than 50% of the target sales. If 
the inputed sales is less than it will prompt an error message. 

Date Validation 

Data validation allows you to input only valid dates and control the date range. For 
example, you might require the date to be in a certain year, or this month. 

2
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Fig 4.10 Date Validation 

For example, you've got a column for due dates and you want to make sure that when 
your users enters a date in the list column, it's only in the current year. 

Steps to Set Date Validation: 

Click the cells that you want to enter dates in. 

● Go to Data Validation. 

● Under Allow, click on Date. 

● Click on the Data dropdown and select either as well as type in the Start Date and 
End Date. 

● The begin date is =DATE(YEAR(TODAY()),1,1) (Detroit,  start of the year) 

● The end date is =DATE(YEAR(TODAY()),12,31) (the end of the current year). 

● Click OK. 

Now, it will only take dates that are from the current year. 

4.3.1 Handling Invalid Data Entry with Error Messages 

We can set error messages to appear when they enter invalid data upon breaking a 
validation rule. 

2
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Fig 4.11 Handling Invalid Data Entry with Error Messages 

 

How to Set an Error Message: 

To conditionally notify users of when they submit unacceptable information, you can 
create error messages that will display if a validation rule is broken. 

Add Show error alert on invalid input. 

There are 3 choice of style: Stop, Warning or Information. 

● Stop -Stops the entry all together. 

●   The user can enter with a warning. 

●   Information can merely suggest a message; it cannot stop people entering the entry 
field. 

They type in a title and an error message. 

Title: "Invalid Entry" 

Message: 'Enter a valid age between 18 and 100.' 

This way, now when invalid data is entered, the user will see an error telling him how to 
plug in the valid data instead. 

Excel Data Validation tools are quite crucial to maintain data integrity and stay error free 
as these do not allow errors to occur due to some specified set of rules, helps in 
keeping the data entry uniform by giving you an option where you can mention a set for 
input, and also restricts the data being input from incorrect or irrelevant value that in 
turn triggers an error. These tools facilitate data entry preparation, and process the 
entered data to make it clean, resulting in usable data for analysis. If leveraged 
properly, these features can be used to eliminate most of the common data-entry errors 
and improve data quality overall. 

4.4 Creating Dynamic Dropdown Lists 
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Excel: A drop-down list updates itself when the source data changes in it 
Automatically!! This is useful particularly if you have a dropdown that gets updated 
frequently (or lets say, you want to append some more options in the same drop down 
but don’t want to manually add them each time). 

Dynamic Dropdown list 

The dropdown list is a value that a user has to choose from, and the options are 
upgraded as soon as the underlying data list changes. If I add your New Products to the 
list, they will appear in the dropdown without doing anything at all to List of products 
(since we append). 

Method 1: Dynamic Dropdown List in Excel Table)application/vnd.openxmlformats-
oƯicedocument.spreadsheetml.sheetextension excel.xlsx4 Steps to Create a Drop-
down List In the first step, select the cell where you want to create a drop-down list. 

The easiest way is to use an Excel table to create a dynamic dropdown list. Changes to 
your data You’ll see that as you alter the data which underpins your list, either by editing 
or adding/deleting Table rows, the list dynamically adjusts to display what’s now in 

there. 

How to Make a Dynamic Dropdown List with an Excel Table: 

Create an Excel Table: 

First things first, organize your data into a column. For example, if your departments 
are “HR,” “Sales,” “Finance” and then “IT”, then it is the last department and a new one 
is added. 

●   Click Table on the Insert tab, and then click the column of data (including header). 
Ensure that My table has headers is checked. 

Name the Table: 

● Insert the table and click one cell in the table. 

· In the Properties group, click in the Table Name field (under Table Tesign tab) and then 
type a name for your table (e.g. Departments). 

Create the Dropdown List: 

● Navigate to the cell or range of cells for which you want a dropdown menu. 

● Go to the Data tab, and select Data Validation. 

● Open the Data Validation dialog, and choose List in the Allow box under Settings. 

· In the Source field, type in the table reference: Enter table name. For example: 
=Departments[Department Name]. 
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● Click OK. 

With the above adjustment in place, by inserting or deleting the departments from 
Departments table will show up in this dropdown listing at the same time. 

 

Fig 4.12 Dropdown List 

Any cell that has been associated to this table will have a dropdown list for you to 
choose one of the updated lists automatically as soon as there is any modification in 
the table. 

Method 2: Named Ranges and Creating the Dynamic Dropdown Lists 

Dynamic Dropdown Lists - Another method involves setting up named ranges which 
automatically expand as we add new rows. Starting point is naming a range, which 
refers to a dynamic area and connecting your named range with a drop down list. 

How to Make a Dynamic Dropdown List by Using Named Ranges: 

Create a Named Range: 

●  Suppose you have products in A1:A10. 

● Visit the Formulas tab, and choose the list cells (A1:A10). 

● Under Name the range ProductList, click on Define Name. 

● In the Refers to box, type OFFSET function that is used to create dynamic range. 

● For example: 

=OFFSET($A$1, 0, 0, COUNTA($A:$A), 1) 

So using this the formula is defining a range from A1 down and adjusting its size 
automatically depending number of non empty cells in column A. 

You can try using the Named Range with Dropdown List: 

Right-click the cell in which you would like to have a dropdown list. 

● Select the Data tab and then click on Data Validation. From the list, choose Data 
Validation. 
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●   In the Data Validation dialog box, click on List from the Allow choices. 

● Type the name of the named range that you created for the cell range in the Source 
box, but be sure to type an equals sign before the name (=ProductList). 

● Click OK. 

Lastly, you can continue to add new products all day long when ever you need as a line 
and the named range will automatically be updated with new items so your dropdown 
list will update. 

Example of Named Range: 

 

 

Now, if you enter Product D into A11, your dropdown will automatically be updated 
(thanks to the OFFSET function of the Named Range), and it will include Product D on 
the list. 

Benefits of Dynamic Dropdown Lists 

Dynamic dropdowns lists: Data will change data-driven updating list, do not need to 
delete inlisting data and insert it again, when the data is updated. 

Maintenance friendly: Tables and Named Ranges are maintenance friendly as data is 
retained in them automatically. Its dropdownlist will get refreshed. 

Better Data Integrity: Dynamic dropdowns make it easier to preserve better data 
integrity, since a user can select only valid options that you define in advance and 
eliminating the opportunity for simple data entry mistakes. 

Flexibility: Tables and Named Ranges allow you to add or change the list without 
disturbing other parts of the workbook. 

Dynamic Dropdown Lists in Excel are very useful, if you use it with the combination of 
other Data Validation Techniques Date Validation, It’s a great way to validate date 
values. Dynamic list dropdowns oƯer a solution for ever-changing lists whether your 
lists reside in an Excel Table or Named Range. This feature is particularly helpful in such 
situations where you are working with your data in a huge workbook or when the 
underlying data is frequently changing. 

8 19
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4.5 Date and Time Validation Techniques 

Date & Time validation is a type of data validation that ensure users enter the valid date 
and time for consistency and to maintain data accuracy. It’s very good for data of 
appointments, deadlines and schedules that have dates or times following some 
regular patterns. 

Date and Time Validation. 

The Check date and time tests that the contents of a cell is valid in relation to defined 
rule for what constitutes proper date or time. This an un-stuƯing of the users from 
punching in invalid or out-of-range values and making sure that they can keep accurate 

records. 

Sample: You can ensure that dates to be entered into a spreadsheet (e.g., for recording 
project deadlines) are valid dates, like occurring within a specified range. 

When Would You use Date and Time Validation? 

● Right Format: It allows us to verify that date / time is given in right format and just 
creating no confusion because of direct data. 

Prevents Invalid Dates: It won't allow to choose an invalid date/time, e.g., February 30 or 
time that's not between 00:00 and 23:59. 

●Improved User Experience It assists users to input correct data either by showing an 
error message for invalid dates or simply oƯering a date and time picker component. 

Date Validation in Excel 

In Excel you can limit the user input to valid dates using Data Validation. Like the 
former, you can also define requirements as all of the above. 

● Dates in some period. 

● These must be some specific days of the week, say you only allow them on 
weekdays. 

● Dates after or before an particular date. 
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Fig 4.13 Date Validation in Excel 

Steps to Set Date Validation: 

Click on the cell to right of title Cell for Date Entry at the bottom row to confirm your 
selection. 

In the cell or range of cells that you would like to be able to enter a date, click. 

Open Data Validation. 

● Find Data Tab on the Ribbon. 

● In the Data Tools group, click on Data Validation. 

Set Validation Criteria: 

● On the Settings tab of the Data Validation dialog box, click the drop down arrow in the 
Allow box, and select Date. 

As a result of doing this, you are allowed to specify the format that the date should be: 

●  Set: only valid dates (e.g., Jan 1, 2020 through Dec 31, 2025 - not years before or 
after). 

● Limit access by date: Specific date ( is, limit entry by "01/01/2025"). 

● Whether a given date comes before or after another date (ie: does this fall in the 
range of dates following today). 

Optional: Error Alert 

●  The user might set an Error Alert, for when the u ser actually enters an invalid date. 

For instance, if you have bounds for possible dates ([01/01/2020 to 12/31/2025] in this 
case), and someone types a date outside the range allowed, there can be a pop up of 
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something like an alert saying "Yo! Yo! Please enter the date between 01/01/2020 - 
12/31.008-1YADoo5!". 

Once you want to implement the validation, hit OK. 

Example: For example, you may only want to limit dates after January 1, 2023. 

Allow: Date 

Data: After 

Start Date: 01/01/2023 

Now, though, if someone enters a date prior to Jan. 1, 2023, a blue error message will 
appear asking them to fill in the correct information. 

Time Validation in Excel 

This is where you use Time ValidationWhen to use: When you need to validate the user 
has entered a time that can be interpreted, (ex You want the user's input as the time 
but what requires you for them not to enter certain times like a 10 hour diƯerence) work 
hours). Like the date, you can set the time to validation in Excel. 

Steps to Set Time Validation: 

1. Choose the Cell for Time to Be Entered: 

● Select the cell or range of cells where time should appear. 

Open Data Validation: 

●   On the Ribbon, click the Data tab. 

● On the Data tab, click on Data Validation in the Data Tools section. 

Set Validation Criteria: 

● Go to the Settings tab, click Allow in the Data Validation dialog box, and choose Time 
from the dropdown list. 

Time conditions are defined as: 

●  Between: Similar to only but with a between clause, letting users determine when 
the event can take place (not one time vs repeating). 

Equal to: Allow a certain time (e.g., allow "12:00 PM" only). 

● Before or After: Verify time is before or after a certain time such as before 6:00 pm. 

Optional: Error Alert: 
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Send an Error Alert with a message when the user inputs an invalid Time ( eg: Please 
input time between 9:00 AM and 5:00 PM). 

● Click on OK as validation took place.TR*DIR.SEQ should now be displayed on the 
screen. 

Example: 

For instance, to limit months between 9:00am and 6:00pm thus,foliosing line. 

● Allow: Time 

● Data: Between 

● Start Time: 09:00 AM 

● End Time: 06:00 PM 

If now one enters a time not in this range s/he would receive an error message. 

Date And Time Validation Formulas 

For complex date and time validation rules, you might want to utilize the Custom 

formulas as well. For example, you might want to allow only dates that are not on 
weekends or times within the working day. 

A first one could be to Validate Date is a Weekday. 

Validating for Weekdays in a Data Entry Form If you want to ensure that the user has 
entered a weekday, then you need to rely on a custom formula within the Data 
Validation dialog. 

●   Open Data Validation, choose Custom under Allow dropdown. 

● Then, type the following formula in the Formula text box, 
=WEEKDAY(A1,2)=TIME(9,0,0), A1<=TIME(18,0,0)) 

This way we can make sure that the time typed in A1 is from 9-6. 

Advantages of the Validation Forms regarding Date and Time 

● This prevents incorrect data entry, as only valid dates and times can be entered into 
the sheet, therefore reducing any errors by inaccurate inputs. 

● Data Integrity Increased: It verifies the data to be reliable and accurate especially 
when we need specific dates and times (such as deadlines, schedules etc.). 

● Enhances the Handling of Data: It reduces the eƯiciencies by automating the 
process of discarding data from unwanted input and provides a smooth and easy 
handling experience to the user. 
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● Enhances the User Experience by oƯering end users clear direction and error 
messages that produces the data entry process simpler, as well as more intuitive. 

Excel date and time validation is a useful feature to maintain data integrity by making 
sure that the user has entered the correct data type. The Data Validation you to restrict 
the entry of dates and times into cells based on being within in a valid range, having a 
specific format, or even meeting specific conditions. Whether you are dealing with a 
project deadline, appointment scheduling, or a project timeline, the date and time 
validation will help ensure your data stays clean – and reliable. 

4.6 Summary 

❖ Data Cleaning in Excel is an essential thing to do to ensure your data is accurate, 
reliable and clean. It refers to recognising errors in the data, removing duplicate data 
and changing the form of data to be analyzed before conducting analyses. 

❖ Excel has a wonderful feature called Paste Special that can help you work with your 
data more quickly. It also enable the data cleaning and data management without 
changing to original source whereas it permits copying only the values, formats, or 
formulas. 

❖ Data Validation is a mechanism for ensuring that the cell data falls within a certain 

range of properties. You do that so you can prevent users from inputting bad data by 
defining rules for what is considered acceptable input (number ranges, text length, lists 
of predefined values, controlled or uncontrolled and so on). 

❖ Dynamic dropdowns lists make data entry so easy by showing predefined options 
which updated automatically, Allowing the user to select an option easily. It minimizes 
trans-coding errors and verifies data forms are consistent. 

❖ Date and Time Validation procedures alleviate the problems where entries of 
temporal data do not conform to the proper format and logically follow one another. 
This prevents mistakes like when entering invalid dates or mismatched times. 

4.7 Key Terms 

Data cleaning: the activity of detecting and correcting (or removing) corrupt or 
inaccurate records from a record set, table, or database. 

Paste Special: A function of Microsoft OƯice Excel for pasting data, Paste Special lets 
you paste certain elements of copied data — such as values, formatting or formulas — 
in order to speed up the process. 

Data Validation: Excel’s feature for controlling -restricted data being entered in a cell by 
establishing criteria of how the data should be entered. 

9 9

12

Page 29 of 36 - Integrity Submission Submission ID trn:oid:::3618:127049170

Page 29 of 36 - Integrity Submission Submission ID trn:oid:::3618:127049170



“Dynamic Data Validation Lists: (ie,rolodex)these lists (Excel files) auto update 
themselves showing only certain points of data to select for entering, and remove user 
errors by also allowing one process or standardisation everywhere. 

Date and Time Validation: Methods to establish that items of date and time in records 
are valid, consistent with each other, and look reasonable. 

Duplicates– Multiple entries of the same record of a dataset are called as duplicates 
which can lead to high deviation in analysis, also removed in data cleaning. 

Standardization: This happens when data is formatted into a standard format (for 
example, dates of one specific format or text in certain casing) throughout the database. 

Error Identification: Discovering inaccurate or inconsistent data entries in a dataset, 
according to data cleaning activity. 

Data cleaning Methods: How to apply data cleaning methods and techniques 
somewhere, in business, for students or any profession to help improve the decisions 
made from data. 

4.8 Self-Assessment Questions 

Describe me the idea of data cleaning in Excel? What is the reason that it becomes 
necessary to conduct and what happens if this were omitted before data analysis. 

Explain how the Paste Special Function in Excel is used, for the purpose of cleaning up 
data. Two examples on when you would want to use Paste Special. 

What is data validation in Excel? Explain how diƯering data validation tools (for 
instance, limiting ranges to a number range, text length cap and menu lists) are used to 
maintain data integrity. Provide examples. 

Explain how you can create dynamic dropdown list in Excel? Describe what dynamic 
list is and compare it with a static list.Evaluate the benefits derived from using lists in 
data management. 

Explain common date/time entry mistakes in Excel, like entering the dates using 
diƯerent formats and the times being not valid. What kind of validation we can do to 
avoid such type of mistakes. 

Distinguish between information validation and normalization in Excel. How do these 
mechanisms reinforce each other to guarantee a reliable data quality? Use a few 
examples to illustrate your answer. 

What is duplicate entries on dataset? Describe how it can hurt the analysis of data and 

steps on how to identify and remove duplicates with the help of Excel tools. 
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Explain how dynamic datasets can help you enter more accurate and consistent data 
when you are working with tens of thousands of choices. Give an example of a situation 
in which drop down lists are useful in real life. 

Provide an example (or anecdote) of a time when data cleaning made a huge diƯerence 
in the success or failure of a project or business decision. Emphasize methods and 
equipment used for cleaning. 

Replication Exercise: Using Several Data Cleaning Techniques in Excel 

Dataset (Before Cleaning) 

 

 

Task: Do the following data preprocessing: 

Reduce Duplicates: Eliminate duplicate records (Customer ID 101 is listed twice). 

Fill Missing Values: 

o Replace blank names with "Unknown". 

o Substitute any missing sales value with a "0". 

Reduce Date Formats to Similar Ones: Change all dates into DD/MM/YYYY. 

Apply Data Validation: 

o Add drop down in Region column with values North, South, East, West. 

Try to apply Paste Special: Convert the negative sales values into positive. 

Save your cleaned dataset as “Cleaned_Data. xlsx" and submit. 
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Answers to Knowledge Check 

Knowledge Check 1 

1: B) And paste only the values which are calculated not the formulas 

2: A) Paste the Values And Formats 

3: B) Skip Blanks 

 

4.10 Case Study 

Data Cleaning for Real-World Applications 

When real data is involved there may be many inconsistencies and errors, among them. As data 

cleaning is applied in real business settings, here we’ll attempt to view this case study from a practical 

business scenario. The use-case will concentrate at how data cleaning could be made available to make 

the sales data quality of a retail company better by making it easier for us to delete bad records. 
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Scenario: Sales Data of a Retail Company Let’s consider the following sales data of a retail company 

to understand how we can analyze it using the skewness formula in Excel. 

Now if we think about a retail smoothie chain gathering daily sales from multiple locations. Your data 

has these columns. 

· Store ID 

· Date of Sale 

· Product Category 

· Number of Units Sold 

· Sales Revenue 

Through payments (Cash, Credit Cards, Online etc). 

This information is employed by the company for studying the sales trends, forecasting the income in 

future and to compare performance between stations. However, as with the company discussed here: 

there are quite a few data issues to tidy up once you analyze the data. 

Step 1: The first step will be to identify missing or incorrect data. 

First of all we need to establish all the deband/incorrect data entries. For example: 

· Negative sales amount in some of the rows. 

· : UNKNOWN (where it is supposed to be a valid category). 

·  Dates entered as strings or text. 

·  Negative units sold or negative revenue is not applicable in this case. 

Action Taken: 

·  Missed Sales Revenue: The company elects to measure missed sales revenue on the basis of either: 

·   Quantity Sold * Price per Unit 

(words for where price is another Table) Prices are marked for manual scrutiny if they are not found. 

· Invalid Categories: The company ensures that all 'Unknown' are resolved by checking the descriptions 

of the products. 

11 11
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· Date Formatting: The Company will convert dates expressed as text into a correct date format in the 

rows that they reside. 

· Negative Values as Dividend: Either Value of No of Units sold or value of sales revenue/2 As these 

are indicated negative, checking for data entry errors. 

Step 2: Handling Duplicates 

The company should then ensure there is no redundant input – it can confuse the analysis. 

· Sometimes, when we input the data for sales, the figures are entered more then once. 

Action Taken: 

· The company uses Excel’s in-built Remove Duplicates tool to deduplicate transactions to ensure no 

duplicate is counted twice for each transaction. 

Step 3: Standardizing Data Formats 

It's critical not to normalize data, if it stores in bit representation, is there for every value in usable 

format. For a retail company, for example: 

·  To uniform the means of payment: The company understands that some rows have “Cash” written 

as “cash” or “Online” written as “ONLINE”, concluding then that there is no standardization in the 

means of payment. There are contradictions that have to be clarified. 

·   Product Categories with Variation: There are few product categories that have slight variation list 

(though the difference is small) - for eg., Mens Shoes / Men's shoes etc. 

Action Taken: 

·   Company uses excel`s Find and Replace for standardization of payment method / product category. 

· With the “Payment Method” column all nuances are standardized (eg. 

Step 4: Removing Outliers 

Data outliers are points that are way out from the other bulk of data, they could be errors. For example, 

one transaction can be of sales 1,000 quantitys of a product at one store. This is very unusual. 

Action Taken: 
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This transaction is an exception, the company goes over it and isolates it as a data entry mistake. To 

avoid biased analysis, they choose to eliminate this outlier from the data set. 

The firm sets thresholds that seem reasonable for its data (such as sales revenue in a range from ₹0 to 

₹10,00000) and flags any transaction lying outside the threshold, which must be investigated. 

Step 5: Treatment of the Data for Analysis 

Once the data has undergone a clean and standardisation process, it can be analysed. Redgate was now 

in a position to have solid data that they could use to report on and make business decisions from. 

Action Taken: 

· A new worksheet is generated, then cleaned data is brought in for analysis. To assist managers in their 

decision-making, the company generates sales reports, trends and graphs. 

· In order to avoid this error in the future, the company at its end uses data validation rules in Excel: 

Empty value - no payment methods will be accepted except valid ones (Cash, Credit card, Online) – 

validated by Date. 

Conclusion 

Here the retail company opted to use a combination of data cleaning where they filter missing, 

duplicates and standardize the format/hierarchy as well as outlier management for their sales dataset to 

improve its quality. This enabled them to base their investigations on correct, uniform and immediately 

available data. As a result, they took data-driven decisions and fostering better business operations was 

in their purview. 

Key Takeaways: 

· Data cleaning is part of the important steps when data should be intact and accurate. 

· There are instances where there is a missing value, wrong format, duplicated etc to which data is 

needed to be dealt with. 

· Excel has functionalities such as Paste Special, Data Validation and Remove Duplicates to help you 

in cleaning the data. 

· Datasets need to be cleaned in a way that such data can be used for in-depth analysis which helps in 

making better decisions. 

Reflective Questions 
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What were the cleaning issues you had when working with the sales data for this retail company, how 

did you solve them? 

Why it is recommended to standardize formats for anything like Payment Method and or Product 

Category before analyzing the data? 

What could be the potential business implications for missing or incorrect data when there is no data 

cleansing in place? 
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Unit 5: Logical Analysis Tools 

 

Learning Outcomes 

● Learners will be able to apply logical functions in Excel, including IF, Nested IF, 
AND, and OR, to perform conditional analysis and decision-making. 

● Learners will understand and utilize filtering and sorting techniques to extract 
meaningful insights from large datasets. 

● Learners will apply advanced sorting options, such as multi-level sorting and 
custom sorting, to organize and analyse data eƯiciently. 

● Learners will demonstrate proficiency in using logical analysis tools to improve 
data-driven decision-making and reporting. 

 

Structure 

5.0 Introductory Caselet 

5.1 Applying Logical Functions (IF, Nested IF, AND, OR) 

5.2 Filtering and Sorting Data for Decision Insights 

5.3 Using Advanced Sorting Options 

5.4 Summary 

5.5 Key Terms 

5.6 Descriptive Questions 

5.7 References 

5.6 Case Study 
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5.0 Introductory Caselet 

"Using Logical Functions and Data Analysis for Optimal Business Decisions." 

Scenario: 

Riya works as sales manager for an e-fashion brand across cities in India. As the 
clientele expands, it’s essential to eƯectively organize your sales data in order to act 
upon this. But Riya has several hurdles: High-value customers segment, seasonal 
pattern forecast and discount application in such a way that maximizes revenue. 

Her staƯ goes through thousands of transactions manually to seek patterns, but that 
process is slow and susceptible to error. In addition, shuƯling and sorting data for 
customers is time-consuming to group them by purchasing history, geography, product 
aƯinity. Riya knows she needs a virtual assistant to help her make quick decisions and 
be more eƯicient. 

Logical functions such as IF, Nested IF, AND, OR can help to 3 Classify customers 4 
OƯer special discount oƯer to the customers and Predict future sales pattern. Plus 
there are some fancy filtering and sorting methods to help Riya (and your team) quickly 
sort through the major trends and make good business decisions. 

Logical and Data Analysis Using Logic Functions 

Using IF and Nested IF for customer based Segmentation: 

Riya chooses to divide customers by recency of purchase and monetary value. By using 
IF and Nested IF functions in Excel, Riya automates customer segmentation: 

● High-Spend Customers (Those who have Spent above ₹50,000 in last 1 year) are 
given a Loyalty Rebate of 20%. 

● Frequent buyers (Bought more than 10 times, upto ₹50,000) will get a discount of 
10%. 

● Occasional or new customers (5 purchases or less): Your referral coupon: adds 
recommendation not a discount. 

That automation ensures discounts can strategically be oƯered to only the most 
revenue-generating customers. 

Filtering and Sorting the Data for Trend Analysis: 

Riya provides special resources for filtering and sorting aspects so that customer's 
activity can be analyzed. Using filters, she determines: 

⦁ The most sold product categories across diƯerent cities. 

●  Peak shopping periods from past years. 
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●  The impact of price reduction on sales performance. 

With the categorisation of information, high-contribution data gets first look on Riya and 
decision making can be accelerated. 

Enhanced Sorting for Business EƯiciency: 

Riya does multi pass sorting on their data to figure out what needs to be restocked first. 
She organizes the various sales data by: 

●   Profit Margin: High – Low. 

●  Inventory Level: Low to High. 

● Customer Perspective by the end of 2018 (From High to Low) 

This allows her to properly restock inventory in priority, keeping those top-selling and 
most-profit items always on the shelves. 

Decision-Making with Data Insights 

By using logical operations, filtering and conditioning sort routines Riya automates 
grouping of customers, optimizes inventory management decisions and prolongs 
promotions. Faster data-informed decisions means better customer satisfaction and a 

lift in revenue. 

Critical Thinking Question 

How can Riya further improve her sales strategy with logic operations and advanced 
data filtering and sort? 

5.1 Applying Logical Functions (IF, Nested IF, AND, OR) 

Excel logical functions are ubiquitous for analysis and decision-making. It sets up rules 
in order to make decisions automatic and limiting human intervention. Among others, 
it is popular in applications ranging from grading of students and employees to 
business decision making and financial modeling. 

IF Function 

IF is a simple logical function which is used to check whether a condition is true or 
false and then act accordingly. It is, therefore, very often used for validating data as part 
of a decision making process and also in automation with spreadsheets. 

The function evaluates a condition and returns one value if the condition is TRUE, and 
another value if the condition is FALSE. This makes it possible to classify data, perform 
calculations under conditions and automate the entire workflow. 

Such conditions are commonly used in business and education, and the IF function is 
a valuable function even for uses like creditor obligation test, performance testing 
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answerer to queries and financial tracking. While IF is by no means incapable of making 
decisions when it flies solo, it works even better with some logic functions as 
wingmen—namely AND, OR, and especially nested IF. 

The IF function means less strain on your data manipulation operations, reduced 
reliance on manual intervention and increased accuracy of both analysis and reporting 
output. 

Syntax: 

=IF(logical_test, value_if_true, value_if_false) 

● logcial_test→ What to test for being True or False (e.g., A1>50). 

• value_if_true --> The result returned if the condition was evaluated as true (i.e., 
"Pass"). 

value_if_false – That will be returned if the condition given is not true (e.g., "Fail"). 

 

 

 

Fig 5.1 If Function in Excel 

Figure 5.1 Example of an Excel spreadsheet where the IF function is employed to 
produce a logical value (TRUE, FALSE) depending on whether or not the student 
passed. 

The Formula in Cell D2 Explained: 

=IF(C2="PASS", TRUE(), FALSE()) 

• Logical Test (C2 = “PASS”): It tests if the value in column C (Result) is equal to “Pass”. 

• True Value (TRUE()): If the condition is met (for instance that the student passed), such 
as TRUE. 

4
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• FALSE() Otherwise the function returns FALSE if condition is false (i.e., then student 
failed). 

Here, 

• If the Result column (C) has "PASS", then its associate value in Logical Value column 
(D) would be TRUE. 

• If the Result column (C) lists “FAIL”, then in the Logical Value column (D), there will be 
FALSE. 

Example 2: Student Result Determination 

A student is Formali"Marks"ed to be "Passed" if he/she has marks ≥ 40, failing which 
Formally marks him/her as "Failed". 

=IF(A2>=40, "Pass", "Fail") 

Results: 

 

Fig 5.2 Student ResultDetermination 

Example 3: Employee Bonus Calculation 

A firm oƯers 10% bonus on sale of ₹50,000 or over by an employee and no bonus for 
value less than ₹50,000. 

=IF(A2>50000, "Bonus Granted", "No Bonus") 

Results: 

 

Fig 5.3 Employee Bonus Calculation 

Nested IF Function 

A nested IF is a multiple level version of the Excel IF function, where it is possible to 
test more than 1 condition within a single formula. Rather than a single "either or" 
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return, nested IF statements can provide up to 254 individual responses based on the 
condition(s) met! 

This function is useful for when you have more than two potential outcomes in 
decision-making such as grading systems, pricing strategies and performance 
evaluations. The IF tests are tested in the order they appear so as it finds a match, that 
is returned and the remainder of the tests won't be looked at. 

Syntax: 

=IF(condition1, value1, IF(condition2, value2, value3)) 

When there are multiple conditions applied. 

It will output diƯerent things according to a number of conditions. 

 

Fig 5.4 Nested If in Excel 

 

Example: Student Grading System 

A school has a grading system as follows: 

A (≥ 90), B (≥ 75), C (≥60), D (≥40), F (=90,"A",IF(A2>=75,"B",IF(A2>=60,"C", IF(A2> 40, 
"D","F")))) And here is the charts with that formula in A1, results in B1. 

Results: 

 

AND Function 

7
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The AND Function in Excel This post covers the basic usage of the AND function. It only 

returns TRUE if ALL of the specified conditions are TRUE, otherwise it will return FALSE. 

It’s especially helpful when you have a lot of criteria to judge something by, like eligibility 
determination, financial review, and data validation. It is also commonly used along 
with IF to add conditional logic an extra level deep. 

As AND needs all conditions to be TRUE, if one of checks is negative the function 
returns FALSE. Therefore, it is a useful mechanism in more restricted validation 
environments where business or academic applications approve or classify a 
requirement if several are met. 

Syntax: 

=IF(condition1, value1, IF(condition2, value2, value3)) 

● Utilized where with more than one condition. 

● Returns some diƯerent results, depending on conditions. 

Did You Know? 

With Nested IF functions, Excel will support up to 64 levels of nesting in current 
versions. But each level of Nested IF makes the formula more and more complex, it 
becomes diƯicult to debug. Instead, use functions such as IFS or LOOKUP if you have 
them. 

 

Fig 5.6 AND Function in Excel 

 

Example: Student Grading System 

 

The Syntax Empty school assigns grades as follows: 

 

=AND(condition1, condition2,.) 

9
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● TRUE is returned only if all 3 conditions are satisfied. 

 

● If one of the conditions is not satisfied, then returns FALSE. 

 

Example: Scholarship Eligibility 

 

A student receives a scholarship if they: 

 

● Marks ≥ 85 

 

● Attendance ≥ 75% 

 

=IF(AND(A2>=85, B2>=75), "Eligible", "Not Eligible") 

 

OR Function 

 

The OR function assesses multiple conditions and returns TRUE if any one of the 
conditions is TRUE. 

 

It can be quite handy for when you need to apply one of few criterias (such as 
approvals, conditional formatting or decision making). It is commonly used in 

combination with the IF function to enhance data analysis and reporting by allowing 
users to introduce additional complexity into formulas. 

 

It is a useful technique to simplify the complex logical expressions by replacing them 
with a single OR function that lets us trim down multiple IF conditions, and thus makes 
our formula more readable and eƯective. 

 

Syntax: 

4
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=OR(condition1, condition2,...) 

 

●   Is TRUE where ANY condition is met. 

 

●   FALSE is returned if none of the conditions are satisfied. 

 

Example: Loan Approval 

 

A claim is allowed if a person has one (or both) of: 

 

A CIBIL score ≥ 750, OR 

 

A monthly income ≥ ₹50,000 

 

=IF(OR(A2>=750, B2>=50000), "Approved", "Rejected") 

 

Results: 

 

Fig 5.7 Scholarship Eligibility Result 

 

XOR (Exclusive OR) 

 

The XOR function (Exclusive OR) evaluates to TRUE if one and only one of its arguments 
is TRUE and FALSE otherwise (i.e., both are FALSE or both are TRUE). 
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Truth Table for XOR: 

 

Excel Formula for XOR: 

 

=XOR(A1, B1) 

 

This returns: 

 

TRUE if either of the values is TRUE. 

 

FALSE if both these values are equal. 

 

Fig 5.8 OR Function in Excel 

Example: A1 = TRUE and B1 = FALSE → XOR(A1,B0) returns TRUE 

 

Si A1 = TRUE y B1 = TRUE → XOR(A1,B1) = FALSE. 

 

XNOT (Exclusive NOT) 

 

"XNOT" does not exist as an Excel function, but can be interpreted as a NOT operation 
on the XOR of two values. 

 

In logic gates, this corresponds to NOT (negating or inversing a value). 

 

10
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Fig 5.9 Loan Approval Status 

NOT Truth table (XNOT idea) : 

 

Input A 

 

XNOT A (NOT A) 

 

Fig 5.10: Exclusive OR 

FALSE 

 

TRUE 

 

TRUE 

 

FALSE 

 

Excel Formula for NOT: 

 

=NOT(A1) 
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This returns: 

 

TRUE if A1 is FALSE. 

 

FALSE if A1 is TRUE. 

 

 

Real Business Use of Logical Formulae 

 

Application: Evaluating Employee Performance and Awarding a Bonus 

 

 

Scenario: 

 

A business considers staƯ on several diƯerent levels: 

 

They oƯer an additional 10% bonus (on the annual sales, if it exceeds ₹5,00,000) to 
their employees. 

 

Workers are assigned a rating according to the numbers of sales: 

 

Excellent: Sales ≥ ₹10,00,000 
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Good: Sales ≥ ₹7,50,000 

 

Average: Sales ≥ ₹5,00,000 

 

Needs Improvement: Sales 500000, "Bonus Granted", "No Bonus") 

 

· If the sales are greater than ₹5,00,000 → Bonus received 

 

· Otherwise → No Bonus 

 

Performance Rating (Nested IF): 

 

=IF(B2>=1000000, "Excellent", IF(B2>=750000, "Good", IF(B2>=500000, "Average", 
"Fair"))) 

 

· Assesses sales to rank in its own way. 

 

Special Award Qualification (AND Function): 

 

=IF(AND(C2>=750, D2>=90), "Eligible for Award", "Not Eligible") 

 

· Credit score ≥750 AND attendance >90% is compulsory 

 

Discount Eligibility (OR Function): 

 

=IF(OR(E2>5, F2>2000),"Discount Applied", "No Discount") 

 

· 5 or more items is brought by the employee then discount will be given on it, if an 
employee spends above ₹2,000 then he would get discount. 
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Final Complex Decision (AND & OR Combined): 

 

=IF(AND(B2>500000,OR(E2>5,F2>2000),AND(C2>=750,D2>=90)),"Top Performer & 
Discount Applied","Review Performance") 

 

: An employee is Top Performer with a Discount if: 

 

Sales > ₹5,00,000 

 

Purchases more than 5 articles OR has a value of ₹2,000 or above. 

 

Ownership of neither Has credit score ≥750 AND attendance ≥90% 

 

 

 

Conclusion 

And via IF, Nested IF, AND, and OR functions business can automate procedures such 

as: 

● Performance evaluation 

● Loan and credit approvals 

● Promotional oƯers 

● Admissions and hiring criteria 

Knowing these two functions in Excel will assist you in making decision based on data, 
and also take you business operation to the next level of eƯiciency. 
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Did You Know? 

Advanced sort feature which can be used to sort based on multiple columns for better 
organizing the data. You can also sort by cell color, font color, or custom lists so you 
spend less time siftin... and more Its not just for numbers either - you can sort by 
character length, font color, and even cell color!Sort data in Excel worksheets in a 
crowd! ranking & categorizing business information is a quick and painless process-
ranking lists of names neat problems into organized data. 

5.2 Filtering and Sorting Data for Decision Insights 

Filtering and sorting- features Excel Filters Sorting are some of the most eƯicient data-
processing functions available in Excel to help you organize, analyze and retrieve 
important pieces of information from a huge dataload so that we can make quick 
decision with perfection. 

Filtering Data 

Filter also sorts rows - Display only the sort of rows in Excel Filter The filter will display 
only the rows that meet certain conditions and temporarily hide others. The power of 
filtering is that you can apply filters to the filtered data and see only it in the workbook, 
making it easy for you to study selected portions of overall dataset. 

How to Apply Filters 

● Step 1: Click at the range or click any cell of your data. 

● Step 2: Go to the Data tab and select Filter. The filter arrows will be put in the header 
row. 

●  Step 3: Hit the little filter arrow on your target column and type in your input 
conditions for the filter. 

Example: Filtering Sales Data to Include Only One Region 

Suppose you have a data set of sales in several regional areas, and you only want to 
see the North Regional data. 
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Fig 5.16 Filtering Sales Data by Region 

Filter Applied: 

● Criteria: Region = "North" 

 

Fig 5.17 Sales in North Region 

● Insight: You can quickly assess total sales in the North region for further analysis. 

 

Custom Filters 

You can always add your own custom filters to have more flexibility with say ranges, 
text conditions or dates. 

 

Fig 5.18 Filtering Data by Date Range 

Example: Filtering by Date Range 

Imagine a sales report that you only want to display for the months of January through 
March. 

Custom Filter Applied: 
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Fig 5.19 Custom Filter 

Criteria: Date is greater than 01-Jan-2024 and less than 31-Mar-2024 

● Takeaway: Pay attention to quarterly sales results. 

Sorting Data 

It allows one to order (i.e., sort / rank) data in an informative manner which may help 
one finding patterns, trends or other features. Tasks can be seen in alphabetical and 
numerical order, by due date. 

How to Sort Data 

● Step 1: Select your date range or the column you want to sort. 

Step 2: The Transpose Option Click on the Data tab. 

● Step 3: Choose sort ascending (A-Z) or sort descending (Z-A). 

Example: Sorting Sales Data 

 

Figure 5.20 Sorting Sales Data 

Sort Applied: 

● Criteria: Revenue in decreasing order 

 

Fig 5.21 Sales in Descending Order 

●   Insight: Discover best performing products in no time. 

5
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Multi-Level Sorting 

Multi-level Sorting -sort data on two and more rows. Great for hierarchal data 
organization. 

Example: Sales by Region and Salesperson 

 

Fig 5.22 Sales Performance by Region and Sales Representative 

Sort Applied: 

● Level 1: Region (A-Z) 

Level 2: Top - Sales (Largest to Smallest) 

 

Fig 5.24 Region (A-Z) 

 

Fig 5.25 Sort Applied (Largest to Smallest) 

● Insight: Easily identify productive performers. 

Excel filtering and sorting are fundamental for data-driven decision-making in business, 
as they allow the user to reveal insights, explore patterns and back informed decisions 
with facts. 
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5.3 Using Advanced Sorting Options in Excel 

One of the most notorious features within Excel is sorting, users spend possibly hours 
sorting and analyzing their own data. For most basic data types you'd want just a 
simple sort, ascending or descending. Complex Sorting Options users can sort data 
using multiple options - by most viewed, created date, view type and view count 
Custom Lists Users also have the ability to create custom lists for their information 
Case-sensitivity Turn it on if you prefer case sensitivity in your lists. This is particularly 
helpful to businesses required to process complicated types of data in a timely 
manner. 

Multi-Level Sorting 

The hierarchical Sort can be easily implemented by using Multi level Sort (users would 
like to sort against multiple columns) It is convenient to sort data that belongs with 
hierarchy, eg salesman name sales performance region. 

Examples: Organizing employee sales data by region and volume of sales. 

Take a dataset of employee sales across several regions for example: 

 

Fig 5.26 Sorting employee sales data by region and amount of sales 

Steps to Apply Multi-Level Sorting 

1. Choose the dataset. 

2. Navigate to the Data tab and click Sort. 

3
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3.For the first column, choose Region and then A-Z (Ascending Order) in the dialog box 

 

 

4.Click Add Level, then choose Sales (₹) as the second column and select Largest to 

Smallest. 

 

5.Click OK. 

Result: 

17
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Fig 5.27 Multi-Level Sorting 

Insight: The data has been sorted by Region (A-Z) and for each region, it is sorted in 

reverse order of Sales. 

Sorting by Custom Lists 

Excel users are able to sort according to a "custom list," which is in an arbitrated order 

rather than alphabetical or numerical. 

Example: Sort by Quarter (Q1, Q2, Q3, Q4) 

Now consider business sales data recorded by quarters: 

 

Fig 5.28 Sorting by Quarter 

How to do Custom Sort Using Lists 

Select the dataset. 

Go to Data → Sort. 
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Now in the Sort dialog select Quarter for your Column. 

Click Order → Custom List. 

In the Custom Lists dialog type: Q1, Q2, Q3, Q4 and then click OK. 

Result: 

 

Fig 5.29 Sort Using Custom Lists 

Insight: This uses natural trading order rather than alphabetical. 

Sort by Cell Color, Font Color, or Icon 

You can use cell color, font color and the icons (applied via conditional formatting) to 

easily group the data that you are analyzing. 

Example: Sort Sales Performance by Color 

 

Fig 5.30 Sort Using Custom Lists 

Steps to Sort by Color: 

Select the dataset. 

Go to Data → Sort. 

7
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Select Performance Rating as the sort column. 

 

Fig 5.31 Sorted by Performance Rating 

In the Order paragraph, select either Cell Color or Icon and set order of the colors (ⰨⰩ 

→ ⰥⰦ → එඒ). 

Click OK. 

Result (Sorted by Performance Rating): 

What I like: High achievers are near the top, creating instant clarity regarding high 

performers. 

Sorting with Case Sensitivity 

Don’t worry! Excel’s sort is usually not case-sensitive but you have the option to make it 

so if necessary. 

Example: Sorting Employee Names Case-Sensitively 
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Fig 5.32 Sorting Employee Names Case-Sensitively 

Steps to Apply Case-Sensitive Sorting 

Select the dataset. 

Click on the button "Sort..." in the Data menu. 

Click Options and then Case Sensitive. 

Choose Sort A to Z. 

Result: 

 

Fig 5.33 Apply Case-Sensitive Sorting 

Insight: This is how it handles the problem the input case sensitivity of names. 

Multiple criteria(sort) in pivot table 

When you’re dealing with Pivot Tables, sorting is a must. Fields can be dynamically 

sorted by users in order to interrogate mountains of data. 

Example: Sort Total Sales by Region in Pivot Table 
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Fig 5.34 Sorting by Multiple Criteria in Pivot Tables 

Method to Sort the Pivot Table's Data: 

Hold down the Shift key and click on the Pivot Table column heading (Total Sales). 

Right-click and select Sort → Largest to Smallest. 

 

Result: 

Fig 5.35 Sort Pivot Table Data 

Insight: Aid in prioritizing high sales areas for strategic planning. 

Advanced sorting features in Excel provide a fast and easy way to handle, manipulate, 

and format data that is larger in size. By using multi-level sorts, custom lists for sorting 

data, sort options in pivot tables where you can sort your data by color or icon and case 

sensitive way we can have a deep dive while dealing with Data. Mastered skills enables 

us to organize data, observe trends and make smarter decisions in day-to-day business 

context. 

Knowledge Check 1 

Knowledge Check 

Choose the correct option: 

3
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How do I do multi level sorting in Excel? 

a) Click on "Custom Lists" 

b) Choose the dataset 

c) Select "Sort by Color" 

When you sort using a custom list where do you write in the pre-defined order (i.e., Q1, 

Q2, Q3,Q4)? 

a) On the Sort window in Column Name 

b) In the Custom Lists window 

c) Format in the Cells Dialog box 

 

5.4 Summary 

❖ Logical Functions in Excel may assist to take decision by evaluating the conditions 

and get true or false against logical tests. They are probably the most popular function in 

data analysis, reporting, and other areas. 

❖ The IF function tests a condition and then returns one value if the test is TRUE, 

another value if the test is FALSE, so it can be used to classify data. 

❖ Multiple conditions are verified with Excel nested IF statements, allowing you to 

extend the application of this function in more advanced formulas such as grade 

calculation systems (especially for academics), financial models and likewise. 

❖  The AND Function requires all supplied conditions to be TRUE for a resultant TRUE, 

which is helpful in when you need certain very explicit eligibility criteria, compliance 

checks and multi-conditional decisions. 

❖ See screenshot: The OR function will get TRUE if at least one condition is true. This 

one is great for that kind of decision making flexibility, as well as "what if"ing and 

conditional formatting. 

❖ (Excel Post 5) Filtering of data: Information required from detailled data which meet a 

particular condition can be extracted using filtering. With these filters, the data becomes 

visible and decision making is more efficient. 

❖ Sorting Data sorts data in ascending or descending order using text, numbers, dates and 

then it becomes easy to analyse the trends & data patterns. 

1

Page 30 of 35 - Integrity Submission Submission ID trn:oid:::3618:127049174

Page 30 of 35 - Integrity Submission Submission ID trn:oid:::3618:127049174



❖ Custom Sorting Options allow sorting the data in levels, for example, to receive the 

report sorted on department and then by an employee's name making reports clear and 

looking organized 

❖ Techniques for specific order on the basis of Colors, or preceding Icon Set OR YOUR 

list "ALWAYS' shows the end-user what iis more important. 

❖ Become proficient in Logical Analysis Tools, and you'll have the ability to handle 

more of your business data with skill and ease. 

 

5.5 Key Terms 

Logical Functions: In Excel, functions that allow you to perform operations based on 

conditions if function is TRUE and if FALSE. 

IF Function :a function that verifies whether a condition is met, and returns one value if 

true and another value if false. 

Nested If: A set containing more than one If statement which can be used in formula to 

test a set of conditions one by one. 

AND Function: If and only if all the conditions are true, it will be true also. Otherwise, it 

returns False. 

OR Function: This returns a True if the conditions given in this statement are met to any 

extent or False otherwise. 

Data filter Only show requested data according to the conditions and hide others for easy 

browsing use during data analysis. 

Data Sorting: Structuring data based on particular criteria such as ascending/descending 

order, by number value, text or dates. 

Advanced Sorting - A refined sort feature for sorting data with multi-criteria such as 

using custom lists or applying S&T. 

Conditional Formatting: This is an Excel feature that uses formats like colors or icons in 

cells based on certain programmed conditions in order to give you a much easier way of 

building visualisation. 

Data-Driven Decision Making: It is to make decisions in your business or analytical 

thinking based on a systematically reviewed and logically analyzed data. 

 

5.6 Descriptive Questions 

6
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Describe the significance of logical functions in Excel. And what do they add to 

decision-making in data analysis? 

Describe the IF function. How does it work, and when is it generally used? 

What is a Nested IF function? Nested IF vs. Simple If What do I call the Extra IF? 

Advantages & Disadvantage of nested if in Excel. 

Describe AND function in Excel. How will it help me to analyze logically? How is it 

appropriately used? 

2.a What is the OR function and its uses? How does it perform the logical operation as 

compared to AND function? 

Role of a data filter in enhancing decision-making in an Excel sheet. Explain a few ways 

you can filter your data in Excel. 

Why and how would you sort with data in Excel? How does it help to learn about trends 

& patterns in a dataset? 

Explain what is meant by Excel advanced sort? How do custom sort options for example 

sorting by color or more than one level of sorting help organize data? 

What About Filter and Sort with Logical Functions for Data Analysis? Give some 

reasonable concrete application of that combination. 

Explain where logical functions are used in solving business problems: Explain their use 

in financial analysis, inventory management and monitoring. 

 

5.7 References 

1. Microsoft Support. (n.d.). Use logical functions in Excel. Retrieved 

fromhttps://support.microsoft.com 

2. Microsoft Support. (n.d.). Top ten ways to clean your data. Retrieved 

fromhttps://support.microsoft.com/en-us/office/top-ten-ways-to-clean-your-data-

2844b620-677c-47a7-ac3e-c2e157d1db19 

3. Walkenbach, J. (2019). Excel Bible. Wiley. 

4. Gupta, V. K. (2020). Excel for Data Analysis and Business Modeling. BPB 

Publications. 

5. Beresford, L. (2021). Mastering Excel Formulas and Functions. Independently 

Published.Answers to Knowledge Check 

Knowledge Check 1 

1: a) Click on "Custom Lists" 

2: b) On the Custom Lists dialog box 

2
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5.8 Case Study 

“Retailing Sales Analysis And Decision Making” 

ABC Retail is a department store chain that runs in different parts in India. The 

management wants to enhance its performance in sales and operations using Excel data 

analysis. The company maintains a vast database of sales, employee performance and 

transactions. 

So that ABC Retail can gain such sound insight, it will use Logical Functions and Sorting 

& Filtering as well as Advanced Techniques for Sorting & Filtering to study and interpret 

sales data. 

Problem Statement 

The ABC Retail's management intended to: 

Categorise Sales Performance using IF, Nested IF, AND, OR functions. 

Filter and sort sales data to see trends and views. 

Utilize Advanced Sorting functionality to bring the important values to the top. 

Dataset Overview 

 

Fig 5.36 Sales Performance 

 

The columns included in the sales data are: 

Step 1: Working with Logical Functions (IF, Nested IF, AND, OR) 

Objective: 

Goal The management wants to classify the performance of each salesperson into groups, 

either “Good”, “Average”, or “Poor” based on the following conditions: 

●   Good: If the salesperson achieved or outperformed target, and their customer rating is 

4 or higher. 

●   Median: The salesperson meets target but has earned no more than 4 rating from the 

● Bad: When the sales representative does not attain the goal. 
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Solution with IF and Nested IF: 

In Excel, we use the formula: 

=IF(AND(C2>=D2, E2>=4), "Good", AVERAGE (IF(C2>=D2,"A","P"))) 

Results: 

 

Fig 5.37 IF and Nested IF Functions 

Insights: 

● Rohan and Kiran played admirably. 

● Aditi and Neha sold less than their set target. 

Step 2: Refine and Organize Data for Decision Making Insights 

Objective: 

● Filter the data to show only salesmen who had a performance of “Good” or “Average.” 

● Order Total Sales in descending order to find the best performers. 

Steps: 

Select the dataset. 

Click on Data → Filter and filter the Performance Category column for "Good" & 

"Average". 

Select Data → Sort and sort from the Largest to Smallest based on Total Sales. 

Filtered and Sorted Data: 

 

Fig 5.38 Filtered and Sorted Data 

Insights: 

● Rohan  is the best salesperson. 

●  Rewards from such incentive based programs may exclude underperformers. 
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Step 3: More Sorting Options 

Objective: 

●   Rank employees by Region (A-Z) and then Total Sales (Largest to Smallest). 

● Sort by custom sorting order with performance groupings (Good → Average → Poor). 

Steps for Multi-Level Sorting: 

Select the dataset. 

Click on Data → Sort. 

Put Region as level 1 to sort in order (A-Z). 

Create another level and sort your data by Total Sales (L to S). 

Click OK. 

Sorted Data: 

 

 

Fig 5.39 Multi-Level Sorting 

 

Insights: 

● Kiran who is the best performer of North area. 

● Rohan tops the charts in the South. 

Conclusion & Business Decisions 

Insights from Data Analysis: 

●   The condition functions well to classify sales performance. 

●   Filtering and sorting made it simple to see top performers. 

● Enhanced sorting displayed performance by regions. 

Actionable Business Strategies: 

●  Give bonuses (to Rohan and Kiran) to high performers. 

●   Train the weak performer (Aditi, Arjun and Neha). 

●   Assign high value sales territories to top performers. 
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Unit 6: Lookup Functions 

 

Learning Outcomes 

● Learners will be able to apply VLOOKUP and HLOOKUP functions to retrieve data 
eƯiciently from structured tables. 

● Learners will understand and implement helper columns to enhance lookup 
functionality and improve data retrieval accuracy. 

● Learners will apply INDEX and MATCH functions to perform dynamic and flexible 
lookups beyond the limitations of VLOOKUP and HLOOKUP. 

● Learners will analyze and solve real-world data lookup challenges using 
advanced Excel functions. 

 

 

Content 

6.0  Introductory Caselet 

6.1  Understanding VLOOKUP and HLOOKUP Functions 

6.2  Advanced Lookup with Helper Columns 

6.3  Introduction to Index and Match Functions for Flexible Lookups 

6.4  Summary 

6.5  Key Terms 

6.6  Descriptive Questions 

6.7  References 

6.8  Case Study 
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6.0 Introductory Caselet 

"Maximizing Inventory Control with Excel Lookup Functions 

Amit is a supply chain manager for a retail company. His task: to make sure the 
company’s stores are well-stocked, but not overflowing with excess inventory. His team 
deals with massive data sets, such as product IDs, supplier information, inventory 
levels, sales history. But it does take some time to retrieve the correct information. 

One day, his boss asks him to compare the stock levels and vendor information for 
thousands of products. For him, manual search is a waste of time and error-prone. He 
wants to be able to pull in data automatically from somewhere useful - such as pulling 
product information from a master stock sheet, or looking at stock levels across several 
store locations. 

Amit is familiar with VLOOKUP and HLOOKUP functions in Excel but he is struggling to 
use them eƯectively. He also finds out that those advanced methods (getting things 
done, use of helper columns and using INDEX + MATCH) provide a much more dynamic 
way of performing search functions. Intent on saving time in managing current stock, 
Amit decides to find out about these wonderful Excel features. 

Critical Thinking Question 

How does Amit use VLOOKUP, HLOOKUP, INDEX, MATCH to analyze the inventory data 
so that he can ensure there is never too much or too little stock in any of his stores? 

6.1 Understanding VLOOKUP and HLOOKUP Functions 

The concept of looking for certain information rapidly from large data sets is crucial in 
data Analysis Company. The lookup functions in Excel is an eƯicient tool which helps us 
to look for specific data against a huge amount of data through queries that match the 
optimum exact criteria. VLOOKUP and HLOOKUP are probably the most frequently 
used lookup functions. 

22
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Fig 6.1 Vertical Lookup (VLOOKUP) and Horizontal Lookup (HLOOKUP) 

VLOOKUP is a feature that allows users to search vertically through the first column of a 
selected range, and return data from any other column in the same row. Columns of 
VLOOKUP-friendly data are datasets that can be quickly worked on with employee 
rosters, financial reports, and product lists! INDEX and MATCH can do what VLOOKUP 
cannot, which is to look up the value on the left. HLOOKUP (or Horizontal Lookup) 
enables users to search for a value in the first row of a given range and returns data 
from another row on the same column. Because of the data horizontal arrangement, 
this function would be handy in grabbing time based performance figures and lists from 
pricing tables. 

These are the features adding value to eƯiciency by facilitating search, lessening 
manual eƯort and human errors. As powerful as INDEX-MATCH and XLOOKUP are, 
they still necessitate data to be arranged in the right way. It's vital to understand when 
and how to use them properly in managing data and making decisions. 

Explanation of VLOOKUP and HLOOKUP Function in Excel 

The above VLOOKUP and HLOOKUP Excel functions have been illustrated to make it 
easier for you, along with Olympic medal statistics by countries. 

Key Features in the Image: 

Dataset Structure: 

●  Column A has names of countries. 

● The picture representation below shows the distribution of Olympic medals A, B,C 
and D indicate columns full of medal numbers for G Gold, S Silver and B Bronze in each 
country. 

HLOOKUP Example: 

12
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Fig 6.2 Understanding VLOOKUP and HLOOKUP in Excel 

 

● The formula =HLOOKUP(A2, A2:D6, 3, FALSE) looks up the country in cell A2 (US) 
from the table A2:D6. 

●   The formula references the silver medal row in the third position for this country. 

VLOOKUP Example: 

● The functions VLOOKUP(A4, A2:D6, 3, FALSE) find the name “Japan” (the value in A4) 
within column A and then returns its Silver medal count from the third column (C). 

● The number that comes out of this sum shows the second-placing Japan to be in 
possession of 14 Silver medals. 

Concepts Illustrated: 

● Column G is strictly for demonstration purpose, you can replace the formula with 
either VLOOKUP or INDEX function which outputs the same result. ● VLOOKUP looks 
up an input value in first column and returns matching data from specified column. 

●   HLOOKUP searches horizontally down the first row of a table and then returns a 
value in the same column from a specified row. 

● The technology is available to allow users to eƯiciently manage the data collection 
and retrieval. 

Example 2: 

11
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Fig 6.3 VLOOKUP and HLOOKUP 

Fig 6.3 provides an example of vertical and horizontal look up, when VLOOKUP and 
HLOOKUP are put to use, respectively using planetary diameters as the sample data 
set. The formula in cell C7 is =VLOOKUP(B7 $A$2:$B$5, 2, FALSE). What the VLOOKUP 

is doing is searching down column A for its lookup value. The right side of the worksheet 
demonstrates using HLOOKUP to pull data from a table that holds Planetary names in 
row 1 and their corresponding diameters across row 2. The formula: =HLOOKUP(B5, 
B1:E2, 2, FALSE) begins by looking for "Mars" in row 1, and then retrieves its diameter 
from row 2. Both functions are necessary for structured dataset data retrieval since 
HLOOKUP allows row searches (as opposed to column searches) mentioned earlier. 

6.1.1 VLOOKUP Function 

The V in the VLOOKUP stands for vertical, which means it looks up data vertically (i.e., 
from top to bottom) in a table and retrieves the corresponding value. It follows a vertical 
orientation. 

Syntax: 

VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup]) 

lookup_value: The value to search for in the first column of the table. 

●   table_array: The range that houses the values which needs to be looked up along 
with the column in which we will find our return value. 

● col_index_num: The column number of the value to return within the table_array. 

● range_lookup: (Facoltativo) TRUE value is for an approximate match; FALSE value is 
for an exact match. 

6.1.2 How VLOOKUP Works 

3
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VLOOKUP searches the table array rows from the first column to any column in 
table_array. The function looks up value in the first column rows and returns a value 
from another col_index_num. 

Example: Employee Data Lookup 

The data in this set contains information on employees - there are three columns for 
consideration: 

 

Fig 6.4 Employee Data 

 

The department of Employee ID 1005 can be located as follows: 

=VLOOKUP(1005, A2:C10, 3, FALSE) 

 

Fig 6.5 Steps to find the department of Employee ID 1005 

Breaking Down the Formula 

20
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● The required field ‘Employee ID’ is parametrized through the formula (1005). 

●   In the table range A2:C10 the function looks for the Employee ID that we have stated 
is 1005. 

● The formula is asking for the value in the Department column, position 3, out of table 
range A2:C10. 

● In order to achieve an exact match only in the search result function is FALSE. 

Result Interpretation 

● The function searches Column A for the 1005 entry by ranging through its values. 

●  It finds 1005 in row 6. 

● Function continues to the third column of row 6 and returns the Sales value to the 
user. 

6.1.3 Real-World Applications of VLOOKUP 

The function VLOOKUP serves many entities in obtaining specific values from large 

collections of data. In other professional domains, VLOOKUP is often performed 
manually: 

Employee Database Management (HR Department) 

Another HR person must be able to query from their system using employee 
information. 

Application: 

The HR manager can use VLOOKUP to search an Access record by providing Employee 
ID detail to find out employee’s name and department, earning and joining date from 
the master table. 

Example Formula: 

=VLOOKUP(A2, EmployeeData! A:E, 2, FALSE) 

The VLOOKUP function is used for processing payroll as well as performance reviews 
and tracking employees. 

Product Price Lookup in Retail 

Supermarket cashier registers system is one application that restricts within the 
supermarket, in which the description of a product is using VLOOKUP command in 
order to access the price information on a database. 

Application: 
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Once the user enters the product code, VLOOKUP gets them their price and discount 
automatically. 

Example Formula: 

=VLOOKUP(B2, PriceList! A:C, 3, FALSE) 

The macros evolved, fast and eƯicient in calculating the proper bill amounts with little 
fuss. 

COM (E-commerce & Logistics) 

The call center agent needs Order ID to look at the status in the system. 

Application: 

Your rep sends your ID to VLOOKUP, and gets back shipping & delivery info like date of 
delivery, courier etc. 

Example Formula: 

=VLOOKUP(D2, OrderData! A:F, 4, FALSE) 

User support becomes manageable, albeit still assisted and facilitated. 

Student Grade Calculation (Education Sector) 

The admin of the college would like to retrieve a student grade based on their Roll 
Number. 

Application: 

ProcessM Your Roll Number You can enter your roll number and Excel will fetch from 
database and you can determine the Grade. 

Example Formula: 

=VLOOKUP(A2, Grades! A:D, 3, FALSE) 

By this way, automatically generation can be available for preparing report card. 

Inventory Management (Manufacturing & Warehousing) 

The manager of warehouse wants to observe the quantity of product is available 
currently in store. 

Application: 

The quantity count, reorder point and Supplier ID follow the entry of Product ID: 
VLOOKUP is used to bring product inventory details including the Quantity Count, 
Reorder Point and Supplier based on the Product ID. 
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Example Formula: 

=VLOOKUP(A5, Inventory! A:E, 4, FALSE) 

The formula avoid under-stocking and over stocking. 

Financial Reporting and Budget Tracking modules are used by the Finance Department 
to monitor financial expenditure. 

A finance manager would like to get actual department expenses by using the 
department codes as a filter. 

Application: 

There was no diƯerence between the two if found using department code entry where 
both allocation and spending activities could be viewed. 

Example Formula: 

=VLOOKUP(A2, Budget! A:D, 3, FALSE) 

The calculation allows companies to realize its financial planning, in addition it helps 

you to verify cost or budget. 

Procurement Department (Supplier & Vendor Management) 

The purchasing oƯicer attempts to retrieve supplier information by entering the Supplier 
ID. 

Application: 

Suppliers contact details, email address and last transaction will show by entering 

Supplier ID. 

Example Formula: 

=VLOOKUP(B3, Suppliers! A:D, 2, FALSE) 

The system improves supplier interchange and order visibility. 

The VLOOKUP function serves as one of the main organ functions for corporations by 
automatically locating data to increase productivity and minimize errors across various 
industries. It has a tool that allows HR, retail, finance and other companies to easily 
manage their data for eƯicient decision making and planning. 

6.1.4 Handling Errors in VLOOKUP 

●  The lookup_value is not found in the first table column, and you get a #N/A error as 
the return. 

1
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● The result shows #REF! error as the column index you have given is greater than 
available columns. 

● range_lookup If TRUE or omitted, VLOOKUP will find the closest match from a row 
before returning the lower value. 

6.1.5 VLOOKUP Best Practices Keep column numbers and field names consistent on 
both answer sheet and data You must make sure that your question slug of “latitude” or 
whatever else you’re looking for, uses the same column number/name that we use in 
class! 

Use FALSE for Exact Matches 

Argument range_lookup should always be set to FALSE which requires an exact match. 
This is probably not what you want (though if it were, you'd use FALSE or an empty 
value for this argument), as the first column must still be sorted to retrieve anything 
useful. 

Example: 

The price list has a "Laptop", for which I need the prices. 

=VLOOKUP("Laptop", A2:C10, 2, FALSE) 

Here we have used the "Laptop" as search term and it searches in column A till it gets 
the price tag of laptop which is in the column B. 

By specifying the FALSE value in this formula, we make sure that Excel returns only 
precisely matching lookup results with the help of the VLOOKUP function. 

 

Did You Know? 

 

VLOOKUP For Range-Based Searches Can Use Approximate Matches: When you 
specify TRUE as the range lookup, VLOOKUP will bring back the closest match that is 
less than or equal to the lookup value – this can be very useful when in grading systems, 
tax brackets and commission structures because sometimes there are no exact 
matches. 

 

If the data set is large then sort the first database column in ascending order. 

 

When using approximate match with TRUE as 4th parameter, you can speed up the 
process by first sorting column1 in ascending order. 

4
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Example: 

 

A grade look-up table is a set of scores which are used to determine particular letter 
grades when the table is indexed by rank. 

 

Fig 6.6 Score Board 

The formula finds what the grade is for scoring 75. 

 

=VLOOKUP(75, A2:B6, 2, TRUE) 

 

The function works in a didactic environment, where the lowest-to-highest scores are 
listed down Column A. 

 

The VLOOKUP formula gives “C” because 75 is between 70 and 80. 

 

Use Absolute References to avoid errors. 

 

While you copy formulas, make use of absolute cell references ($A$2:$C$10) so that 
the lookup range remains constant and errors in reference displacement are avoided. 
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Example: 

 

=VLOOKUP(A2, $A$2:$C$10, 2, FALSE) 

 

The formula pulls down through cells, however notice I lock the lookup range 
($A$2:$C$10) so it will not change. 

 

When you need the extreme flexibility - go with INDEX and MATCH functions 

 

LOOKUP functions are more flexible than VLOOKUP, in that the first lookup column 
comes at some point but not within the 1st position. 

 

Example: 

 

When you have the price of a product stored in column B but at the same time the 
name of that product in column A =VLOOKUP will not work. Instead, use: 

 

=INDEX(C2:C10, MATCH("Laptop", B2:B10, 0)) 

 

● The MATCH function finds “Laptop” in B2:B10 with a 0 last argument. 

 

MATCH("Laptop",$B$2:$B$10,0) ●   MATCH will return the row number of where 
“Laptop” is in B2:B10. The INDEX function returns the matching value from C2:C10. 

 

Why use INDEX and MATCH? 

 

● Accessibility:other, VLOOKUP only works on the first column ¶ The INDEX-MATCH 
method can do lookups on any column According to INDEX. 
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●   The method is computational eƯicient within the data set. 

 

● The way is robust against errors in adding or removing columns. 

 

6.1.6 Understanding HLOOKUP Function in Excel 

 

HLOOKUP Looks for a value in the top row of a table or an array of values and then 
returns a value in the same column from a row you specify. The HLOOKUP function 
helps organize tables and to find a specific value from the first-row categories through 
comparison with other rows. 

 

Syntax of HLOOKUP: 

 

=HLOOKUP(lookup_value, table_array, row_index_num, [range_lookup]) 

 

● Search for lookup_value in the first column of table_array. 

 

●   The table_array parameter for specifying the range of data to search is requesite for 
the function. 

 

● The row_index_num argument indicates from which row of table_array youd like to 
return a value. 

 

● range_lookup – (exclusivo) VERDADERO para una coincidencia aproximada, FALSO 
para una coincidencia exacta. 

 

6.1.7: XLOOKUP 

 

2

5
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XLOOKUP is a brand new, top-of-the-line lookup function in Excel that you can use to 
look up a value in one column and return the matching value from another column. It is 
more dynamic as compared to VLOOKUP and HLOOKUP. 

Syntax: 

 

=XLOOKUP(lookup_value, lookup_array, return_array, [if_not_found], [match_mode], 
[search_mode]) 

 

· lookup_value → The value to find. 

lookup_array – The range in which Excel will find the lookup value. 

·   return_array – The array or range from which you want to return the result. 

· [if_not_found] (optional) → Custom message if value is not found / does not exist. 

· [match_mode] (optional) → If it should match the entire list item or the first letter. 

·   [search_mode] (opcional) → Sentido de búsqueda (de primero solo para el comience 
o último a primero). 

 

Example 1: Basic XLOOKUP 

 

 

EXAMPLE: Get salesperson region. 

Formula: 

=XLOOKUP("Rohan", A2:A4, B2:B4) 

 

Result: 

South 

Knowledge Check 1 

7

9

18
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Choose the correct option: 

What is the Excel function that looks up a value in the first column of a range and 
returns another value? 

a) HLOOKUP 

b) VLOOKUP 

c) MATCH 

Why is VLOOKUP limited? 

a) It cannot look up values in the leftmost column of a range. 

b) It only supports numeric values. 

c) It works with rows of data 

What is the ideal look up formula for looking values across a horizontal table? 

a) VLOOKUP 

b) INDEX 

c) HLOOKUP 

6.1.7 Real-World Applications of HLOOKUP 

Student Score Lookup (Education Sector) 

A teacher wants to recover the student's score information in his/her mark sheet that 
has been arranged horizontally. 

Application: 

The first row of the table corresponds to data subjects and mark scores are located 
under that. 

HLOOKUP looks for the topic in first row and then retrieves student marks from one of 
the rows. 

Formula Example: 

=HLOOKUP("Math", A1:E5, 3, FALSE) 

The advantage of the usage of HLOOKUP is the possibility to get fast students marks in 
an automatic way without looking for them manually. 

Price List (Retail & E-commerce) 

A sales representative wants to find the price level of certain product types over various 
sales areas. 
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Application: 

The first line also shows product categories (Electronics Furniture Clothing) etc. 

The app stores pricing data for multiple iterating regions in individual rows. 

Formula Example: 

=HLOOKUP("Electronics", A1:D4, 2, FALSE) 

The technology aƯords people an easier way to compare prices from a given source at 
the same time. 

Budget Lead Monitoring (Finance and Accounting) 

The finance department needs to have an overview of the distribution for Q1-Q4 in 
budget. 

Application: 

● The first line is the header and refers to fiscal qtrs (Q1, Q2, Q3 and Q4). 

●   The departmental budget are listed in subsequent rows below this first one. 

Formula Example: 

=HLOOKUP("Q2", A1:E5, 3, FALSE) 

Using HLOOKUP, subscribers can eƯiciently track financial data for completing 
quarterly reports. 

The employee Shift Schedule ( HR & Operations ) 

The manager wants to see the employees' shift times one day. 

Application: 

● The first row displays the seven days of the week. 

 A list for employees shift work below each other. 

Formula Example: 

=HLOOKUP("Wednesday", A1:G5, 4, FALSE) 

You can apply HLOOKUP Excel function to keep employees schedules together with 

their attendance. 

Meteorology Research HLOOKUP for weather data analysis. 

The meteorologist wants to analyze temperature temperatures of a specific city in their 
weekly report. 
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Application: 

Football Crazy Instructions: ●   All football crazy city names are in the first row of cells. 

● Each week's temperature values are printed beneath the one before it in the same 
column of the sheet. 

Formula Example: 

=HLOOKUP("New York", A1:G5, 3, FALSE) 

HLOOKUP advantages users with over-speed weather conditions from many cities. 

Limitations of HLOOKUP 

● The lookups done via HLOOKUP are still not as flexible as INDEX-MATCH or XLOOKUP 
when doing a combination of searching columns and rows. 

● The lookup value must be in the first row of the dataset data that has been made 
available. 

● The vertical lookup feature is not there in HLOOKUP. 

Data recovery from a table layed out horizontally can be handled by the HLOOKUP 
function. It's useful in operations reports and schedules, financial tracking and product 
pricing in a variety of businesses. For complex datasets, users may want to explore 
other lookup functions over INDEX-MATCH or XLOOKUP because they provide greater 
flexibility. 

Activity: Excel Student Attendance Analysis 

You’re going to learn how to analyse and graph our student attendance data so we can 
find trends and interesting insights using Excel. 

Instructions: 

Select a Dataset: Use a sample dataset provided (or create your own) including fields 
for student’s name, date, attendance status (Present/Absent), class section. 

Organize the Data in Excel 

·   Input the information in some Excel workbook. 

· Use sorting and filtering to order attendance chronologically (by sin asin adate, 
student or section). 

Perform Data Analysis 

· Use COUNTIF functions to determine the number of days and numbers absent for 
each student. 

2
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· Calculate the class average percent attendance and the same for each section. 

Visualize the Data 

·   Bar chart showing attendance rates in diƯerent sections. 

· Use a line graph to plot daily trends across one week, or month. 

·   Create a pie chart to show the proportion of all students present and absent. 

Use Conditional Formatting 

·  Show students whose total attendance is less than or equal to 75% in red. 

·   Bold the students who had an attendance of 100% (no absences). 

Make Data-Driven Observations 

Respond to the following in light of your analysis: 

Which division has most and least attendance? 

Are there days with less visitors? 

What methods will improve attendance in underperforming sections? 

6.2 Advanced Lookup with a Helper Columns 

In some cases, you cannot work eƯectively with the VLOOKUP(HLOOKUP because they 
are limited to searching along right columns and they will only return values from left 
hand sides. The second Helper Column is a response to lookups limitations, returning 
lookup features. 

 

6.2.1 Why Use Helper Columns? 

Helper columns are used when: 

● The lookup column is in a position beyond the first position of the data. 

● In order to uniquely identify the data, all of the fields need to be collapsed into one. 

● You cannot use VLOOKUP to return values from a column to the left, and INDEX and 
MATCH can accomplish this task which should be mentioned.. 

● A distinct identifier is needed as there are duplicate elements in the data. 

Example 1: Helper Column for Reverse Lookup 

VLOOKUP will only look in the first column and dimensions to the right of your look up 
range are, however VLOOKUP will only return values that are on the right. When values 
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are being returned from that column then it's necessary to look at the left hand side of 
the lookup range. 

 

 

Fig 6.7 Product details 

Solution with a Helper Column 

As VLOOKUP only searches the first column, I add a helper column where i move the 
Company column to be in the first position. 

 

Fig 6.8 Solution with a Helper Column 

Now, we use: 

=VLOOKUP("HP", A2:C6, 2, FALSE) 

This gives you 3 which is HP id. 

 

Example 2: Concatenating for a Unique Lookup Someone asked me to provide an 
example where we would concatenate instead of merge. 
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Fig 6.9 Employee Details 

Don't use extra columns to make calculations when dealing with big data, it does add 
time to the file size and processing. 

Solution with a Helper Column 

Add a new column Helper (Name & Department) In the above response, I picked up 
Name and department both. 

 

Fig 6.10 Solution with Helper Column 

To search for Charlie’s IT salary, type: 

=VLOOKUP("CharlieIT", A2:E5, 5, FALSE) 

This returns 7000. 

Best Practices for Helper Columns 

●   In case an auxiliary columns make things hard to read you can hide them. 

• You probably want to use concatenation (&) or the TEXTJOIN function to create 
unique IDs. 

● Use supplementary columns sparingly for large datasets as they contribute to file size 
and processing time. 

Did You Know? 
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· Lookup eƯiciency can be 30% faster than array formulas or complex nested functions 
if you use a helper column. 

· For data sets with 10K+ rows, a helper column is typically two or three times faster 
than an array-based formula. 

 

6.3 Introduction to INDEX and MATCH Functions for Flexible Lookups 

Data lookup and retrieval in Excel Data lookup and retrieval is required commonly, so 
there should be some ways to get the same job done eƯectively. VLOOKUP and 
HLOOKUP are powerhouse functions, however, they both have some limitations when it 
comes to searching data in left columns. For Excel users, INDEX and MATCH functions 
are by far the best solution that will allow you to work with larger spreadsheets and give 
you more flexibility in your lookups. 

Example: INDEX 

 

Fig 6.11 Example for INDEX Function 

The INDEX function pulls a value from a range at the specified location you entered in 
the provided Excel sheet. The formula =INDEX(B2:D8,4,2) means: 

●   Search in range B2:D8. 

● Check only the 4th row (centering in range). 

●   Choose the second column (in relation to your range) 

● We can see on the table that the 4th row and 2nd column value (Height of “Thanish”) 
is 5.8, so F3 shows it correctly. 

Example: MATCH FUNCTION 

1
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Fig 6.12 Example for MATCH Function 

Did You Know? 

INDEX-MATCH is Faster, and More Powerful than VLOOKUP for Large Datasets: 

Unlike VLOOKUP that searches the whole table, INDEX-MATCH can search values i a 
crosswise manner which results in better performance and takes into account 
situations when new columns are added or existing ones get removed. This is the 
reason it is the most popular tool for financial analysis 

In this Excel sheet, MATCH function is utilized to return the position of specified value 
in a column. The formula =MATCH("Rachel Green",C:C,0) looks for the name "Rachel 
Green" in column C (Employee Name) and returns the row where it is located. 

● The argument to the left ‘Rachel Green’ is look_up value. 

●   The second argument C:C is identifying the column to lookup. 

● About Argument3: It's the argument zero = exact match. 

●   The function therefore returns 15, meaning that “Rachel Green” is found at row 15 of 
column C. 

6.3.1 Understanding INDEX and MATCH 

Combined, the INDEX/MATCH functions are safer and more eƯicient than VLOOKUP. 

4
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INDEX Function 

An array provided as an argument to INDEX function represents a value contained on 
such row and column intersection. 

Syntax: 

INDEX(array, row_num, [column_num]) 

●   array – The array to query. 

● row_num – El número de fila dentro del array. 

●   column_num – (opcional) Column number (2D array). 

Example: Consider the following table: 

 

Fig 6.13 Student’s Score 

 

If we use the formula: 

=INDEX(B2:C4, 2, 2) 

91 will be returned, row 2, column 1 (Bob’s score). 

MATCH Function 

You use the MATCH function to find out what position certain values occur in given a 
certain list (either along rows or down columns). 

Syntax: 

MATCH(lookup_value, lookup_array, [match_type]) 

● The function looks for the value lookup_value in range lookup_array. 

● lookup_array- The range in which to search. 

● Users can choose among three match types via the match_type variable: 1 close, 0 
exact and -1 close descending. 

This is what the MATCH function with Bob’s lookup value in a list will look like: 

2

3

6
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=MATCH("Bob", B2:B4, 0) 

This returns 2 as "Bob" appears in the second row of this lookup range. 

6.3.2 Using INDEX and MATCH Together 

Flexible VLOOKUP requires the INDEX and MATCH to be combined. 

The challenge is to bring back “Charlie” score of the table data. 

=INDEX(C2:C4, MATCH("Charlie", B2:B4, 0)) 

How it works: 

● By using the zero-based match look up, MATCH figures out that “Charlie” can be 
found at B3, and gives us back 3. 

●  INDEX is also a reference, the value of the third row in column C (which is 78) being 
returned. 

Why You Should Use INDEX and MATCH instead of VLOOKUP 

●  INDEX and MATCH instead of VLOOKUP can pull data from any column position, not 
just one expect in the formula like with a VLOOKUP which selects if your lookup value is 
left of that column. 

● If you need to work with huge worksheets, they both come in handy but if you want 
faster performance then INDEX & MATCH is the best. 

●   VLOOKUP has a fixed column index whereas INDEX and MATCH may allow flexible 
reference. 

INDEX and MATCH also provide an opportunity to use dynamic references, which are 
more suitable for structured tables than VLOOKUP. 

Excel users are encouraged to use a combination of INDEX and MATCH over VLOOKUP, 
as it is an extremely eƯicient and flexible lookup method. INDEX MATCH Together, 
these 2 functions are far more powerful than either one alone.Users who understand 
how INDEX and MATCH work together will be better equipped to manage eƯective and 

flexible lookups in the databases. 

Knowledge Check 2 

Fill in the Blanks: 

INDEX function gets a value from within specified range prefermenting to the row and 
column. In this formula =INDEX(B2:D8,4,2), the number 4 is referring to the selected 
__. (Column / Row) 

1
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The MATCH function is a tool to help locate the position of a specific value in a row, 
column, or table. In this =MATCH("Rachel Green",C:C,0), the value 0 is to make it __. 
(An approximate match   / An exact match) 

Unlike VLOOKUP, which forces you to reference data from left, INDEX MATCH in Excel 
is the combination of two functions that give users more flexibility and cover all the 
cases that may occur when you want to look up some value. ( Any column position / 
Only first column) 

6.4 Summary 

❖ VLOOK UP beautifully will search for a value in the first column of a table and return 
the value from any other column of this table! 

❖ HLOOKUP is for horizontal lookup, it does what VLOOKUP does but instead retrieves 
the value from first row and matches with the given value and produces corresponding 
values. 

❖ Both VLOOKUP and HLOOKUP can make exact matches (if the range lookup is set to 
FALSE); they can also do approximate matches, which useful for finding values that fall 
within a certain range of numbers. 

❖ The major drawback of VLOOKUP and HLOOKUP is that they both necessitate the 
lookup value to be in the first column/row of the data table, which is a limitation. 

❖ You can utilize a few helper columns to avoid cumbersome lookups and get improved 
perfomance by rearranging your data in a way that enables more complex, but 
streamlined lookups than possible with V / HLOOKUP alone. 

❖ Errors like #N/A, #REF!, and #VALUE! can happen in lookup formulas when you are 

looking up an item that's missing from the source data, such as a missing region or 
district code. 

❖ The INDEX function will return a value from within a table based on a specified row 
and column number, providing more flexibility than […] 

❖ MATCH function can return the position of a value in a row or column used to 
supplement INDEX for more powerful and flexible lookup functions. 

❖ INDEX and MATCH paired up is better than VLOOKUP/HLOOKUP as the latter only 
allows a lookup in one direction, won't accept column insertions without update of the 
formula and slows down significantly when you are working across big table arrays. 

❖ You can use these lookup functions as a computerized implementation of data 
tables to find the next largest and smallest distinct value quickly and easily. 

6.5 Key Terms 

4
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VLOOKUP Function: Searches for a value in the first column of a table and returns a 
value in the same row from another column that you specify, which can be handy when 
performing vertical lookups. 

HLOOKUP: Similar to VLOOKUP, but instead of looking up a value from the first column, 
it searches for the value in the first row and retrieves values from that specified row to 
help with horizontal lookups. 

Exact and Approximate Match: Both VLOOKUP, and HLOOKUP can lookup an exact 
match when range_lookup is set to FALSE as well as approximate match when it’s 
TRUE for finding a solution within ranges of numbers. 

Lookup Function Limitations: The VLOOKUP and HLOOKUP need the value to be 
located in the first row or column of the data table, so their uses are limited for data 
searching options. 

Helper Columns: Extra columns that we create to modify the structure of our data and 
allow us to perform really eƯicient, flexible lookups than the basic VLOOKUP and 
HLOOKUP. 

Lookup Errors: #N/A, #REF!, and #VALUE! happen because of loss of data, wrong 
column reference or/and bad range. 

INDEX Function: While coherence.good spreads the message in a big way to connect all 
humanity, coherence.better finds and amplifies already existing coherent thinking-
existing good ideas and ways of solving humanity's challenges. 

MATCH Function = Match allows you to find the position of a value in a row or column 
and use that input within an Index function for dynamic look up. 

INDEX-MATCH Mix Super power alternative to VLOOKUP & HLOOKUP where you can 
lookup any combination in any direction, handles inserted columns better and does 
well with huge data set. 

Real Life Uses Lookup functions are often used in financial modeling, inventory 
management data about employees or even customers database to facilitate 
information requests and reporting. 

6.6 Descriptive Questions 

What is the VLOOKUP function used for in Excel? What is the use of reducing data from 

such large files? 

What is the diƯerence between HLOOKUP and VLOOKUP? When would you use 
HLOOKUP over VLOOKUP? 

What are diƯerences between searching by exact match and approximate in VLOOKUP 
HLOOKUP? Give examples of situations where each would be applicable. 

1
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What are the normal mistakes made while working with VLOOKUP and HLOOKUP? 
Justify why these errors occur and how to solve them. 

How are lookup functions more eƯicient when they are used with helper columns? 
Give an instance where a lookup function is enhanced by adding a helper column. 

Explain INDEX function and its use in data retrieval in excel? How is it more flexible 
than VLOOKUP and HLOOKUP? 

For what is the MATCH function used in Excel? How would it be used in conjunction 
with INDEX to do a more complex lookup? 

"The combination of the INDEX and MATCH in comparison with to VLOOKUP. What are 
the benefits of INDEX-MATCH over VLOOKUP, and when should you use one rather than 
the other? 

Where do we use the lookup functions extensively in our real-life scenarios? Give at 
least two examples of each, and explain how the functions accomplish their goals in 
data management. 

How to utilize lookup functions in Financial Analysis & Reporting? Give an example of 
when you would use VLOOKUP, HLOOKUP or INDEX-MATCH to sort through data? 

6.7 References 

1. Microsoft Excel OƯicial Documentation –Microsoft Support: VLOOKUP Function 
andMicrosoft Support: HLOOKUP Function provide oƯicial guidelines and examples. 

2. ExcelJet – VLOOKUP Guide and INDEX-MATCH Tutorial oƯer step-by-step 
explanations, examples, and best practices. 

3. Chandoo.org – VLOOKUP vs. INDEX-MATCH explains the diƯerences and 
advantages of INDEX-MATCH over VLOOKUP. 

4. Ablebits Excel Blog – VLOOKUP, HLOOKUP, and INDEX-MATCH Explained 
provides practical examples and troubleshooting tips. 

5. YouTube Tutorials – Channels like ExcelIsFun, MyOnlineTrainingHub, and Leila 
Gharani have comprehensive video tutorials on lookup functions and advanced Excel 
techniques. 

6. Excel 2019 Bible by Michael Alexander, Richard Kusleika, and John Walkenbach 

7. Excel Formulas & Functions for Dummies by Ken Bluttman 

8. Microsoft Excel Data Analysis and Business Modeling by Wayne L. Winston 

Answers to Knowledge Check 

Knowledge Check 1 
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1: b) VLOOKUP 

2: a) it can't search for values from the leftmost column of a range 

3: c) HLOOKUP 

Knowledge Check 2 

1: b) 2: b) 3: a) 

 

6.8 Case Study 

Employee Databasse - How to create it use VLOOKUP and HLOOKUP? 

The employee DB of XYZ Corporation contains entries in format such as Employee ID 
along with Name and Department details, Salary information, Performance ratings etc. 
To retrieve some information from employees using the employee ID,current HR 
department team members must access the solution on a regular basis. 

Scenario: 

Priya, the HR manager, wants to develop an automated system for constantly getting 
input of employees data. She has two primary tasks: 

·  Attaching to employee id you can have Name, Department and Salary from the 
VLOOKUP formula. 

· In the performance rating table, there is service year data arranged in a horizontal 
format. She's using a HLOOKUP function to bring back the performance rating by 
Employee Id and Year of Service. 

Solution Implementation: 

VLOOKUP for Employee Details 

The HR staƯ uses a VLOOKUP to retrieve employee data from the database for cell 
reference A2. 

The Employee Name is retrieved by the VLOOKUP function as follows: 

=VLOOKUP(A2, EmployeeData! A:E,2,FALSE) # Get Employee Name 

=VLOOKUP(A2, EmployeeData! A:E, 3, FALSE) # Pull Department 

=VLOOKUP(A2, EmployeeData! A:E, 4, FALSE) # Fetch Salary 

This will pull back the department information when you put A2 into Employee ID from 
EmployeeData! A:Eand passing False as the argument. 
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·   VLOOKUP retrieves the Salary value from position 4 of the EmployeeData sheet by 
using A2 as its lookup key and FALSE as its match type. 

· EmployeeData! A:E contains the employee data table in which the user clicks on a 
field position with various column indexes relative to the range. 

· The chosen field position is synchronized with A2, that corresponds to the identifier of 
the employee. 

HLOOKUP for Performance Rating 

The HR have to use the Vlookup function as their performance rating data are in 
separate columns for every year. 

=HLOOKUP(B2, PerformanceRatings! A1:G5, MATCH(A2, PerformanceRatings! A:A, 0), 
FALSE) 

In B2 Year of Service, the function is dimensioned by year (row headers). 

Outcome: 

· HR is able to bring up employee data and performance ratings through a quick search 

that minimizes their search time. 

· Filed solution assists in better decision making in work appraisaland promotion 
assessment of an organization. 

Case Study 2: Analysis of Sales Report with Advanced Lookups Using Helper Columns, 
Index and Match 

Background: 

· Processing point-of-sale data from retail accounts at ABC Retail Retail’s PoS (Point of 
Sales) system records transaction information in diƯerent locations. The sales 
department needs an automated data-retrieval system including the following: 

· Cumulative sales of a product in a region. 

· That makes the salesperson responsible for that product in that territory. 

Scenario: 

Sales manager Rohan has a lot to deal with at work. The data is contained within a few 
document pages. You have multiple records for each product in the sales database 
since it is sold by diƯerent reps. 

By adding helper columns, along with INDEX-MATCH, Rohan has more versatile search 
capabilities. 
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SOLUTION: It is time to use the result in Cell B3. Create a subset of unique IDs as 
follows… Creates the following table. 

Rohan adds a column in the spreadsheet which brings together Product Name and 
Region and create an individual value. 

There are two new columns (Product & Region) added by Rohan in the sales database 
as follows: 

=A2 & "-" & B2 

Product Name and Region together are an unique lookup key. 

Dynamic sales lookup with INDEX-MATCH 

Rohan uses INDEX-MATCH as his go-to way for getting results of what he's looking up. 

INDEX-MATCH instead of VLOOKUP In INDEX-MATCH, users prefer to use INDEX-
MATCH functions instead of VLOOKUP as it gives more freedom to lookups. 

=INDEX(SalesData! C:C, MATCH(E2 & "-" & F2, SalesData! D:D, 0)) 

· The name of the product is in E2 and region value is F2 but helper column is D:D. 

· The combination returns the total sale amount for that product and region. 

Finding the Sales Representative 

Furthermore, the process involves determining which agent sold the highest number of 
units for the selected product. 

=INDEX(SalesData! B:B, MATCH(MAX(SalesData! C:C), SalesData! C:C, 0)) 

The formula provides the name of sales representative who has a maximum sale. 

Outcome: 

· Sales data about any product and region can be accessed at once by the team 
members. 

· Index match functions and helper columns oƯer workaround to the VLOOKUP issues. 

·   The information error of system can be reduced and retrieval speed of the data 
record is improved. 

Conclusion 

The examples analyzed above show the practical application of VLOOKUP, HLOOKUP 
and helper columns in combination with INDEX-MATCH on diƯerent business model 
scenarios. The first module is employment management and the second module sales 
observation, which means you will strongly acquired practical oƯice Excel knowledge. 
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Reflective Questions 

Why is relying VLOOKUP better as compared to other conventional ways of doing 
glance up for an employee? 

What Disadvantages do VLOOKUP and HLOOKUP have? How will HR be aƯected by 

this? 

For a company database system, when would you prefer to use HLOOKUP rather than 
VLOOKUP? 

If the employee database is expanded to include diƯerent departments in diƯerent 
locations, what will be the issue with VLOOKUP and HLOOKUP? 

What would happen if the lookup value does not exist in the employee database? How 
do I handle missing data? 

Why was a helper column used in this example and how it improves the lookup 
process? 

What are the advantages of INDEX-MATCH over VLOOKUP especially with big data? 

How does the use of dynamic lookups in Excel help a sales manager make better 
decisions? 

What would be some suggestions to adapt the current lookup formulas, if a new sales 
report format is distributed? 

What other excel formula would you use in combination with INDEX-MATCH to further 
improve the sales analysis? 
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Unit 7: Data Visualization 

 

Learning Outcomes 

1. Learners will be able to create and analyze PivotTables and PivotCharts to 
summarize and visualize data eƯectively. 

2. Learners will be able to build calculated fields and items in PivotTables to 
perform custom calculations for deeper insights. 

3. Learners will be able to use slicers and dashboards to filter data dynamically and 
derive meaningful business insights. 

4. Learners will be able to apply data visualization techniques to enhance data-
driven decision-making. 

 

Content 

7.0 Introductory Caselet 

7.1 Introduction to PivotTables and PivotCharts 

7.2 Creating and Analyzing PivotTables and PivotCharts 

7.3 Building Calculated Items and Fields in PivotTables 

7.4 Using Slicers and Dashboards to Derive Insights 

7.5 Summary 

7.6 Key Terms 

7.7 Descriptive Questions 

7.8 References 

7.9 Case Study 
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7.0 Introductory Caselet 

"Raw Data into a Goldmine for Leaders and Managers" 

Pivot Tables and Pivot Charts: The Muscle behind Them 

Amit is a sales analyst in a growing FMCG company. He was required to produce a 
monthly performance summary across diƯerent product types in several areas. His 
boss wants to understand which products are selling best, revenue trends and what 
sales are down in certain areas. 

Amit can see vast amounts of sales data stored in Excel databases. But he struggles to 
generate useful insights and do so in a timely manner. To do that manually in 
thousands of rows would take him forever, and if he were to use simple formulas, they 
won’t give him the type of analysis he needs. 

During a team meeting, his senior tells him that he should be working with PivotTables 
and PivotCharts — two powerful Excel tools that help users digest big data sets. Amit is 
curious but not necessarily sure where to begin. 

How will he archive his sales data in excel using Pivottables? What type of PivotCharts 

are best for displaying sales trends? When it comes to your manager, how can he rely 
on data to make suggestions? 

Keen on become more analytical, Amit goes on a learning journey to discover 
PivotTables and PivotCharts so he can uncover hidden trends in his data making better 
business decisions. 

Critical Thinking Question 

Amit wants to assess the sales performance per region and product category for his 
company’s sales strategy. Then, how can Amit use PivotTables/PivotCharts? 

7.1 Introduction to PivotTables and PivotCharts 

Business environment provides lots of data concerning sales, finance, customer 
reactions and operations that organizations currently are dealing with. It is essential to 
perform the processing of data eƯectively when we are making a proper decision. 
PivotTables and PivotCharts in MS Excel are the sorcery elements, which allow power 
users (i.e., experts on data) to summarize it, chart it and then extract smart information 
out of large sets of data, something that is absolutely necessary for making decisions 
based on big corpuses of data. 
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Fig 7.1 Pivot Table 

 

PivotTables that help you organize and summarize your data and PivotCharts to provide 
a visual representation of your data make finding comparisons, patterns and trens more 
eƯicient. Together they allow an enterprise to make informed decisions based on 
enlightening information. 

A pivot table can help quickly summarize and analyze large data sets. It makes 
grouping, filtering and calculation easier without real dataset modification. 

The Key Components of PivotTables: 

●Summarizes the data into multiple dimensions. 

● Supports drag and drop to rearrange the fields. 

●Calculate percentage, count, average and sum. 

● Supports filtering and sorting to facilitate data insight. 

 

A PivotChart is a chart that's based on shape, but can be interacted with and refreshed 
from the original data specifically in a PivotTable. It allows people to see big data 
through the lens of trends, patterns and comparisons which are much easier to process 
and understand in an eƯective way. PivotCharts automatically refresh when the 
associated PivotTable is modified so that you can discover new insights in seconds. 
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Fig 7.2 Pivot Chart 

 

A PivotChart is a visual representation of data from the PivotTable that makes it easier 
to see patterns and trends in your data. 

PivotCharts are also interactive, so they immediately respond to changes in the 
underlying PivotTable. 

Key characteristics of pivot charts 

● Gives simple to interpret visualizations of the data. 

● OƯers diƯerent types of charts such as bar, line and pie charts. 

● Allows sorting and filtering for enhanced data exploration. 

●   Drives expert presentations and reports. 

Why Use PivotTables and PivotCharts? 

Businesses rely on PivotTables and PivotCharts for: 

● Distill large datasets eƯectively. 

● Identify business trends and patterns. 

● Bring data to help drive decisions. 

●  Enhance presentations and reports with user-friendly visualizations. 

2
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Real-World Applications 

Economics – A Research On How To Control The Expenses Of Manufacturing 
Organizations 

Scenario: A textile manufacturing company in Surat wants to perform monthly expenses 

analysis for diƯerent department. 

● Pivot Table provides assistance in classification of spend (RM, Labour, power etc) 
and cost comparisons MoM. 

● A PivotChart helps present cost trends in graphical form, which allow top 
management to see where costs can be reduced. 

● A garment exporter from the Tiruppur region uses Pivot Table to track production 
costs and rationalise pricing policies. 

L.Winter (2014), A Report on Sales Performance Analysis of Indian Retail Business. 

Scenario: A supermarket chain DMart/Reliance Retail wants to compare sales across 
regions and product categories. 

● A PivotTable shows sales by product, site and time. 

● A Piv otChart shows the high-demand regions in a graphical form. 

Example: A Bengaluru-based grocery store uses PivotTables to see what the best-
selling products are during festival season and replenish stock. 

A Case of Customer Data Analysis: Ecommerce Business 

Example: An ecommerce website, say Flipkart/Myntra intends to research on user 
preference. 
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Fig 7.3 Applications of Pivot Table 

● Use PivotTable to classify customers by their region, sales record and spending 
behavior. 

● A PivotChart displays a pie chart to show the percentage of sales by diƯerent 
customer types. 

Illustration: A Mumbai-based online electronics company uses PivotTables to analyse 
trends in smartphone sales and introduce focussed discount oƯers. 

HR and Employee Data Management – AStandout IT company in India 

Use Case : A Hyderabad IT company wants to supervise the performance, salary 
allotment of employees. 

● PivotTable is used to classify employees according to experience grade, skills and 
performance ratings. 

● A PivotChart visually displays how salaries are allocated across departments. 

Example: PivotTables are used in a software company at Pune to identify the high 
performing employees who should be promoted. 

Exercise: Visualizing sales analysis reports with PivotTables and PivotCharts 

Goal: Learn how to use PivotTables and PivotCharts in Excel to analyze data for 
business reporting. 

Instructions: 
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Choose a Dataset: 

Take a sample data (or create your own) including below columns: 

· Date 

· Product Name 

·   Section (Electronics, Clothing etc.) 

· Sector (North, South, East and the West) 

· Sales Amount (₹) 

· Quantity Sold 

Prepare Data in Excel: 

·   Load the dataset into Excel. 

· Table the data (Ctrl + T shortcut). 

·  Have properly named headers (like “Product”, “Region” and “Sales Amount”). 

Create a PivotTable: 

·   Go to the Insert tab → PivotTable → New Worksheet. 

· Drag and drop fields: 

·   Columns: Product or Region (It will be in one of the column). 

·   Values: Amount (use SUM) 

·   Columns: Category (whtit) 

Add a PivotChart: 

· Select the column of related values (including the question number) and click Insert → 
Charts → Column Chart (or a diƯerent chart type). &_ENTER##_ With the PivotTable 
selected, go to Insert > Charts > Column Chart/.. 

· Change the title of the chart and add data labels. 

Analyze the Data: 

·   Filter and sort to identify your best-selling regions or products. 

· Date cluster (e.g., months) for a trend over time. 

Reflect Which sold the most? Which region sold the best? 

7.2 Creating and Analyzing PivotTables and PivotCharts  

6

6
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You can summarize, analyze, explore and present summary data with Pivot Table. 
PivotCharts complement PivotTables by adding visualizations to the summary data of a 
PivotTable and allow you to quickly visualize comparisons, patterns, and trends. 
PivotTables and PivotCharts both make it easy to interpret key data in your business. 

How to Create a Pivot Table in Excel 

How to create a Pivot Table in Excel. 

Step 1: Open Your Excel Worksheet and Get Your Data Ready 

● Organize your data in an artificial table to rows and columns. 

● Ensure that every column has header and that there appears no blank columns or 
raw in the data set. 

● (Optional) Name your data range: Select data, give it a name for quick reference 
point (Formulas > Define name). 

Step 2: Choose Your Data 

● Click on a place in your data set. 

● Or, manually select the pivot table date range. 

Step 3: Pivot Table comes in place 

● Access the Insert tab of the Excel ribbon. 

● Menu You will now select The browser where you invite the Web except for one. 

● In the Create PivotTable dialog box, verify or type in the range of data you want to 
analyze. 

● Choose where you want to place the Pivot Table: 

● New Worksheet: Positions the Pivot Table in new worksheet. 

● Current Worksheet: Places the Pivot Table in a specified location of the active 
worksheet. 

 

1
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Fig 7.4 Pivot Table using Excel 

Did You Know? 

PivotTables were originally available from Excel 5.0 (1993) 

First introduced in Excel 5.0, which was released in 1993, PivotTables are meant to help 

users summarize and analyze large amounts of data without the need for complex 
formulas. This changed the way we thought about data analysis -- permitting users to 
play with their data in new and exciting ways. 

 

Step 4: Create Your Pivot Table 

●   The PivotTable Field List pane is on the right side of the window. 

●   Drag Fields to one of the four regions: 

●   Rows: Add fields to use as rows. 

●   Columns : Define what will be added as columns. 

●   Values: Include the numerical fields with data you want to aggregate (as in sum, 
count, etc). 

●   Filters: Include fields you would like to filter the data by. 

 

Fig 7.5 Pivot Table in Excel 

Shortcut Keys: 

·   Windows: To open the Create PivotTable dialog box, press Alt+N+V. 1

13
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· Mac: Command + Option + P is your pivot tablepalooza. 

In the Create PivotTable dialog box: 

Actions: ●   Check the selection of data (or adjust if necessary). 

● Choose where you want the pivot table be placed: 

●   New Worksheet: Creates the pivot table in a new worksheet. 

● Current Worksheet: You can place it in a specific location on the current worksheet. 

 

Step 5: Set Up Your Pivot Table 

You will have a pane on the right hand side of your window called PivotTable Field List. 
This is where you’ll organize your information: 

 

Fig 7.7 Field List Pane in Pivot Table 

Drag and Drop Fields: 

Drag field names from the Field List to anyone of the four areas: 

Filters 

· Filters –A reel-high filter that applies to the entire PivotTable. 

It enables users to visualise data dynamically on selected parameters. 

·   A drop-down list will be added at the top of the PivotTable to filter the data by this 
field. 

Example: 

A company has an Employee Database containing fields, such as Employee ID and 
Name, Department, Salary, Joining year and Performance Rating. 

· When Department field is added in the Filters area, then users can filter the PivotTable 
by a particular department, like HR, Sales or IT with disrupting PivotTable's 
arrangement. 

1

1

2
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Use Case: 

Quickly glance on personnel's information, filtered by departments if there is no need to 

see everything at once. 

Columns 

·   You use the Columns area to group data horizontally in the PivotTable. 

·   It can….. Assists in comparing data in diƯerent categories. 

·   There are separate columns for each diƯerent value in the field you selected. 

Example: 

The PivotTable will show each department (HR, Sales, IT) in a column if we move the 
Department field into the Columns area allowing us to easily compare data by 
departments. 

Use Case: 

Analyse salaries, appraisals or number of employees in various departments. 

Rows 

· The Rows field determines how data down the rows of the PivotTable is organized. 

· Every distinct value of the selected field is represented in its own row on the 
PivotTable. 

· Category and Group data more eƯiciently. 

Example: 

If you put the Employee Name field to the Rows area, the PivotTable will list down each 
employee's name one by one as a separate row and helps in analyzing individual 
information of an employee. 

Use Case: 

Display rated performance of employees that are in each department. 

Values 

· The Values field is the place where you perform calculations on your data(fields); 
common operations include Sum, Count, Average, Min and Max. 

· The selected field values are cascading based on the aggregation function. 

Example: 
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If you drag the Salary field to the Values area, Excel will add salaries for each employee 
/ department. 

Use Case: 

Determine total salary expense by department or get a mean rating based on 
performance. 

Example: Employee Performance Analysis 

 

Fig 7.8 Pivot Table Field 

PivotTable Configuration: 

 

Output PivotTable Example: 

 

Insights: 

• The HR department has the highest total salary. 

• Employees with a performance rating of 5 receive higher salaries. 

 

18
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Knowledge Check 1 

Choose the correct option: 

What is one of the main uses for a Pivot Table in Excel? 

A. To develop elaborate mathematical equations 

B. To know how to summarize, analyze and report on data competently 

C. When we want to make changes in the original dataset that are not reversible 

Where can you place a Pivot Table in Excel? 

A. Only in a new worksheet 

B. Within this sheet only 

C. Either on a new worksheet, or at the location that you select in this worksheet 

Which part of the Pivot Table is for inserting numeric values to perform operations like 
sum or count? 

A. Rows 

B. Values 

C. Filters 

 

7.3 Building Calculated Items and Fields in PivotTables 

PivotTables in Excel allows super quick summarization and analysis of huge data sets. 
Some simple summarising options are not enough to uncover deeper insights. 
Calculated Items and Fields allow users to create custom calculations in PivotTables 
without altering the source data. 

Calculated Items vs Calculated Fields: 

Calculated Fields: They are used when you need a new calculation that can be made for 
an entire field (column) in the PivotTable. 

Calculated Items: Calculated Items are used when a new calculation has to be done on 
the certain category (row) in the PivotTable. 

Example 1: How to Create Calculated Field in Sales Data Let me start with an example 
to introduce you with the concept of calculated fields. 

Scenario: 

1
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An Indian retail store needs to look into the profitability of diƯerent product categories. 
There are Sales Revenue and Cost Price in the data, but there is no Profit column 
directly. 

 

Fig 7.9 Sales Revenue and Cost Price Data 

Solution: 

With the use of a Calculated Field, we can define Profit as: 

Profit is the diƯerence between Sales revenue and Cost Price. 

Steps: 

Click the Pivot Table. 

Go to the PivotTable Analyze - Fields, Items & Sets - Calculated Field 

Rename it as Profit and the formula used is: = Sales Revenue - Cost Price 

Click OK and now we have Profit across all categories properly computed on the fly! 

Output: 

 

8
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Fig 7.10 Expected Output 

It helps to understand profitability trends across diƯerent items without aƯecting the 
source dataset. 

Did You Know? 

PivotTables in Excel can support records greater than 1 million rows 

You need as much of the source data on one worksheet or in a single table (including 
columns that will not be analyzed) as needed for PivotTables to quickly calculate and 
summarize large data sets, up to 1,048,576 rows by 16,384 columns in Excel 2007. This 

capability allows for the exploration of large datasets in Excel itself. Reference: Excel 
specifications and limits. 

Example 2: Calculated Item of Region Sales Analysis In a Regional_sales analysis, we 
can Define an item based on their parent and non-parent intersection. 

Scenario: 

One of the textile co wants to compare the Sales North India vs South India in Pivot 
Table. The sate wise sales report is in the data set, there is not such column with name 
“north india” and “south india”. 

 

Fig 7.11 Regional Sales Data 

Solution: 

Calculated Item It is possible to create new categories by means of a Calculated Item. 

Steps: 

Choose the Pivot Table. 

Go to the PivotTable Analyze - Fields, Items & Sets - Calculated Field 

10
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Name the range as North India and fill in your formula: 

= N.C.T. of Delhi + Punjab + Uttar Pradesh 

Do also for a “South India” field: 

= Tamil Nadu + Karnataka + Kerela Cause of Nivrittinema The nivritti principle could 
have been a response to the following reasons: 1. 

Click OK, now we have the two new fields in the Pivot Table. 

Output: 

 

Fig 7.12 Expected Output 

 

This enables comparing sales in larger regional segments without modifying the 
original database. 

Real-World Application: 

Retail Chains: Formula are explained to see margin per product line. 

E-commerce: Online retailers including Amazon and Flipkart use calculated fields to 
track year-over-year growth in sales, discounts and net income. 

Industry: Aggregate measures could be compared to performance by region and 
production unit. 

With Calculated Fields and Items blog businesses can glean insightful information, 
which they can use in decision making through custom calculations. 
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Fig 7.13 Real-World Application 

 

Knowledge Check 2 

Fill in the Blanks: 

PivotTables in Excel allow users to quickly __ and examine large amounts of data. 
(visualize / summarise) 

Calculated Fields are good when you need to perform a new calculation on an entire _ 
of the PivotTable. (field (column) / category (row)) 

Calculated Items are used when a new calculation from the existing values is needed 

in a___________ of PivotTable. (category (row) / field (column)) 

7.4 Using Slicers and Dashboards to Derive Insights 

A common way to use slicers is with Excel’s PivotTables, which you can use for example 
to filter data. We can use slicers in your reports to oƯer a dynamic way for users to 
change what is being reported, such as sales by region or sales representative. If you 

use slicers then selecting a region will not just filter the Pivot table to show the data that 
is relevant but also highlight (both by colour and automatically popup a Vlookup List) 
the best sales people for that region. This real-time visual feedback is useful in better 
analyzing data trends and insights. 

15
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Fig 7.14 Pros and Cons of Slicers and Dashboards 

 

Moreover, slicers can be created for multi-select to help users select and analyze the 
multiple pieces of data. For example, if you need to assess the progress made by two or 
more sales agents, you can do so by simply holding down the Control (or Command) 
key while clicking on each of their names during selection. Not only does the function 
enhance user experience but it also increases data visualization on presentations. This 
creates an unmatched synergy when using MS Excel. And of course, slicers can be 
styled to improve the presentation, so it's not It isn't necessarily a solved problem. 

more simple to integrate them in dashboards consistent with corporate identity and, 
isn’t less important, they also provide a grater reporting capability. 

7.4.1 Using Slicers in PivotTables 

Example: Sales Analysis of an E-Commerce Company 

For example, consider a business conducting online e-commerce sales of electronics. 
Management should look into sales productwise and regionwise. 

Sample: 
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Fig 7.15 Sales Analysis for Ecommerce Firm 

Steps to Add a Slicer: 

Select a dataset and insert a PivotTable. 

Put Product Category in "Rows" and Sales Revenue into the "Values". 

Click anywhere inside the PivotTable and then Go to the PivotTable Anlyze – Insert 
Slicer 

For Slicer field, select Region and click OK. 

You can now click on any region in the slicer and your sales data will be filtered 
beneath. 

It means that sales managers can quickly sift and compare sales numbers by region. 

7.4.2 Using Slicers in PivotCharts 

They also work with PivotCharts so that data can be visualized better. 

Example: Sales Trend of a Shop 

A store would like to examine how the sales of some types of fruit have trended over 
time, for example Apples, Bananas, Cherries and Oranges. 

How to Add a Slicer to Your PivotChart in Microsoft Excel: 

·   Add a PivotTable to show sales by salesperson and by product. 

· PivotChart (Column Chart) made using the PivotTable. 

· Click "Insert Slicer", then 'Product' to see data filtered in an easy-to-view way. 

· Picking a product in the Slicer updates the PivotChart interactively - providing sales 
information for just that selected product. 

Page 23 of 31 - Integrity Submission Submission ID trn:oid:::3618:127049950

Page 23 of 31 - Integrity Submission Submission ID trn:oid:::3618:127049950



Result: The PivotChart automatically updates instantly, allowing you to analyse sales 
performance rapidly and interactively. 

 

 

Fig 7.16 Pivot Chart with Slicer 

 

7.4.3 Understanding Dashboards 

What is a Dashboard? 

A dashboard represents the most crucial information about your business through 
charts, tables, slicers and so on in order to provide a clear insight into measurement. 

Why Use Dashboards? 

Dashboards are an important business intelligence and data visualization solution, 
enabling organizations and individuals to make informed decisions in a timely manner. 
The following are more detailed explanation of their benefits: 

Sums Up Major Information 

They aggregate data from multiple report and sources in one comprehensive view. 

Instead of bouncing between a bunch of spreadsheets, your customers can see all the 

vital KPIs, charts and tables in one place. 
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This eƯicient procedure reduces time, eases complexity and increased data 
comprehension – easier to find patterns and discoveries. 

Interactive and Dynamic 

Unlike the static reports, Dashboards have interactive capabilities such as slicers, 
filters, and they also support drill down. 

Users can customize their view by selecting specific data points, adjusting filters, or 
drilling into certain metrics. 

This interaction provides a real-time querying of the data; thus users are able to get a 
deeper dive into what induces specific trends or outliers. 

Bolsters Decision-Making 

Dashboards help support business strategy through the provision of transparent and 
actionable insights. 

And with the data patterns and trends they can see, decision makers can help to better 
manage operations, to identify opportunities, and even grab trouble in its early 
moments. 

Real-time information updates allow businesses to base decisions on current data. 

 

Fig 7.17 Uses of Dashboards 

 

7.4.4 Creating a Sales Dashboard in Excel 

Example: Dashboard For An FMCG Company 

A quick service consuming company needs dashboard which shows: 
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● Total sales by city 

● Monthly sales trends 

 

Fig 7.18 Sales Dashboard 

Steps to Build a Dashboard: 

Add City and Product Category Slicers. 

Organize the Dashboard: 

○ Keep all shards in one visit. 

○ Use style and formatting for readability. 

Managers and Executives can use this dashboard to analyze sales performance in 
regions/ products on the run. 

Benefits of Slicers and Dashboards 

Slicers and From PivotTables: Excel’s Slicers and dashboards provide an eƯective way 
of both analyzing and communicating insights from data. Slicers are interactive filters 
which allow user to interactively and dynamically slice the data to see only selected 
slicer(s) data\information at a time without changing report canvas. It allows for better 
data exploration and it simplifies complex data analysis. Dashboards include summary 
tables and charts that you can insert as PivotTables, linked data visualizations using 

slicers. They enable businesses to track trends, spot patterns and make quick 
decisions. For example, in a retail company, the sales dashboard with slicers such as 
city, product category and month helps to quickly analyze regional performance and 
demand for products. With slicers and dashboards, businesses can make better 
decisions, be more eƯicient, and literally see their data in real-time. 
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7.5 Summary 

❖ PivotTables and PivotCharts help you summarize, analyze, and present huge 
volumes of information to enable informed decision making. 

❖ PivotTables enable users to rearrange, sort and do calculation on data in any way 
they would like. 

❖ PivotCharts show visual PivtTable information to make it easier to spot trends and 
make comparisons. 

❖ In companies, PivotTables and PivotCharts are used for financial analysis, tracking 
sales performance, customer information, and HR data tracking. 

❖ Creating a PivotTable is a process which involves (i) organizing the data, (ii) selecting 
the range, and (iii) dragging and dropping to organize rows, columns, values, filters. 

❖ Calculated Fields allows custom calculations over a complete dataset without 
modifying the source. 

❖ Calculated Items allow the user to perform calculations directly in a PivotTable 
category. 

❖ Dashboards and Slicers facilitate data interactivity where, filters can be applied and 
insights drilled down interactively. 

❖ The proficient use of PivotTables and PivotCharts for data visualization, is enabling 
well informed and data driven decisions in various business units. 

7.6 Key Terms 

PivotTable: An analysis feature that creates a summary of data by dynamically 
arranging information in a table or list. 

PivotChart: A chart representation of PivotTable data that helps you see trends and 
comparisons. 

Row Labels: The category by which data is grouped into rows in a PivotTable. 

Column Labels: The field in a PivotTable that categorizes information into columns. 

Values: The numerical values of a PivotTable, often calculated as sum, average or 
count. 

Filters: A feature of PivotTable that allows you to display only some portions of data. 

Calculated Field A formula that a user creates to use in a PivotTable report or Pivot 
Chart for data analysis beyond numeric summaries such as totals or counts. 
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Calculated Item: A formula used in a specific field in a PivotTable. 

Slicer: A visual filter tool that provides users with an interactive experience in filtering 
PivotTables and PivotCharts. 

Dashboard: Set of visualizations (chats, tables and metrics) that allow you to make 
decisions at a glance and insights in the data very fast. 

Data Source: The raw data which you use to create a PivotTable. 

Aggregation: Method of adding up big data using functions like sum, count, average 
etc. 

Group: To combine data within a PivotTable based on some shared value or period of 
time. 

Drill Down: A technique you use to examine detail in a PivotTable. 

Refresh: Constructing a PivotTable again to reflect changes in the data source. 

7.7 Descriptive Questions 

What is a PivotTable, and how can it help with data analysis? 

Explain how to create a PivotTable in Excel. 

What is the diƯerence between PivotTable and PivotChart? 

Describe the elements of a PivotTable, such as Row Labels, Column Labels, Values 
and Filters. 

Why would you work with PivotTable Slicers? What is the role of Slicers in data 
filtration? 

What is the process for building a Calculated Field in your PivotTable? Provide an 
example. 

Explain how to group data in a PivotTable and why this is helpful. 

What is Dashboard in Excel, and How related with PivotTables & PivotCharts? 

Why and How to Refresh a PivotTable? 

Explain the Drill Down concept in PivotTables and how it can allow for a complex 

analysis of data. 

7.8 References 

1. Walkenbach, J. (2019). Excel 2019 Bible. Wiley. 

2. Alexander, M., &Kusleika, D. (2022). Excel Power Pivot & Power Query For 
Dummies. Wiley. 
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Answers to Knowledge Check 

Knowledge Check 1 

1: B)Synthesizing, Analyzing and Reporting Data Summarization/v Analysis/v Report/S-
Allow all of the above outside of class timeESSAGESumaTo summarizeBy now you 
should understand how to use statistics in your are not simply looking to get 
information from data, report it nicely and pretend everything is done. 

2: C) In either a new worksheet or in an earlier case location in the current worksheet 

3: B) Values 

Knowledge Check 2 

1: b) summarize 2: a) field (column) 3: a) category (row_constraints: 
pDueToField=isNew attribute=this.lexicYouLittleShit(Added to builtin of this)); 
row_constraints: value=hist(Amount; field=_yourFirstAmount; 
subfield=value),summaries(hide,inner=);). 

7.9 Case Study 

How to Use Pivot Tables for Sales Analysis in Excel 

XYZ Retail is a mid-size retailer selling products in four regions – North, South, East and 
West. The management wants to analyze last year's sales data for trends, best selling 

products and the performance of regions. 

Problem Statement 

Sales data has been collected in large quantities by the company, but this does not 
necessarily lead to easy extraction of valuable information without appropriate 
summarization of that data. The idea is to use Pivot Tables in Excel to analyze and 

visualize the data. 

Overview of Datasets (Last Year’s Sales) 

Overall Sales Summary with Pivot Table 

Data Set: 

1

9

16

20
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Here’s what your Pivot Table in Excel will look like after summarizing the total sales per 
region: 

Best-Selling Product Categories 

And if we take another Pivot Table, these are the sales amounts by category: 

Sales Trend Across Time 

A line graph with the assistance of Pivot Table demonstrates that January and June 
there was most sales this could indicate some seasonality in shopping. 

Top-Takeaway Findings 

· Most Sold Area: North and South (Max : ₹7,90,000 each) and East had least sales 
(₹3,15,000). 

Best-Performing Segment Electronics did best (₹10,55,000 in revenues), followed by 
Home Appliances (₹7,55,000). 

·   Most profitable Item: Laptops had the highest sales amounting to (₹4,15,000). 

· SeasonalityJanuary and June are months of maximum sales which means these 
months were seeing the most demand. 

Conclusion 

Excel Pivot Tables provided XYZ Retail with an on-hand tool for visualizing and analyzing 
their sales data right away. The company can use this analysis in order to make sense of 
where it should focus on its categories with best performing products, stock more 
items that sell the most at high peak seasons, and develop regional marketing 
campaigns towards fast selling regions in order to bring up sales for slow moving 
regions. 

 

Sample Dataset: 
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Module 9: Strategic Business Decisions using AI 

 

 

Learning Outcomes 

1. Understand fundamental concepts of Artificial Intelligence and its business 
applications. 

2. Analyze the role of AI in enhancing strategic business decision-making. 

3. Identify key AI-driven tools used in data analysis and decision support. 

4. Apply Power Query and Power Pivot to perform advanced analytics on business 
data. 

5. Interpret business scenarios and formulate strategies using AI insights. 

6. DiƯerentiate between traditional and AI-driven decision-making models. 

7. Evaluate real-world cases to understand the strategic impact of AI in business 
contexts. 

 

 

 

Content: 

9.0 Introductory Caselet 

9.1 Introduction to AI 

9.2 Introduction to Strategic Business Decisions 

9.3 Using Power Query and Power Pivot for Advanced Analytics 

9.4 Hands-On Activity / Assignment 

9.5 Summary 

9.6 Key Terms 

9.7 Descriptive Questions 

9.8 References 

9.9 Case Study 

 

8

5

40
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9.0 Introductory Caselet 

“SmartRoute: Navigating Strategically with AI” 

SmartRoute Logistics A mid-sized supply chain company located in Pune, SmartRoute 
was gaining popularity by servicing local retail networks eƯectively with reliable manual 
planning. As the race heated up, customer demands for expedited delivery times put 
pressure on ineƯicient route planning and resource allocation. 

The leadership team saw the opportunity in data driven decision making, but didn’t have 
the analytic capability to make sense of their increasing volume of delivery data. This 
all changed when they started working with an AI consultancy to embed an Artificial 
Intelligence into their decision-making process. With the help of tools like Power Query 
and Power Pivot, they started manipulating raw logistics data to derive actionable 
insights. 

Months later, SmartRoute built AI-driven dashboards for route planning that 
incorporate weather, traƯic and fuel costs. Predictive models alerted to possible 

delays and available underutilized zones in the fleet. Accordingly, delivery times were 
reduced by 18%, and operational costs decreased by almost 12%. The significance 
was more than just logistics – SmartRoute revised their expansion strategy, selecting 
locations for their warehouses through an AI-driven demand prediction engine. What 
began as an exercise in tactical eƯiciency turned into a broad transformation of the 
company’s strategic thinking, leveraging data and artificial intelligence. 

Critical Thinking Question: 

In the SmartRoute example, how did technology tools and strategic planning shift the 
company’s growth trajectory? What other types of businesses might benefit from such 
AI integration? 

9.1 Introduction to AI 

9.1.1 Defining Artificial Intelligence 

This subject covers what AI is at a high level, diƯerent types of AI and how it has 
evolved over time. 

Narrow AI vs. General AI 
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Fig. 9.1 Narrow AI vs. General AI 

 

· Narrow AI (Weak AI): 

o Aimed at a particular purpose or range of purposes. 

o Examples are voice assistants like your Siri, recommendation engines on Netflix or 
spam filters. 

o It works under certain limitations and cannot work in an area out of its predefined 
parameters. 

o   Does not possess awareness; consciousness of, comprehension of, or self-
consciousness. 

·   General AI (Strong AI):. 

Option a:Hypothetical type of artificial intelligence in which we use it to do literally 

everything that a human can do. 

o Able to think, solve problems, and reason both abstractly and in other domains. 

o   Would exhibit self-awareness, awareness of others and their feelings. 

o Purely theoretical at this point, no implementations have been made. 

· Key DiƯerences: 

o  Scope: Weak AI is dedicated to certain tasks; Strong AI has a general scope. 

o Adaptation: Narrow AI is not able to be applied in other places without having to 
reprogram it; General AI would be generally applicable. 

o   Autonomy: Narrow AI follows rules and data; General AI knows how to make 
decisions on its own. 

Historical Evolution and Trends 

14
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· 1940s – 1950s: preliminary theories UIStoryboardSegue Theoretical foundation.. 

o Alan Turing's "thinking machines" and the Turing Test. 

o Developments of early neural network models and symbolic reasoning 

· 1956: The Dartmouth Conference 

o It celebrated the oƯicial birth of AI as an academic discipline. 

o The primary goal was to develop machines capable of imitating humans’ ability to 
reason. 

· 1960s-1980s: Rule-Based Systems 

o Usage of expert systems constructed with the help of logic programming. 

o Enthusiasm about knowledge representation and reasoning mechanisms. 

· 1980s-1990s: AI Winter 

o Lost hopes, as current computational capabilities were not suƯicient to support 
unrealistic AI promises. 

o Budget cuts and lack of interest in AI field. 

· 2000s-2010s: Machine Learning and Big Data 

o Empowerment with statistical learning models, as large datasets were provided. 

o Enlarged areas of AI implementations in existing businesses. 

· 2010s-present: Deep Learning and Practical AI 

o Breakthroughs in deep neural networks, natural language processing and computer 
vision. 

o AI applications in health, finance, marketing, and autonomous driving. 

§ Growth in AI platforms and cloud-based AI services (TensorFlow, PyTorch) 

· Current trends: 

o Conversational AI. E.g. ChatGPT 

o AI ethics and governance 

o Edge AI processing. E.g. Quickstrom, Xnor.ai 

o democratization via no-code AI tools, e.g. software such as If-This-Than-That 9.0.2 
Core Components of AI 

19
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This subtopic defines the key technological necessities at the heart of all AI systems’ 
work in all industries. Machine Learning 

· Definition: 

o Supervised Learning: Models are trained on labeled data (such as classification or 
regression). 

o Unsupervised Learning: Leveraging unlabeled data to recognize patterns (for example, 
clustering and dimensionality reduction). 

o Reinforcement Learning: Agents learn their optimal action under a trial and error 
setting in an environment. 

·   Business Applications: 

o Customer segmentation 

o Fraud detection 

o Sales forecasting 

o Predictive maintenance 

· Common Algorithms: 

o Decision Trees 

o Support Vector Machines 

o Neural Networks 

o K-Means Clustering 

o  Gradient Boosting Machines 

· Tools and Platforms: 

o Scikit-learn 

o TensorFlow 

o PyTorch 

o Azure ML 

o AWS SageMaker 

· Challenges: 

o Data quality and bias 

o Model interpretability 

6

6
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o Overfitting and under fitting 

o Computational costs 

Natural Language Processing (NLP) 

· Definition: 

o  Teaches machines how to understand, interpret and generate human language. 

· Core Tasks: 

o Text Classification: Labeling text by predefined categories (in, e.g., spam detection 

applications). 

o Named Entity Recognition (NER): recognizing proper names, locations, organizations 
in text. 

o Sentiment Analysis: Inferring the emotional attitude from a text. 

o Machine Translation: Converting text from one language to another. 

o   Question Answering and Chatbots: The ability to answer user questions in natural 
language. 

· Techniques: 

o Tokenization 

o Stemming and Lemmatization stemmer provided by the Cheer.c module of the 
normalization technique, performs stemming according to a coulb* lemmatizer 
provided by Cheer.c coulb normal T.f lemmatizes according to my:T.b counts V is 
normally distributed, directed p(ny:) defaults contrast against e also worldwide. 

o Part-of-speech tagging 

o Language modeling 

o   Word embeddings (such as, Word2Vec, GloVe) 

· Recent Advancements: 

o Pre-trained transformers such as BERT, GPT, RoBERTa. 

o  Language understanding and generation with context. 

· Business Use Cases: 

o Using chatbots to automate customer serve. 

o   They analyse social media sentiment. 

o   Improvements to searching capabilities. 

16
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o Automation of document management. 

· Challenges: 

o Ambiguity in language 

o Multilingual support 

o Bias in training data 

o Scalability of models 

Computer Vision 

· Definition: 

o   Allows machines to understand and play with visual data, e.g., images & videos. 

· Key Tasks: 

o Image Classification – Finding objects or categories in images. 

o Object Detection: The task of localizing objects in an image, where more than one 
object can be detected within the same image. 

o Image Segmentation: The process of partitioning an image into parts or objects. 

o  Facial Recognition: Recognizes people by their faces. 

o  OCR: Taking words from pictures. 

· Techniques and Algorithms: 

o CNNs 1.Convolutional Neural Networks (CNNs) 

o YOLO (You Only Look Once) for real time object detection. 

o   Image processing using OpenCV 

o  GANs for image generation 

· Applications: 

o Manufacturing quality control 

o Surveillance/Security solar powered systems 

o   Diagnostics in medical imaging 

o   Automated social media-tagging 

o  Autonomous vehicle navigation 

· Challenges: 

38
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o  Variation in lighting, angles & image quality 

o  Data labeling and annotation needs 

o Privacy concerns 

•o  Real-time limitations on processing 

Expert Systems 

· Definition: 

o  AIs with decision-making processes similar to a human expert based on sets of rules 
and logic. 

· Architecture: 

o  Knowledge Base: It stores facts and heuristics. 

o Inference Engine: Uses logical principles on the knowledge base in order to derive new 
facts or to draw conclusions. 

o User Interface: Allows the user to interact with the system. 

· Types: 

o Rule-based systems: (IF-THEN rules) For example, RULEXT; RBS). 

o Fuzzy logic systems (to deal with uncertainty in decision-making) 

·  Business-Software-Anwendungen: 

o  Medical diagnostics 

o IT and electronics systems troubleshooting 

o   Bank credit risk evaluation 

o System Legal decision support 

· Advantages: 

o like performances before consistent decision-making 

o Availability 24/7 

o Capturing and reproducing expert knowledge. 

· Limitations: 

o  Costly and time-consuming to develop 

o Updating the KB seems to have proven challenging 
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o   Machine Learning systems, low learning capacity in comparison to machine-
learning devices 

 

Did You Know? 

“Did you also realize that the foundations of AI (Machine Learning; Natural Language 
Processing; Computer Vision And Expert Systems) are either embedded or behind over 
77% everyday digital services, from fraud detection and your photo to your voice 
assistant? 

9.1.3 AI in Business Context 

AI use cases are revolutionizing business by driving eƯiciency, personalization and 
data-informed enterprise. This section investigates the primary business use cases for 
AI, which are customer service automation, predictive analytics and 
recommendations. 

Customer Service Automation 

· AI customer service solutions that make communication and support more eƯicient 
with: 

o   Real-time †chatbots and virtual assistants who can manage frequent customer 
questions. 

o   Virtual assistants that are interconnected with IVR systems for automating call 
center processes. 

o AI-driven helpdesks that classify, prioritize and route tickets according to context and 
mood. 

· Benefits: 

o  24/7 availability and rapid response. 

o Lowering the burden and cost of human agency. 

o Improved customer experience with consistent answers. 

· Technologies used: 

o   Natural Language Processing (NLP) to understand customer requests. 

o   Sentiment to understand urgency or emotion. 

o CRM integration in order to see real-time customer data. 

· Use Cases: 

5

Page 15 of 44 - Integrity Submission Submission ID trn:oid:::3618:127049213

Page 15 of 44 - Integrity Submission Submission ID trn:oid:::3618:127049213



o Banks employing AI chat bots for balance and transaction history requests. 

o  AI based assistant integrated e-commerce platforms that can track orders. 

o  Telecom companies using virtual agents to automate the processes of 
troubleshooting. 

· Challenges: 

o  Unable to cope with complex queries. 

o Constant need for learning and training the models. 

o The danger of over-automating resulting in annoying the Customer. 

Predictive Analytics 

· Predictive analytics: Utilize historic data plus AI models to predict future actions: 

o Recognizing patterns, behaviors or threats that may develop under certain 
circumstances. 

o Utilized in finance, marketing, supply chain management, health care and HR. 

· Key components: 

o   Gathering data from a variety of sources. 

o Recognition engines using patterninduction algorithms, such as machine learning. 

o  Dashboards and visualizations to communicate findings. 

· Applications: 

o  Marketing: Predicting customer churn, clustering of customer behaviour, campaign 
optimization. 

o Finance: Credit scoring, fraud detection, portfolio optimization. 

Supply Chain – Demand forecast, Inventory optimization, Delivery time estimate. 

o HR: Attrition prediction, Optimizing hiring for talent acquisition. 

· Techniques used: 

o Regression models 

o Time-series forecasting 

o Decision trees and ensembles model 

o Deep learning for complex data sets 

· Benefits: 

31
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o Better decisions through proactive insights. 

o   Maintenance/Demand driven cost reduction. 

o   Competitive edge based on data-driven planning. 

· Limitations: 

o  Reliance on quality and applicability of data. 

o Forecasting can be ineƯective and unreliable if assumptions behind them change. 

o Demand for data scientists and infrastructure expertise. 

Recommendation Systems 

· AI-powered recommendation engines personalize the user experiences by 
recommending products or content that a user may like: 

o Used in e-commerce, streaming services, news media and social networks. 

·   Types of Recommendation Systems: 

o Content-Based Filtering: Recommends based on past behavior or preferences made 
by the user. 

o Collaborative Filtering Recommends the items liked by the users who similar to 
(user–user or item–item). 

o Hybrid models: They use both, content-based and collaborative filtering for higher 
accuracy. 

· Applications: 

o Online shops recommending products after looking at your history of browsing and 
purchasing. 

o Netflix suggesting movies to watch based upon the patterns of viewership. 

o   News aggregators adapting headlines to a user's interests. 

· Technologies used: 

o User profiling in the form of tracking behavior. 

o   Similarity measures as Cosine similarity, Pearson correlation. 

o Matrix factorization and deep learning for large-scale recommenders. 

· Benefits: 

o  Helps to engage and satisfy customers. 

9
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o   Converts and grows revenue. 

o Empowers scaled micro-targeting and personalization. 

· Challenges: 

o Cold start issue for new users or items. 

o Filter bubbles narrowing access to diƯerent information. 

o  Privacy, data use concerns. 

9.1.4 Ethical and Legal Considerations 

As AI becomes more entrenched in decision-making pipelines, we need to tackle the 
ethical and legal implications of AI creation and use. This paper presents the key 
themes of data privacy, algorithmic bias and regulation for responsible AI use. 

 

 

Fig. 9.2 Ethical and Legal Considerations 

 

Data Privacy 

• Data protection consists of the safeguarding of personal and sensitive information by 
AI systems: 

o Ensures data protection laws are consistently followed. 

o Fosters confidence among users and stakeholders. 

• Concerns with AI systems: 

o Aggregation of massive amounts of personal data across touchpoints (web, mobile, 
IoT). 

o Risk of using data in an unauthorized manner, sharing or the like. 

28
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o Informed consent is diƯicult to obtain, particularly for blackbox AI models. 

• Key Principles: 

o Transparency – tell users what kind of data is being collected and why. 

o Consent: Provide clear information and opt-in controls for users. 

o Minimization: Data should be limited to what is strictly necessary for the intended 
purpose. 

o Anonymsation: That is, wipe away any PII before analysing. 

• Technological measures: 

o Encryption of data at rest and in transit. 

o DiƯerential privacy for aggregate analysis while preserving individual privacy. 

o Federated learning, used to train models without concentrating data. 

• Compliance Standards: 

o General Data Protection Regulation (GDPR) – [EU]. 

o California Consumer Privacy Act (CCPA) – US. 

o Personal Data Protection Bill (PDPB) - India (draft). 

• Organizational practices: 

o Appointing data protection oƯicers. 

o Performing periodic privacy impact assessments. 

o Logging data access and usage. 

Algorithmic Bias 

• Algorithmic bias means systemic and repeatable errors in AI that create unfair 
outcomes: 

Biases from biased training data, broken assumptions or absence of diversity. 

• Sources of Bias: 

o Data about the past which relates to social inequality. 

o Discrimination in adverse impact against certain groups. 

Human labeling or feature selection bias. 

o Sampling biases in rail tones for training sets. 

• Examples: 

11
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o Training algorithms for recruitment that prefer men, simply because even more 
biased historical data were used. 

o Certain populations are penalized by credit scoring systems. 

o Facial recognition is not performing well on darker skins. 

• Impact on Businesses: 

o Reputational risk from discrimination practices. 

o Legal liability and regulatory scrutiny. 

o Customer distrust and loss of market share. 

• Mitigation Strategies: 

o Bias audits on development models. 

o Apply algorithms from fairness-aware machine learning. 

o Ensure representative teams gather the data and test the model. 

o Develop clear model reporting (model cards). 

• Ethical AI Principles: 

o Fairness 

o Accountability 

o Transparency 

o Inclusiveness 

Regulatory Frameworks 

• AI regulation seeks for the safe, fair, and value aligned AI systems: 

o Ethics-based technology, with innovation. 

• Current Landscape: 

o Regulatory tactis diƯer by region but are aligining on common foundations. 

o Some are industry specific (health, finance) and others are general. 

• Key Examples: 

o European Union AI Act: 

 Risk-based approach classifying AI systems as unacceptable, high-risk and low-risk. 25
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Need for transparency, human accountability and DRM checks for applications of high 
risk. 

o OECD AI Principles: 

 On AI, a set of principles for inclusive growth, transparency & accountability. 

o NITI Aayog (India): 

 Suggested standpoint on RAISE at policy level. 

 Emphasis is on health, agriculture and education use cases. 

• What About Some Key Tenetries of Emerging Frameworks: 

o Risk classification and management 

o Data governance and protection 

( o AI decisions transparency and interpretability slew. 

o Human oversight and intervention 

o Redress for harm or misuse 

• Corporate Response: 

o Establishing AI governance councils. 

o Creating internal AI ethics policies. 

o Harmonizing development practices with regulatory needs. 

Activity: AI Application Mapping Exercise” 

In this activity, students will work collaboratively in small groups to find 5 real life 
applications of AI from diƯerent fields like health care, retail, finance or logistics. For 
each use case, they will identify the core AI techniques (Machine Learning, Natural 
Language Processing, Computer Vision or Expert Systems) that are most applicable and 
describe their contribution in just a few words. The group will then work-up up a short 
presentation aligning these uses with the concerned components of an AI approach. 
This exercise helps students bridge theory with practical examples and it supports 
teachers in helping their learners understand how various AI technologies work within 
a real business. 

 

9.2 Introduction to Strategic Business Decisions 

9.2.1 Strategic Decision-Making Models 

24
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Approaches in decision-making Models Decision making model provide structured 

ways of breaking market environments, internal competences and industry conditions. 
These are the kind of models that enable managers to take advantage opportunities, 
manage risks, and build a sustainable growth strategy. 

 

 

 

 

 

 

 

 

Fig. 9.3 Strategic Decision-Making Models 

 

SWOT Analysis 

• Definition: 

o SWOT: An abbreviation for Strengths, Weaknesses, Opportunities and Threats. 

o It is a diagnostic tool for the internal strengths and weaknesses in an organisation s 
management processes. 

• Internal Factors: 

o Core competencies, brand equity, distinct resources, loyal customers, eƯicient 
operations. 

o Weaknesses: Lack of skill resources, old technology issue, low distribution rate, low 
popularity of the brand, monetary issues. 

• External Factors: 

o Opportunities: Emerging Markets, Technology advancements, Positive regulations, 
Strategic partnerships. 

o Threats: Competition, consumer tastes, economy, technology. 

• Applications: 

o Developing new product strategies. 
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o Identifying competitive advantages. 

o Readiness for market entry Evaluation. 

• Benefits: 

o Simple, easy-to-use framework. 

o Encourages holistic thinking. 

o Needs to be a bright red so it jumps oƯ the page. 

• Limitations: 

o Subjective; depends on analyst perception. 

o May oversimplify complex issues. 

o Lacks prioritization without complementary analysis. 

Porter’s Five Forces 

• Definition: 

o Created by Michael Porter, this model examines the attractiveness of industry and 
its animosity levels. 

o Assists firms to comprehend market environment and profitability possibilities. 

• Forces: 

o Threat of New Entrants: 

29 Factors such as capital, economies of scale, brand loyalty and regulation) that act 
as barriers to entry. 

o Bargaining Power of Suppliers: 

 Strong suppliers aƯect input costs besides high in number of substitute and buyer 
groups. 

o Bargaining Power of Buyers: 

 Bargaining power of buyers – reduces profitability (strong where customers have 
competition or sensitivity to price). 

o Threat of Substitutes: 

 Substitutes for products or services that meet the same need (e.g., tea vs. coƯee, 
ride- sharing vs. taxis). 

o Industry Rivalry: 
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o Intensity of existing firm rivalry, which is driven by the number and balance of 
competitors, market growth, and diƯerentiation. 

• Applications: 

o Evaluating attractiveness of new market entry. 

o Assessing the risks of altering supplier arrangements. 

o Designing competitive strategies. 

• Benefits: 

o Structured analysis of external environment. 

o Highlights industry-specific pressures. 

o Useful for long-term strategic planning. 

• Limitations: 

o Static incision; not comprehensive enough for dynamic market changes. 

o Excludes internal organisational resources and competences. 

o May not consider collaborative strategies such as partnerships or ecosystems. 

PESTEL Framework 

• Definition: 

o PESTEL analyses the Political, Economic, Social, Technological Environmental Legal 
issues for business. 

• Factors: 

o Political: Political stability, trade policy, tax policy, political risk. 

o Economic: Inflation, interest rates, exchange rates, unemployment numbers and the 
business cycle. 

o Social: Demography, culture, lifestyles, attitudes. 

o Technological: R&D investment, automation, innovation cycles, digital 
transformation. 

o Environmental : Sustainability, climate change and energy policies. 

o Legal: Labour laws, intellectual property rights, compliance. 

• Applications: 

1
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o Market entry early scanning of macro-environment trends. 

o Assessing the risk of regulation for compliance planning. 

o Consumer and society trends for product innovation. 

• Benefits: 

o Broad analysis of external influences. 

o Anticipates emerging risks and opportunities. 

o Is complementary to others, such as SWOT and Five Forces. 

• Limitations: 

o Needs to be updated regularly because of changing circumstances. 

o May produce a lot of data without necessarily proper prioritization. 

o Not as eƯicient if not part of a strategy'o_Not 8628/1. 

9.2.2 Data-Driven Decision Making 

Today’s strategic decision-making is moving from intuition to analytics. Companies 
need to be able to collect and analyze data, but they also need to turn insights into 
plans of action. Evidence-based decision making limits the application of intuition 
and reinforces needs-based planning. 

Significance of data in Strategic planning 

• Role of Data: 

o OƯers unbiased perspective on market dynamics, customer trends and operational 
productivity. 

o Facilitates predictive model building for future projection. 

o Enhances resource allocation by highlighting high return endeavors. 

• Applications: 

o Market Penetration: Using demographic and consumption data to gain access into 
profitable regions. 

o Product Development: Using customer feedback, online reviews and sales trends 
to create new products. 

o Process EƯiciency: Using the IoT and sensors to predict when a machine may 
require maintenance in manufacturing. 
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o Risk Management: Early warnings and guidelines for financial markets or supply 
chains lookouts. 

• Benefits: 

o Enhances accuracy of long-term strategies. 

o Reduction of uncertainty through the measurement of risks and opportunities. 

o Enhances competitive edge through time planted knowledge. 

• Challenges: 

o Data is siloed by which organization it is within (weed). 

o Mediocre quality information can lead to wrong decisions. 

o Expensive infrastructure for the storage and analytics. 

o Reliance on expertise of human resources for interpreting the data. 

• Emerging Trends: 

o Real-time decision-making through streaming data. 

o Cloud-basedanalytics platformsto lower IT costs. 

o AI integration to find the hidden patterns. 

KPIs and Performance Metrics 

• Definition: 

o KPIs ( Key Performance Indicators ) are the quantifiable values, which are used to 
measure the progress against strategic goals. 

o Metrics serve as measures with which to qualify eƯectiveness and eƯiciency. 

• Characteristics of EƯective KPIs: 

o SMART may be a better approach for you to use rather than START: Specific, 
Measurable, Achievable, Relevant (and Realistic in some usages), Time-bound. 

o Aligned: Must be in direct correlation to strategic objectives. 

o Actionable: Should influence decision-making. 

• Examples by Business Area: 

o Finance: Return on Investment (ROI), Net Profit Margin, Economic Added Value. 
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o Marketing: Cost of Customer Acquisition (CAC), Conversion Rate, Customer 
Lifetime Value (CLV). 

o Volumes: Cycle Time, Capacity Utilization, Overall Equipment EƯiciency (OEE). 

o Human Resources: Turnover Rate, EƯectiveness of Training Absenteeism. 

• Benefits: 

o OƯers specific goals/milestones at which to gauge progress. 

o Promotes responsibility across teams and department. 

o Facilitates data-driven adjustments to strategies. 

• Challenges: 

o Focus of short-term KPI’s could ignore long term. 

o Too many measurements lead to confusion and diminished concentration. 

o Lack of uniform recruiting procedures can compromise reliability. 

• Best Practices: 

o Choose a balanced scorecard perspective (financial, customer, internal business 
process or learning and growth). 

o Continuously revisit KPIs to align to changing strategies. 

o Use dashboards for live visualization and monitoring. 

9.2.3 Challenges in Traditional Decision-Making 

Intuitive and experiences-driven decision making is the standard approach in 
traditional business, where stakeholders regularly lack quality information. Whereas 
such methods have served well so far, the nature of current business settings have 
become more strenuous and hard. There are two major obstacles: information 
overload and human bias, which may cause it diƯicult for man to think clearly and well 
enough. 

Information Overload 

• Definition: 

o Information overload is a condition where the volume of data received exceeds an 
individual’s or organization’s 

ability to handle and comprehend it. 

20
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o Today in organisations decision makers are continue to be bombarded with 
structured and un-structured data from more than one source. 

• Sources of Overload: 

o Expansion of digital platforms producing big data (e.g., social media, IoT devices). 

o Several internal systems (CRM, ERP, HR databases etc.) supplying duplicate or 
contradictory information. 

o Low latency news, analyst feeds and other resources contributing to external 
information flow. 

• Impact on Decision-Making: 

o Problem of sorting relevant and irrelevant data. 

)o Greater risk of analysis paralysis as too much data leads to delays in decision-
making. 

o Risk of missing crucial signals in the presence of overwhelming noise. 

o Loss of eƯiciency associated to staƯ looking and validating data longer. 

• Business Examples: 

o A retail chain confused about what the best price to set is because of conflicting 
online and oƯline sales data. 

o A doctor inundated with epic patient records and clinical trial reports, delaying 
strategy formulation. 

• Possible Remedies (without AI): 

o Utilization of dashboards to highlight KPIs. 

o Transfer responsibility for collection of data to specialized departments. 

o Prioritization techniques such as Pareto Principle (80/20 rule). 

Human Bias and Subjectivity 

• Definition: 

o Human bias means that people will depend on instinct, feelings or pre-formulated 
opinions rather than scientific evidence.” 

o Interpretation of data is subjective and this subjectivity may result in poor 
decisions. 

• Types of Bias: 
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o Confirmation Bias: Accepting information that reinforces your beliefs. 

o Anchoring Bias: We put extra value to the first piece of information that we received 
(first impression, starting number). 

o Recency Bias: Overemphasizing the significance of recent events at the expense of 
longer-term trends. 

o Groupthink: Teams not generating conflict and going along with strong voices 
without a lot of individual critique. 

• Consequences: 

o Strategic implications like betting on unprofitable markets. 

o Lack of innovation resulting from over-reliance on past accomplishments. 

o Ignore critical risks which don’t correspond to the ideas of the leadership. 

• Illustrative Cases: 

o Tech companies ignoring market research and releasing products à Based on And 
so forth. 

leadership’s hunch, causing lack of acceptance. 

o Over-reliance on models and failure to question assumptions leading financial 
institutions to underestimate risk in 2008. 

• Mitigation Practices: 

o Promoting a diversity of teams and perspectives. 

o Introducing structured decision-making frameworks. 

o Integrating quantitative models with expert judgment. 

o Applying such test as devil’s advocate and red teams. 

9.2.4 Role of AI in Strategic Planning 

AI alleviates several constraints of the conventional decision-making process by 

providing higher-order features to replicate situations, predict trends, and optimize 
strategies. These features enable the capacity for improved accuracy, speed and 
flexibility in longer term planning, positioning AI as a key enabler of strategic decision-
making. 

Scenario Modeling 

• Definition: 

34
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o Scenario modeling uses AI-fueled simulations to assess diƯerent possible futures 
depending on altered conditions. 

o It enables companies to deal with uncertainty – by “piloting” strategic options. 

• How It Works: 

o AI.generate predictive models based on large datasets (market, economic, and 
operational). 

o Other assumptions (such as demand fluctuations, regulatory changes and 
availability of resources) are used to develop scenarios. 

o Decision makers employ results to consider the most robust alternative. 

• Applications: 

o Supply chain optimization with volatile fuel prices and demand schedules. 

o Capacity planning for healthcare services in pandemic situation. 

o Banks testing portfolios under various economic down-turn scenarios. 

• Benefits: 

o Enables proactive decision-making. 

o Minimizes risk by exposing the vulnerabilities. 

o Provides greater certainty for long-term investment. 

• Challenges: 

o Need for good and diverse dataset. 

o Relying too heavily on models might not account for unexpected shocks. 

Trend Forecasting 

• Definition: 

o Trend forecasting uses AI and machine learning to forecast future consumer, 
market or industry trends by analyzing past data and real-time signals. 

• Methods: 

o Long-term status (time-series) analysis for prediction. 

o Social media and news sentiment analysis for consumer preferences. 

o Predictive analytics for demand prediction in retail or manufacturing. 
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• Applications: 

o Fashion and retail predicting seasonal trends and the inventory required. 

o Marketing departments forecasting customer behaviour for targeted campaigns. 

o Energy providers predicting demand based on weather and consumption 
information. 

• Benefits: 

o Briefs product development and innovation. 

o Improved marketing personalization and eƯectiveness. 

o Increases production to market alignment. 

• Limitations: 

o Definitions can change dramatically in response to unforseen circumstances (like 
COVID-19). 

o Risk of misunderstandings when heuristic or social cues are missed. 

Optimization Strategies 

• Definition: 

o AI optimization is the application of algorithms to determine the best allocation of 
resources, processes or investments under certain constraints. 

• Techniques: 

o Linear/Non linear optimization models. 

o Adaptation decision making under uncertainty reinforcement learning. 

o Genetic algorithms for simulating evolutionary enhancement. 

• Applications: 

o Logistics: route planing to minimize the distribution cost and delivery time. 

o Finance: Portfolio optimization risk return trade-oƯ. 

o Manufacturing: how to schedule production to produce as much product with the 
least down time. 

o Human Resources: Maximizing use and training of work force. 

• Benefits: 
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o Cost eƯiciencies from optimal resource usage. 

o Increased operational performance. 

o Dynamic environments characterised by the need for quicker and more reliable 
decision-making. 

• Challenges: 

o High reliance on correct and up-to-date data. 

o Nontrivial problems of optimization are computationally expensive. 

o Possible backlash from staƯ who are used to using automated suggestions 

Did You Know? 

“Did you know that structured decision-making models such as SWOT, Porter’s Five 
Forces and PESTEL mean companies are 33% more likely to be above-average profit 
earners? Studies have demonstrated that when using these models in conjunction 
with data-driven insights, long-term strategic planning is made much more eƯective 
and business risks are lowered. 

9.3 Using Power Query and Power Pivot for Advanced Analytics 

9.3.1  Introduction to  Power Query 

Power Query is an enterprise-level data preparation tool that enables people to 
connect and combine data from many diƯerent sources into one coherent view for 
analysis. It oƯers a friendly user interface (UI) and automation so that data can be 
easily transformed and integrated onto business workflows. 

Data Transformation Workflows 

· Definition: 

o Data transformation processes comprise a series of operations performed on 
another dataset, often raw data, to convert it into a format or structure that makes it 
more appropriate for performing analytics. 

o Power Query automates these flows and provides consistency and eƯiciency. 

· Key Features of Power Query Workflows: 

o Source Connectivity: Pull in data from Databases, Excel Files, CSVs, Web Services 
and APIs. 

o Applied Steps: Each transformation (e.g., filtering, merging, splitting) is tracked and 
could be replayed automatically. 

2
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o Reusability : After a workflow is built, it can be re-executed with new data which in 

turn saves time. 

o   Non-Destructive Workflow: Data and transformations are kept separately from 
each other. 

·  Standard Workflow Steps: 

oImportation des informations vente brutes issues de plusieurs fichiers. 

o   Combine with customer demographics. 

o  Remove rows that are missing or not applicable. 

o  Format and name columns in a consistent manner. 

o   Consolidation of monthly files for a consolidated file. 

· Business Benefits: 

o Saves time by minimising repetitive manual work. 

o Manages data integrity among reports. 

o Allows combination of diverse and large datasets for better understanding. 

· Challenges: 

o Need to have knowledge of the transformation logic in advance workflows. 

o It may not perform very well for huge datasets. 

o  Users need to document the steps in a workflow adequately for collaboration. 

Data Cleaning and Shaping 

· Definition: 

o Data cleaning is the process of spotting and rectifying errors, inconsistencies or 
gaps in data. 

 Data Shaping: It concerns with restructuring and rearranging data set so that it fits 

for analytic requirements. 

· Data Cleaning Features in Power Query: 

o  Duplicates Removal: Cleaning redundant records to make it more accurate. 

o Missing Value: Nulls had to be replaced with an average, median or a placeholder 
value. 
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o Correcting Mistakes: For example, ensuring spelling is consistent, formatting is 
fixed. 

o  Data Type Conversion: Numbers, Dates and Text samples well formatted. 

· Data Shaping Features: 

o Pivoting / Unpivoting Columns: Changing rows to columns or vice versa to better 
analyze data. 

o Column Splitting: Dividing combined columns (e.g., “City, Country”) into 
constituent parts 

attributes. 

o Appending Queries: Appending datasets together into the same table. 

o Summing Data: Rolling-up sales amounts over a series of times (by day, month, 
etc.) o Detail Analysis Sales by time of day, category, age group ect. 

·  Real-Life Business Example: 

o  A retail organization imports files of monthly sales. 

o Data cleansing: remove duplicates and fix date formats. 

o   Transforms the data, taking month columns and unpivot them to a standard 
transaction table. 

o Writes out the cleansed data for analysis using Power Pivot. 

· Benefits: 

o Generates dependable, quality data to make decisions with confidence. 

o  Minimises... more human errors vs. manual clean up in spreadsheets. 

o Makes datasets analyzable as easily as possible. 

· Challenges: 

o Requires to be constantly monitored to adjust to the new issues of data. 

o Cleaning overhead may be excessive if steps are overly complex. 

o It should be enabled for users to validate the outputs if no information is lost. 

9.3.2 Power Pivot Essentials 

Power Pivot is an incredibly powerful tool that lives inside of Excel and Power BI (we 
will cover a bit on Power BI later in this post) that allows you to do some incredible 
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data analysis and create awesome, interactive reports. But unlike regular Excel 
formulas, Power Pivot allows relationships between multiple tables; and hierarchies 
and other measures it auto-generates give you a solid basis to create canned reports 
or dashboards that are blueprinted for business-ana lyst success. 

Data Modeling 

· Definition: 

o Power Pivot Modeling where data models are built in such a way as to match 
business processes, and facilitate easier analysis and reporting. 

o This is done by developing tables, measures, and calculated fields that allow your 
analytics remarkable flexibility. 

·  Parts of Data Model : 

o Tables: Structured data sets brought from Power Query or other sources. 

o Relationships: Connections or relations between tables (for example sales 
connected to customers). 

o Calculated Columns: Fields which are created based on other columns. 

o   Measures: Sum, average and ratio based measures developed by DAX. 

· Business Example: 

o  A financial analyst who models information from sales, customers, and products. 

o  Adds a calculated column of profit = sales – cost. 

o Measures like sales per customer are defined. 

o Construct pivot tables to analyze performance by region and time. 

· Advantages: 

o Processes millions of rows quicker than regular Excel. 

o  Brings dynamic re-usable models to diƯerent reports. 

o Provides for scenario simulation and KPI in after-glow measures. 

· Challenges: 

o A basic understanding of Relational Database concepts is required. 

o DAX learning curve is not necessarily the lowest for beginners. 

o Mismatched design of models could influence the performance and accuracy. 
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Creating Relationships and Hierarchies 

·  Relationships in Power Pivot: 

o Describe how tables related to one another via primary and foreign keys. 

o  Example: Sales table linked to Customers table by Customer ID. 

o Relationship types: One-to-many (most typical), many-to-many (using bridging 
tables). 

o Benefits: 

ü Avoids flat files to lessen redundancies. 

ü Integrative and provides deeper understanding by integrating datasets. 

·   Power Pivot Hierarchies: 

.o  For building analysis drill-down in structures. 

o Example: Geography hierarchy (Country -> State -> City). 

o Example: Time hierarchy (Year → Quarter → Month → Day). 

o Benefits: 

ü OƯers user friendly navigation to users on pivot tables. 

ü Reduces time spent on analysis by consolidating related fields. 

ü Implies multiple levels of detail needed for manageme nt reporting. 

· Business Example: 

o A company was working on sales information, so they modeled a relationship 
between product and sales tables. 

o Established time hierarchy to study sales trends by year, quarter and month. 

o Management “roll-ups” from annual sales down to daily performance, all available 
with pivot tables. 

· Advantages: 

o  The multidimensional analysis process can be supported. 

o  Provides more options for reporting. 

o Promote consistent application of organizational formats for reports. 

 9.3.3 Integrating Power Tools in Strategic Decision Making 

23
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Power Query, Power Pivot and Power BI can all be stitched together to create a totally 
integrated platform for hardcore analysis. Jedox and Qlik solutions combined provide 
companies with the means to cleanse and convert data, model businesses, develop 
complex calculations, share insights using interactive dashboards. This unification 
allows companies to make informed, real-time decisions based on evidence. 

Dashboards and Reporting 

·   Power BI Dashboards: 

o Allow interactive, visual display of business information. 

o  Be able to see soon the current KPI and trend. 

o People can drill down from the high level stuƯ tothe granular details. 

· Key Features: 

o   Visuals: Charts, graphs, maps and KPI cards. 

o   Interactivity: Filters, Slicers and Drillthrough for more complete story telling. 

o Integration: It should be able to consume data from Power Query (ETL processes) 
and Power Pivot (models). 

o Sharing: Team-wide sharing of reports using cloud based services. 

·   Commercial Uses: 

o Stokeholders track revenues, expenses and profits with dynamic dashboards 56   
100 // 

o Marketing teams can monitor campaign performance, engagement and ROI in real 
time. 

o Operations keep an eye overall supply chain eƯiciency, downtime and logistics. 

· Benefits: 

o Fosters transparency between departments. 

o Allows faster, data driven decisions. 

o Enhances teamwork through “common knowledge”. 

· Challenges: 

o Strong, consistent governance is needed to ensure data sources are predictable o A 
high level of success in corporate culture maturity for organization-wide and business 
unit specific projects. 

7
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o  Complex dashboards can confuse users if given the chance. 

o Privacy needs to be secured for sensitive data. 

 

 

Knowledge Check 1 

Choose the correct option: 

What platform allows people to link and clean data from various sources? 

a. Power Pivot, b. Power BI 

c. Power Query   d. Excel Functions 

What item in Power Query logs all the individual transformation steps? 

a.  Data Model b.Pivot Table 

c: Image   d: Query Editor 

What is the language of Power Pivot for complex calculations? 

a. SQL b.VBA 

c. M Language   d. DAX 

Which visual combines Power Query and Power Pivot to build a dynamic dashboard? 

a. Excel   b= Power BI 

c. Tableau  d. Access 

9.0 Practical Work Assignment: Simulation for Business Decisions based on AI. 

The purpose of this case is to provide the opportunity for learners to apply Artificial 
Intelligence (AI) Tools Power Query Power Pivot and Power BI in making business 
strategy decisions. Students will be taught how to clean, model and analysis business 
data in order to create insights by doing with real or simulated datasets. 

Assignment Steps: 

Dataset Selection: 

o Students receive an example dataset (sales transactions, customer demographics or 
supply chain data). Or they can select a publicly available business related dataset. 

Data Preparation (Power Query): 

o Load dataset into Power Query. 
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o   Cleanse the data (remove duplicates, treat missing values, regular expression) and 
standardize formats in a required format. 

4o   Restructure the dataset: This can be done by combining or separating fields, and 
normalizing multiple files (if any). 

Data Modeling (Power Pivot): 

o Open the scrubbed data into Power Pivot. 

o Establish relationships between tables (like sales and customer data). 

o  Create calculated columns (such as Profit = Sales – Cost) and measures (like 
Average Sales per Customer). 

o Build drill-down hierarchies for analytical purposes (Year  Quarter  Month.) 

Deliverables: 

· A tidyed, transformed, and processed dataset (Excel / Power BI file) 

·  A Power BI dashboard/report containing a minimum of three KPIs and one scenario 
analysis. 

· A short (250–300 word) reflection describing how AI-based tools made the decision-
making process more eƯective compared to traditional approaches. 

9.5 Summary 

v Artificial intelligence (AI) enables machines to act and think as natural beings do; 
business evolves towards data-driven strategic decision-making. 

v Narrow AI is intented for specialized task but General AI is only a theorectical concept 
which strives to reproduce human intelligence in various domains. 

v Fundamentals of AI This involves Machine Learning, Expert Systems, Natural 
Language Processing and Computer Vision to mention just some few which each have 
specific focus areas that applies in them. 

v Businesses utilize AI for customer service automation, predictive analytics, and 
recommendation systems to improve eƯiciency and personalization. 

v Directives in AI The ethical and legal aspects of AI are concerned with the protection of 
data privacy, dealing with algorithmic bias, compliance with regulation etc. 

v  Models for strategic guidance: SWOT, Porter’s Five Forces,etcоловные модели 
встратегическом управлении) 

and the PESTEL framework. 

29
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v Data-based decision-making driven by premium-quality data, the KPIs and 
performance measures play a central role in success measurement. 

v Conventional decision making is not withouth challenges such as overwhelming 
information and human bias resulting in delay or wrong strategies. 

v AI can help to facilitate strategic planning, such as scenario modeling, trend 
prediction and optimal strategies that provide greater simulation and eƯiciency 
capability. 

v Power Query helps you clean, transform and shape data from a range of sources for 
further analysis. 

9.6 Key Terms 

Artificial Intelligence (AI): The process of imitating human intelligence into a machine 
so that the machine is able to learn on its own, reason and make decisions. 

Weak AI: An AI system that is purposed for a narrow range of tasks (e.g., voice assistant, 
chatbot or recommendation engine). 

Machine Learning (ML): One part of AI but not all, ML is when a system learns patterns in 
data to make predictions or decisions directly without programming them explicitly. 

Natural Language Processing (NLP): AI technology used for machines understanding, 
interpreting and generating human language. 

SWOT Analysis: A strategy tool used to examine an organization’ beginnings, o r g a n i z 
a t i o n Manlangit 8 Strengths, and Weaknesses in its approach to Opportunities, 
Threats or weakness. 

Opportunities, and Threats. 

Key Performance Indicators (KPIs): Metrics to gauge progress in relation to business 
objectives. 

9.7 Descriptive Questions 

Explain what Artificial Intelligence is and describe the diƯerence between Narrow 
AI(Good) and General AI (Bad), giving relevant examples where appropriate. 

Explain four of the main components of AI-- machine leanring, natural language, 
computer vision, and expert systems-- and how they're used in a business sense. 

How does AI change the game for customer service automation? List and discuss at 
least two examples of industries in which AI is being used for customer interactions. 

Explain predictive analytics in business. What are some of the ways in which 
businesses leverage predictive analytics to make better decisions? 

10
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Explain the role of ethics and laws in AI such as data privacy, algorithmic bias, and 
regulation. 

Analyze and compare the SWOT Analysis, Porter’s Five Forces an PESTEL framework as 
strategic. 

decision-making models. 

What is the relevance of data in strategic planning? How do you go about decision 
making process through the nut and bolt of KPIs? 

Emphasize the problems with classic decision making: too much information and 
human bias. Provide examples. 

Discuss how AI helps to identify scenarios, trends and optimization strategies in 
strategic planning. 

Describe the function of Power Query and Power Pivot for advanced business 
analytics. Where do these land in the Power BI world to help make strategic business 
decisions? 
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d. DAX 

b. Power BI 

 

 

9.9 Case Study 

“NovaMart: AI for Reconstructing OƯline Retail Strategies” 

Introduction 

NovaMart – a mid-sized retail chain with 120 plus stores spread across India, was 
heavily dependent on legacy-style business processes for running its operations right 
from CRM to Supplychain. The company's reputation was that of an aggressive pricing 
retailer with a wide variety of products, narrow margins and customers in regional 
locations throughout England. But as e-commerce marketplace and analytics-based 
rivals emerged, NovaMart faced plummeting margins, customers losing trust in the 
brand and decision making that was cumbersome. 

Leadership knew that running the business as usual would not work in a digital-first 
world. Hopes even slower but why am I in a rush? They needed to be able to 
incorporate AI packages such as Power Query, Power Pivot and Power BI into their 
analytics environment so that they could explore advanced forecasting, touching on 
things like optimization and customer-centric strategies. 

Challenge 1: IneƯective Customer Service & Decreasing Satisfaction 

NovaMart had call-center style customer service that was slow to pick up, and not very 
good at solving problems. Customers were demanding faster, personalized touchpoints 
and the company lacked the ability to meet at scale. Inevitably, customer complaints 
surged 20% over two years — and rivals with A.I.-powered chatbots got an edge. 

Solution: 

The business has installed an AI-based customer service automation system with 
Natural Language Processing (NLP) technology. Chatbots were launched on the website 
and mobile app, addressing questions about products available/logistics/ status of 
orders/return polices. ByconnectingthesebotswithCRMdata,responses 
werepersonalizedtoeachcustomer’spurchasehistory. Withinsixmonths,first-
responsetimesdecreased by60%,andcustomersatisfactionscoresimprovedsignificantly. 
ThisautomationalsoQfGuy8791Liberatedhumanagents in the performance of more 
complex cases resulted in increasing eƯiciency throughout the service function. 

Issue 2: Lack of Demand Forecasting and Overstocking 

2
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NovaMart primarily utilized a manual forecasting by historical averages and manager’s 
experience for inventory management. It was not perfect, however; this system made 
ordering clumsy and often resulted in orders for items that would sit too long or 
workdays. Losses on unsold merchandise equaled almost 8% of annual revenue. 

Solution: 

ThecompanyshiftedtopredictiveanalyticspoweredbyAI. Data such as sales history, 
seasonal demand, local events and even weather predictions were brought together 
using Power Query and modeled in Power Pivot. DAX measures enabled 

Issue 4: Traditional Methods Cramps the Space for Strategy What are the concepts 
“strategy” and “strategic planning”? 

Mordochovitz and his colleagues at the company’s top struck a SLOR’ building on SWOT 
analysis and following their guts in mapping out strategies to adopt. While eƯective, 
this approach was slow and could not account for the 'real world' dynamics of a 
market. The decision to expand stores, set prices or introduce new products was often 
made in response to what its competitors had done. 

Solution: 

At NovaMart, AI powered both scenario simulation and trend forecasting. Managers 
leveraged Power BI’s “What-If” parameters to test the eƯects of various price options, 
discount schemes and promotional eƯorts against sales and profit scenarios. Leading 
indicators from the market, in the form of consumer preference shifting and competitor 
actions, were integrated into dashboards. It has given leadership a live, interactive look 
at multiple kinds of scenarios. Thus, NovaMart had the opportunity to act faster and on 
evidence-based foundation when it came to store expansion, seasonal campaigns or 
when going for a product portfolio change. 

Problem 5: Overloaded and Biased Humans 

Managers would typically drown in a deluge of sales reports and siloed data from 
diƯerent departments. Human factors, such as the tendency to overuse evidence of 
past experience or risk condemnation from others, aƯected decision-making. This led 

to internal inconsistencies and, on occasion, expensive strategic mistakes. 

Solution: 

Scaling and getting more granular was easy as we had Power Query, Power Pivot, and 

Power BI available as part of a single analytics ecosystem. Dashboards aggregated KPIs 
from finance, marketing, operations and HR into one view, to minimize clutter. 
Objective analyses eliminated subjective decisions with real time information support. 
Leadership training was also put in place to help managers interpret AI outputs and 
make data-informed rather than gut-driven decisions. 

7
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Reflective Questions 

In what manner did the AI enabled customer service automation ascertain NovaMart to 
resolve its deteriorating customer satisfaction and how can they address such an issue 
more applicable in this arena? 

How did predictive analytics contribute to NovaMart’s better inventory control and 
how? 

would there be applications of such techniques to supplier negotiations or logistics 
planning? 

How did recommendation systems contribute to better marketing eƯiciency, and what 
are the ethical challenge they face when customizing customer experiences? 

What is it about AI-based scenario modelling that outperforms more common tools 
such as SWOT or PESTEL when informing decision making strategically? 

What’s at risk if NovaMart leans too heavily on AI-generated insights and how should 
leadership keep the human and machine in check here? 

Conclusion 

NovaMart is a case in point of how mid-market companies can revolutionize the way 
they come to strategic decisions by using AI. The firm was able to significantly enhance 
the competitiveness in highly competitive retail market, while responding quickly to 
problems such as customer service, demand forecasting and personalized marketing. 
Key tools such as Power Query, Power Pivot and Power BI formed the backbone for data 
preparation, modelling and visualisation which helped enable leadership to make 
informed agile decisions.” At the same time, the story underscores why we need to 
balance technology with ethical considerations and human judgement. The NovaMart 
journey is testament to the fact that AI is not just a tool focusing on operational 
eƯiciency, but rather a transformational force that has the potential to rewrite the 
bedrock of business success and continuity. 
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Unit 10: Data Visualisation using AI 

 

Learning Outcomes 

 

1. Use AI-powered tools within Excel for insights. 

2. Apply Natural Language Queries (NLQ) to generate visualizations. 

3. Forecast trends using AI tools. 

4. Build AI-generated dashboards using Data Squirrel. 
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10.1 Natural Language Queries 

“AI-Powered Insights at RetailMart" 

RetailMart, a fast growing retailer with more than 200 stores nationwide was struggling 
to make sense of sales trends, maintain stock levels and communicate real time 
information with regional managers. Their current BI solution was heavy on technical 
expertise and manual querying, which made it challenging for non- technical users to 
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extract actionable intelligence. To address their requirement for more user centric and 
intelligent data tools, RetailMart leadership decided to invest in AI aided data 
visualisation platforms. 

Inclusion of Natural Language Querying (NLQ) capabilities directly within their 
dashboards enabled store managers to ask questions such as “What products sold the 
most in the north last month?" and receive instant visual answers. That created much 
less reliance on the analytics team. 

In addition, they engaged AI-driven predictive forecasting models to predict future sales 
and inventory requirements. By utilising past data, AI algorithms have forecasted 
surges in demand for festivals or seasonal transitions, thereby enabling RetailMart to 
manage their stock better and minimise wastage. 

The company also modernized its executive dashboards through its use of AI powered 
tools such as Power BI with Smart Narratives and Tableau’s AI-driven insights. 
Dashboards would automatically call out key trends, anomalies and KPIs, enabling the 
decision-makers to take a macro view without having to man-handle data themselves. 

In 6 months, RetailMart had cut their inventory costs by 20% and sped up decision 
making by about 30%. The AI model approach increased data accessibility to every 
stakeholder in the organization down to floor managers, while ensuring each individuals 
received actionable insights when they needed them. 

Critical Thinking Question 

In what ways did AI-driven tools alter access to data and decision making for various 
roles at RetailMart, and what are some potential issues that may stem from relying too 
much on AI-sourced insights? 

10.1 Natural Language Queries 

 We know natural language queries and simplessemphasis do not mix! 

Natural Language Queries (NLQ) is the practice of human language as spoken by people 
to interact with data and analytics systems. Instead of knowing how to write SQL 
queries or learning a highly specialized coding language, you can just type-in or speak 
questions like “Show me sales growth in the last quarter” and get immediate visualized 
answers. In this section, we will delve into how Natural Language Processing (NLP) 
facilitates these interactions and survey popular AI-based tools as well as their 
respective pros and cons. 

10.1.1  Introduction to NLQ: Analysing Plain English Queries 

Natural Language Queries: The New Standard in Business Analytics 
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Natural Language Querying (NLQ) is a leap-forward technology in the analytics and 
visualization space, especially for nontechnical users like business students and 
professionals. 

Until now, if you wanted to work with data, you had to know complex formulas, use 
programming languages such as SQL or DAX, or learn business intelligence tools. But 
given NLQ capabilities, users are now able to query data systems by just typing 
questions in everyday language—“What were total sales by region Q1 2022?” — and 
get back results in the form of tables, graphs or summaries without requiring 
specialized training. 

NLQ is a subset of Natural Language Processing (NLP): an aspect of artificial 
intelligence that empowers machines to understand and respond to human language. 
With spread databasesheet tools such as Microsoft Excel or business intelligence 
software like Power BI being able to accept NLQ, users can now sift through 
information naturally. This advancement has allowed common people who are not 
scientist to be able to analyse data as well. 

For business students, however, NLQ is especially useful. In practice, there are 
important decisions to be made in real-world scenarios that prompt for quick decision-
making from professionals who do not always have the time to run a technical analysis. 
This is because NLQ allows them to gain insights on-the-fly and share those insights 
without any technical restraints. 

Elements of NLQ for Data Tools 

Note to plain English input: At the core of NLQ is the user's ability to type questions 
naturally. The user doesn’t have to write =SUM(B2:B12) in a cell and instead can just 
ask, ‘What is the total sales?’ and receive the corresponding value. 

Intent Recognition: The AI in NLQ reads the user’s intent from this query. For instance, 
if a user writes, “Which product category performed the best in Q3?”, the model uses 
that it has to rank them by performance at a quarter. 

Context Awareness: Sophisticated NLQ are aware of previous queries or the data 
patterns. So if the dataset has columns like Date, Region and Sales, and a user types in 
“show regional sales,” the tool understands what is meant by “regional” in relation to 
available data columns. 

Real-Time Processing: Answers can be produced in <1 second and contain dynamically 
generated drill-down pivot tables, bar charts or line graphs or even text summaries. 

User-Focused Design: These solution are ideal for business users, managers, 
marketers and students who require insights but lack the time or training in advanced 
analytics. 
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NLQ in Microsoft Excel 

NLQ is also integrated in Microsoft Excel’s “Analyze Data” (formerly known as “Ideas”). 
Once a dataset is imported into Excel, users can open the Analyze Data pane and type 
natural language questions such as: 

· “Total profit by month” 

“Average order value in California” 

· “Sales trend over years” 

Relevant charts, figures and visualizations are posted in return. 

This is particularly helpful for students working on a case study, project data or 
assignments where visual storytelling is critical but time to analyze more deeply for 
patterns and outliers is scarce. 

Benefits of Using NLQ in Business Education 

Accessibility: Even students with no technical skills can play in data analysisland. 

Leveraging Speed and EƯiciency: Quick feedback makes it easy for learners to submit 
diƯerent queries rapidly. 

Better Decision Making: There is less cognitive burden in digesting data when using 
NLQ; that burden can be reallocated to interpretation and action. 

Engagement: Interactive and easy to use tools help students interact and play with 
their data. 

Limitations and Considerations 

Although NLQ makes it easy to access data, it is not without its own limitations: 

· Query sensitivity: The phrasings may produce severe changes in VD results, including 
zero resulting replication scenarios (when VD does not understand the question). 

· Data Structure Dependency: NLQ is dependent on properly-formatted data with 
meaningful column names and consistent format. 

· Limited Complex Analysis: More advanced or nuanced analysis (e.g., regression 
modeling) generally is not possible with NLQ alone. 

For educators, this means teaching students not just to use NLQ but also how to 
design datasets and shape queries such that you get an accurate response. 

10.1.2  Generating Charts and Tables without Formulas 

One of the key usages of NLQ in spreadsheet environments such as Excel is to 
summarize data visually and tabularly, without writing any formal expression. This 
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capability represents a paradigm shift in data visualization education, particularly with 
students who are not from technical disciplines (e.g., business, marketing, and 
finance). 

Instead of sweating the syntax and formula logic, students can now concentrate on the 
story their data tells them, what patterns are emerging and what actions might be 
indicated – all good business decision-making practice. 

Analysis Data Using Excel – “Analyze Data” Tool 

The chart and table visual language can be implemented with Microsoft Excel’s Analyze 
Data panel (located in its Home tab). 

Key Functionalities 

Automatic Visualizations: When Excel will load a dataset and when the Analyze Data 
panel is selected, it reads the sheet and recommends more than one visualization e.g. 

· Clustered Column Chart 

· Line graphs 

· Pivot tables 

·   KPI summary (highest, lowest and average) 

Interactive NLQ Input Box: Type your questions (some examples): 

· “Monthly sales by product line vs. last year” 

· “What is the mean discount per region?” 

· “Customers added trend quarterly” 

No Equations to Write Down: All calculations and transformations are performed 
behind the scenes. The end user gets visual outputs, such as tables and with 1 click. 

Insert Straight Into Sheet: If I produce a chart or table, in one click I can put it straight 
into the workbook ready to present! 

Step-by-Step Example 

Scenario: A student has a data-set with columns Order Date, Region, Product category 

versus Sales and Profit. 

Steps: 

Select the entire dataset. 

Click on the Home ribbon “Analyze Data.” 

Enter suggested insights, or type a question: "Total sales by region". 
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You get a PivotChart in Excel that shows regions across the x-axis and sales up the y-
axis. 

Click “Insert Chart” to insert the visualization into the worksheet. 

There's no need for a use of formulas such as SUMIF, VLOOKUP or PivotTables 
manually. 

Types of Visuals Commonly Generated 

Visualization Type Common Use Cases 

Column Chart Comparing sales across categories or regions 

Line Chart Showing trends over time 

Pie Chart Market share or proportion-based comparisons 

Scatter Plot Analyzing correlation between two variables 

Pivot Table Summarizing large datasets with multiple dimensions 

Not only that, these visuals oƯer compelling stories and ease of digest in terms of how 
data behaves with diƯerent business contexts. 

Customizing the Output 

Once created, charts and tables are completely editable: 

• Users can change chart types 

• Modify labels, colors, and titles 

• Filter data interactively 

• Include annotations or callouts for narrative telling 

This versatility makes it easy for students to be able to customize visuals for reports, 
presentations or submission of case studies rather than create them from the ground 
up. 

Educational Applications 

Educational environments could have students analyze and explore a data set and 
invite them to: 

• Utilize NLQ for producing a list of insights 

• Select the right visualizations to convey those insights 

• Do not use Excel formulas for any reason 

• Rationale for the Graphics based on data story 
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This not only encourages creativity and make a decision but also goes in line with 
today’s world where tools such as Tableau, Power BI, and Excel are increasingly used 

to have support for NLQ. 

Best Practices for EƯective Use 

Clean Your Data First: Make sure you have non-generic column headers and error-free 
and standardized data. 

Use Concrete Queries: Loose queries such as “show sales” may not yield as useful 
results as “monthly sales trend in electronics category”. 

Leverage Recommendations: Excel makes recommendations for questions and charts 
based on the dataset’s 

patterns. 

Interpret Before Utilizing : Although they are auto-generated, critical thinking is still 
needed for charts interpretation. 

Skills Developed 

Through exposure to NLQ-based chart and table construction, students will gain the 
following: 

• Thinking Analytically: Identifying and interpreting key metrics 

• Visual Communication: Visuals in arguments and decisions. 

• Explore Data: Asking the right questions and finding insights 

• Tool Skills: Getting to know AI-infused business tools 

These habits are critical for business school graduates stepping into positions in which 

data-aided decision needs to be a value creation driver. 

10.1.3 Business Use-Cases of NLQ in Excel 

Data analysis and interpretation has significantly evolved from being the exclusive 
domain of statisticians to become an essential skill for business leaders at every level in 
today’s data-rich world. In the past, analyzing data in a tool such as Microsoft Excel 
required an extensive knowledge of formulas, functions, and pivot tables. But the 
addition of Excel's Natural Language Query (NLQ) feature has made it so that most 
business users can now use data: 

Questions can be asked in plain english and the answers are returned as charts, tables 
or summarized insights. For business practitioners and students, this would signify 
quicker decsion- making. 
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generation, less dependence on technical analysts and enhanced flexibility for the 
competitive business environment. 

Real life business use cases of NLQ in Excel Here are some examples of real life 
business scenarios where natural language querying can work very well within Excel: 
Marketing : a marketing analyst wishes to extract sales by customers with the highest 
likelihood to buy, based on online or oƯline campaigns Finance: accountant gathers 
sales and costs information from budget, actual and forecast built from day-to-day 
operations Sales: how many iPhones have been sold last month before new model gets 
released. 

Sales Performance Analysis 

The REGEX function is extremely powerful to provide a sales team insight how its 
performance appears on several dimensions without needing complex formulas. 

Example Queries: 

• “Total sales by region for Q2” 

•“Compare monthly sales in 2022 with those in 2023.” 

•“What product category generated the most money? 

Applications: 

• Identify top-performing products or territories 

• Track seasonal sales trends 

• Detect underperforming regions 

Benefits: 

• Allows regional managers or salesmen to conveniently create dashboards of 
performance 35 

• Aids in the establishment of sales goals and bonus distribution 

• Save time writing and badly formatting pivot tables and summaries. 

Marketing Campaign Analysis 

Marketing organizations frequently rely on spreadsheets that include information on 
campaign performance, customer engagement or lead generation. NLQ makes it easy 
to get a sense for how well your campaign is doing. 

Example Queries: 

• “How much are people clicking on my ads, by channel?” 
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• “Did the summer campaign change how many people went to the site?” 

• “Compare engagement rates across campaigns” 

Applications: 

• Measuring the ROI of marketing campaigns 

• Measuring and comparing engagement on email, social, paid ads 

• Pinpointing the least expensive marketing avenues to pursue 

Benefits: 

• Enables marketers to build their own insights without relying on data analysts 

• Supports data-backed marketing strategy decisions 

• Improved campaign optimizations via real time responses 

Financial Analysis and Forecasting 

Finance professionals frequently have to examine revenue, expenses, profits and 
financial ratios. NLQ supports rapid drill-downs and comparisons over time or across 
entities. 

Example Queries: 

• “FY2023 total departmental expenses” 

• “Year-over-year growth in net profit” 

• “Show me revenue vs cost over the last 6 months” 

Applications: 

• Departmental budget reviews 

• Financial health monitoring 

• Automated variance analysis 

Benefits: 

• Manages human errors that occur when formula is applied incrementally 

• Speeds up month-end reporting processes 

• Encourages real-time monitoring of financials to better manage movement 

Inventory and Operations Management 

The NLQ can be used to query the operational data such as inventory, stock movement, 
order fulfillment times for day-to-day decision making. 

Page 12 of 56 - Integrity Submission Submission ID trn:oid:::3618:127049219

Page 12 of 56 - Integrity Submission Submission ID trn:oid:::3618:127049219



Example Queries: 

• “What things are running out of?” 

• “Average delivery time by supplier” 

• “Total stock value by category” 

Applications: 

• Inventory optimization and replenishment planning 

• Supplier performance evaluation 

• Identifying bottlenecks in delivery operations 

Benefits: 

• Helps supply chain managers to take prompt purchasing decisions 

• Reduction on stockouts and oversupply products gang stalker app for android. 

• Increase service levels and enhance customer experience 

Customer Insights and Segmentation 

The knowledge of the customer's attitude and behaviour is critical for directed 
marketing activities as well as for establishing relationship with the customers. With 
NLQ, datasets involving customer demographics, buying behavior and responses to 
feedback can be examined. 

Example Queries: 

• “Top 5 customers by revenue” 

• “Purchase value per age group” 

• “Customer satisfaction score by region” 

Applications: 

• Customer lifetime value analysis 

• Personalized campaign targeting 

• Loyalty program segmentation 

Benefits: 

• Increases accuracy of customer profiling and segmentation 

• Encourages data-driven customer engagement strategies 

• Supports customer retainment and upsell campaigns 
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Human Resource (HR) Analytics 

HR departments may use NLQ to track metrics related to employee data (i.e. turnover, 
performance ratings and training results). 

Example Queries: 

• “Attrition rate by department” 

• “Average salary by job role” 

• “How many hours of training each employee conducted completed? 

Applications: 

• Workforce planning and diversity monitoring 

• Compensation analysis 

• Evaluating training eƯectiveness 

Benefits: 

• Promotes evidence-based HR decisions 

• Identifies departments with high attrition 

• Improves the management and reporting of HR metrics 

Project Management and Performance Tracking 

For project managers, an excel spreadsheet may contain timelines, milestones, 
resource usage and percent of tasks completed. It lets you see the results right away — 

even without creation of complicated dashboards. 

Example Queries: 

• “Tasks completed by each team” 

• “Milestone delays in Q1” 

• “Time spent per resource in the previous month” 

Applications: 

• Monitoring project health 

• Identifying resource constraints 

• Ensuring timely project delivery 

Benefits: 

• Minimize reporting lag in project reviews 
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• Data visibility results in team accountability gains 

• Keeps project activities in line with business objectives 

Retail and Point-of-Sale Analytics 

Store managers focusing on sales receipts, SKU performance and foot traƯic data can 
leverage NLQ to make quick store-level decisions. 

Example Queries: 

• “Top-selling items last weekend” 

• “Sales per square foot by store” 

• “Customer footfall trend of 30 days” 

Applications: 

• Stock planning for peak hours 

• Product performance based promotions planning 

• Measuring store eƯiciency 

Benefits: 

Education and Learning Analytics 

Schools and trainers gather information on students attendance, attainment and 
progression. 8.NLQ can facilitate the academic reporting and planning. 

Example Queries: 

• “Average score by subject” 

• “Attendance rate by class” 

• “Students at risk of failure” 

Applications: 

• Curriculum planning and intervention 

• Identifying teaching eƯectiveness 

• Reporting for accreditation and audits 

Benefits: 

• Supports student-centric decision-making 

• Savings in time require for assessment summaries 

• Encourages proactive academic interventions 
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Startup and SME Reporting 

For startups and SMB, it's important to have data insights without hiring analysts. Excel 
with NLQ provides aƯordable self-service anlaytics. 

Example Queries: 

• “Monthly revenue vs expenses” 

• “Customer acquisition cost over time” 

• “Services” in “top selling services by profit margin” 

Applications: 

• Startup pitch deck creation 

• Investor reporting 

• Business model validation 

Benefits: 

• Minimizes cost of analytics tools 

• Encourages founder-driven insights and innovation 

• Accelerates performance reviews and turns. 

Summary of Business Applications 

Business Area Common NLQ Use-Cases 

Sales Performance tracking, regional comparisons 

Marketing Campaign ROI, channel eƯectiveness 

Finance Budgeting, forecasting, cost analysis 

Operations Inventory levels, supply chain monitoring Customer Management 
Segmentation, satisfaction, revenue contribution Human Resources Attrition, 
compensation, training eƯectiveness Project Management Task completion, resource 
allocation 

Retail POS data, merchandising, footfall 

Education Student performance and attendance tracking 

Startups/SMEs Financial KPIs, CAC, product performance 

This post has demonstrated the ways in which NLQ for Excel can transform a variety of 
business functions and permit anyone to find insights without being technical. When 
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taught well, these skills provide business students with useful data literacy and 
decision-making tools. 

10.1.4 Role of ChatGPT/Copilot in Assisting with Formulas 

In the conventional way of using Excel, it is pre requisite for users to have a good 
knowledge on what are cells, functions and logicals etc. For business school students 
and executives, this can be tricky to navigate, especially with more complex 
calculations, nested functions or unfamiliar use cases. A new way of working with 
Excel—open, intuitive and conversation-driven—is born through the surfacing of AI 
apps like ChatGPT or Microsoft Copilot, where memorization of formulas is a secondary 
activity. 

AI assistants can be trained to understand user requests in natural language to 
produce structured Excel formulas. This functionality improves productivity, minimizes 
mistakes and creates a understanding environment for new and non-technical users. 

Task: Excel Formula Help in Chat with ChatGPT 

OpenAI's ChatGPT, an AI language model, could work as a formula generator, explainer 
and tutor for Excel users. Users may type prompts like: 

• “Develop a formula to determine average sales per region. 

• “What’s the formula for finding the year from a date?” 

• “What is the distinction between VLOOKUP and INDEX-MATCH?” 

Key Use Cases: 

• Formula Generation: 

ChatGPT is able to translate natural language inquiries into precise Excel formulas. For 
example: 

o User Input: But I want the diƯerence between B and C only where A is greater than 
100. 

o ChatGPT Output: =IF(A2>100, B2-C2, "") 

• Formula Explanation: 

It is often more diƯicult to understand a formula than to apply it. With the help of 
ChatGPT, any formula can be translated into plain English. For example: 

o Formula: =IF(AND(B2>50, C21000") 

=A2 & " " & B2 
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These are some examples of AI-based tools that make common tasks easier for 
students and workers. 

10.1.5 Using AI for Data Cleaning and Visualization Ideas  

Data cleaning and wrangling sets the stage for data analysis and visualization. That’s 
no problem, you’ll just have to clean the raw data first. Historically, this was not 
something that could be cleaned it Excel without at least partly doing so manually. For 
this, there’s solid support from AI tools like ChatGPT and Copilot to help identify clean 
and wrangle data. 

Moreover, AI can assist users in what is the optimal way for a user to visualize their 
forest by studying patterns or focus areas of the data and suggesting chart types or 
dashboard layout. This extrapolation is particularly useful for students learning the 
basic principles of data storytelling. 

AI-Powered Data Cleaning in Excel 

AI-supported tooling may help users to detect and resolve common data quality 
problems such as: 

Inconsistent Formatting: 

• Problem: Dates are formatted as text or in more than one format. 

• AI Prompt: “Change column A into the same date format (DD-MM-YYYY). 

• Output: Correct with some process or formula such as =TEXT(A2,"DD-MM-YYYY"). 

Missing Values: 

• Problem: Blank or NULL cells. 

• AI Prompt: “I want to fill in column B with the average where there are blank values.” 

• Output: =IF(B2="", AVERAGE(B:B), B2) 

Duplicate Entries: 

• Problem: Duplicate records that influence the total/sum or counting. 

• AI Prompt: "How to delete duplicate values from a database in column A and B?" 

•Output: How to make use of Excel’s built-in “Remove Duplicates” or a formulaic 
approach. 

Case Standardization: 

• Issue: Variation in text cases, like NEW YORK, new york, New York. 

• AI Suggestion:Add =PROPER(A2) or =UPPER() to regularize. 
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Outlier Detection: 

•Prompt : “Locate values in column C that stand 2 standard deviations away from the 
mean.” 

•Output: A formula that alerts or that filters out those outliers. 

Visualization Ideas from AI Tools 

Once the data has been cleaned, AI can help give intelligent recommendations on how 
to visualize it based on its structure, key metrics and patterns. 

Common Prompts and AI Responses: 

Prompt: “What chart should I use to show how sales compare across regions over 
time?” 

• AI Response: “Use a line graph with time on the X-axis and sales on the Yaxis, broken 

by region using color codes.” 

Task: “What does the dashboard for an eCommerce dataset look like?” 

 AI Response: 

• KPI Cards: Sales, Orders, Average Order Value 

• Vertical Bar Chart:Sales by Product Category 

• Line Chart: Trends in Sales Over Time 

• Pie Chart: Payment Method Distribution 

• Table: Highest Revenue-Generating Products 

Prompt: “Think of ways to visualize grocery store customer satisfaction survey results. 

• AI Suggestion: 

 Likert-scale summary: Stacked bar chart 

 Open text responses: Word cloud 

 Aggregate ratings Star ratings or average score with KPI cards 

Advantages for Business Students 

Focus on Interpretation: 

AI eliminates the need for manually preparing data, enabling students to focus on 
deriving insights and making strategic recommendations. 

Hands-On Learning: 
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Rather than rote keying of chart types to visualise characteristics, students learn to 
align data attributes with recommended visuals using AI-driven suggestions. 

Iterative Exploration: 

Students can pose several visualization questions, experiment with alternatives and 
dynamically refine their layouts resembling real data exploration practice. 

Professional Output: 

The quality of the AI-assisted dashboards and visualizations is usually at least as good 
as that which would be expected for an academic or business presentation. 

Comparison table: traditional and AI-fueled workflows 

Task Traditional Excel -Assisted with ChatGPT/Copilot 

Fill missing values 

Standardize date format 

Choose chart type 

Build dashboard layout 

Clean categorical entries 

Manual formulas or mputation 

Use of TEXT() or DATEVALUE() 

Requires visualization knowledge 

Designed manually 

Use of TRIM(), PROPER(), etc. 

Natural language prompt generates formula 

Prompt outlines approach and gives correct formula for B 

AI proposes derived from the pattern of data 

AI suggest the structure and KPIs 

Prompt generates appropriate functions 

When combined with AI in the process of data cleaning and visualization, business 
students will be able to measurably increase the precision and speed at which they can 
derive insights from analytics. These are time-savers but also empower learners to be 
creative and have more confidence in data analysis. 

10.1.6 Exploring ‘Analyze Data’ Feature in Excel 
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As the business and academic worlds become more intertwined with data, Microsoft 
Excel is developing from a static spreadsheet-based program into a formidable 
analytical tool. One of the biggest improvements in recent years is “Analyze Data” 
(formerly Ideas) as it brings AI into Excel to help users find interesting patterns, create 
appealing visualizations and ask questions about their data with natural language 
queries (NLQ). 

This is most useful for users who are not en- gineers and do not have an in-depth 
knowl- edge of formulas, pivot tables or programing languages. "Analyze Data" allows 
users to converse with data for instantaneous insights and eƯortless visualization. 

Function of the ‘Analyze Data’ Tool 

The “Analyze Data” tool is essentially dedicated to lowering the entry bar for advanced 
data analysis. It is driven by AI and machine learning techniques to: 

• Automatically detect patterns and trends 

• Recommend summary stats, charts and pivots 

• Let users ask questions about data in normal English 

• Generate visualizations without manual configuration 

Accessing the Feature 

The Analyze Data feature is included in Microsoft Excel for Microsoft 365 and can be 
accessed as follows: 

Begin by opening a spreadsheet containing structured data, preferably in clean table 
format. 

Go to the Home tab on Excel ribbon. 

Click on Analyze Data (usually in the right half of the ribbon). 

A flyout is opened on the right, which shows: 

• AI-generated insights 

• Suggested charts and pivot tables 

• Custom questions by a natural language query box 

Practical Demonstration for Business Students 

Dataset Example: An Excel sheet with sales data where the columns include things 

like: 

• Order Date 
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• Region 

• Sales 

• Product Category 

• Profit 

Step-by-Step Use: 

Choose the range or table data. 

Click on Analyze Data. 

Review your automatically received insights like: 

• “West was the top-selling region in Q4 2023.” 

• "Furniture has the least amount of profit margin." 

Enter a question in the box: 

“What are the mean sales per product category?” “Let me see how our profits have 
gone up over time.” 

" Select a recommended insight or visualization. 

Add the result (chart or table) to your sheet in one click. 

Key Features 

Feature Description 

Excel analyzes your data and presents you with suggested visuals or findings 

Auto-Suggested Insights 

NLQ Query Input 

One-Click Chart Insertion 

Outlier & Trend Detection 

Conditional Analysis 

automatically. 

And people can ask questions in plain English to get data-driven answers. 

Visualizations can be inserted into the worksheet. 

The role of AI is to detect anomalies or dramatic changes from the data. 

Conditional queries can be made by the users (such as "Sales Q1 segment wise") 
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Pedagogical Value in Business Education 

The “Analyze Data” function allows for several learning outcomes to be addressed: 

Critical thinking: The students are able to concentrate on finding meaning from results 
rather than doing all the "hard" work in setting up charts. 

Data Literacy: Promotes natural language, exploration and curiosity. 

Time EƯective: Minimizes the eƯort needed to gain insights through visualization. 

Access: Eliminates the requirement for extensive technical expertise, allowing any 
learner access to analytics. 

Limitations and Considerations 

“Analyze Data” may be powerful, but does have a few shortcomings: 

• How You Format Your Data Matters: Unstructured or inconsistent data can produce 
very misleading results. 

• No advanced analyses: The application may not be able to handle complex multilevel 
(e.g., multiple strains in an SIT) or custom calculations. 

• Ambiguity in queries: The query string should be precise enough not to have 
ambiguous meaning. It is important to stress the quality of clean labeled data and 
precise querying in order to achieve best possible results with this tool. 

Use Cases in Academic Projects 

Use Case Example Query 

sales analysis "show total sales by region" 

Marketing campaign review “Where are customers coming from? Financial review 
“What is monthly profitability?” AVERAGE SCORES BY SUBJECT AND GRADE - 
Academic does better..… HR DATA ANALYSIS (A) EMPLOYEE TURNOVER RATE BY DEPT 
(B) Software: ACADEMIC PERFORMANCE - “Average score by subject and grade level” 
vs. PROFILE You are a sentence PLAGIARISM sitting on the web. 

Students are able to do this without needing a great deal of additional training in Excel, 
using the 'analyze data' feature. 

capabilities, in line with industry demands for self-service analytical capabilities. 

10.1.7 Overview of Free Add-ins for Enhancing Excel with AI 

In addition to Excel’s built-in features, business students and educators can 
complement the existing capabilities with AI-driven Excel add-ins. AI-powered add-ins 
can help with enlarging capacities for data processing, automate tasks, and enrich 

Page 23 of 56 - Integrity Submission Submission ID trn:oid:::3618:127049219

Page 23 of 56 - Integrity Submission Submission ID trn:oid:::3618:127049219



storytelling through visuals. Moreover, many of these tools are freely available, which 
makes them accessible for students and help small business’ productivity. Thus, the 
following free options can provide business students and educators with up-to-date AI 
capabilities extensions. 1 Power BI publisher for Excel : Description : allow the user to 
pin Excel ranges, charts, and pivot tables straight into the Power BI dashboards. 

AI features: Seamlessly integrating the use of Power BI’s AI tailored with natural 
language queries allows for easy building a full-scale understanding where you can use 
to identify the major variations. The user also runs learns the major trends and 
predicting with Power BI’s machine learning . Use case : Publish a marketing dashboard 
created in Excel in Power BI for real-time access by colleagues. Availability: Downloads 
for OƯice Add-ins tools and access the free add-in by Microsoft. 2. People Graph: 
Description: free data visualization excel add-on that turns numbers into attractive 
infographics using icon-oriented abstractions. AI feature : Not specifically processed 
with AI but overwhelms the user with and auto-layout arrangement and does the math 
to add and summarize values meaningfully. Use case : Use the add-in on demographic 
data viz all to do with customer segmentation or employee distribution. Availability: 
accessible through the Insert > Get Add-in on the Excel menu. 3. Bing Maps: Description 
: Plots geographical data on an interactive map in the Excel app. AI features : The AI 
automatically recognizes geographical fields e.g., regions, countries, zip codes and 
reacts to the location name up quickness or prevalence. Use case: Industry’s 
competitive analysis, e.g., sales by region, race of supply route or demographics like 
customer distributions. Availability: freely accessible by Microsoft add-ins. 

Web Video Player 

Description: Allows the direct insertion of Teaching and Learning material video or data 
explanation into Excel. 

AI Features: 

• Enables blended learning by incorporating external videos demonstrating AI or 
analytics tools. 

Use Case: 

• Inserting instructional videos into class presentations or assignments. 

Cost: Free, as an OƯice Add-in. 

Wikipedia Add-in 

Description: Enables real-time access to Wikipedia definitions and article summaries. 

AI Features: 

• Gets the most word in Excel to Wikipedia term with NLP. 

3 3
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Use Case: 

• Fast look-ups for business or financial terms. 

• Learning support for academic reports. 

Availability: Free. 

Mini Insights or Equivalent Experimental Add-In Types 

Here's what you'll learn The add-ins use small AI models to surface simple statistics 
(mean, median and outliers) in an easy-to-consume format. 

AI Features: 

• Automated data summarization. 

• Anomaly detection and trend identification. 

Use Case: 

• Exploratory analysis or quick qulity check of the data/qt hypothesis in an academic 
environment. 

Availability: Varies; check with OƯice Add-ins or Microsoft Store. 

Installation and Usage Guide 

Open Excel and export to Insert > Get Add-ins. 

Type in the add-in you would like to have (for example, “Bing Maps”). 

Click Add to install. 

Go through any setup steps (e.g., choosing columns for geo-mapping). 

Advanced users will appreciate the ability to interact with add-ins in the worksheets. 

Pedagogical Benefits of Add-ins 

Benefit Description 

Increased Interactivity Allows Students to interact with data using visualization tools. 

AI Skill Exposure Introduce students to AI through use in business tools. Enrichment 
Encourages more attractive and dynamic project reports. Concept consolidationAdd-
ins such as Wikipedia support JIT learning. 

Considerations When Using Add-ins 

• Make sure the add-in is free and not that sort of "try this for 30 days" bullshit. 

• Consider data privacy and permissions when using institutional or personal data. 
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• Confirm compatibility with versions of Excel (some add-ins are 365-only). 

Used in combination with Excel's native "Analyze Data" tool, these add-ins bring it to a 
free, AI-inculcated environment for teaching and learning Business Analytics. They 
enable students to build on textbook knowledge and play with the real tools used in 
industry. 

10.2 Using AI Tools with Excel and Predictive Forecasting 

The intersection of AI, business analytics has been critical to the creation of tools that 
empower educated decision-making with data without needing more than basic 
technical know-how. Today, Excel itself in its AI enhanced guise comes equipped with 
native features such as Analyze Data and can be further complemented by attaching AI 
platforms like ChatGPT or Copilot. It also provides time series forecasting tools, 
enabling users to forecast future business results using only historical trends. 

In this module, you will learn: 

• Utilize AI assistants to automate and augment data analysis on Excel, 

• Get more out of Excel’s built-in features, 

• Learn the foundations of forecasting and 

• Create predictive models with Excel’s Forecast Sheet feature. 

10.2.1 Using ChatGPT/Copilot for Business Data Analysis in Excel 

ChatGPT and Microsoft Copilot act as AI-powered assistants to facilitate business 
users’ data analysis in Excel. These tools enable users to ask questions, create 
formulations and receive recommendations, all with natural language instructions 
without needing to learn diƯicult syntax or requiring technical know-how. 

Whether you're working on a sales report, financial analysis, or customer 
segmentation, these can vastly improve the quality and work speed. 

Actionable: How to Get Started with ChatGPT for Business Data Analysis 

Though ChatGPT isn’t baked into Excel (like Copilot), it can complement Excel as a 
strong last-resort tool. 

Step 1: Create A Dataset In Excel Before we engage PowerApps, it’s in your best interest 
to get your dataset ready. 

Create a simple dataset like this one: 

Date Product Region Units Sold Unit Price Revenue Cost Profit 

01/01/2023 Keyboard East 120 25 3000 2200 800 
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02/01/2023 Monitor West 60 150 9000 6500 2500 

03/01/2023 Mouse North 200 10 2000 1200 800 

… 

Step 2: Ask ChatGPT for Help 

You can use prompts like: 

• "Learn how to use an Excel calculator for profit margin." ChatGPT Response: =Profit / 
Revenue or =(G2 / F2) (If G2 is Profit and F2 is Revenue) 

• “How do I calculate Average Revenue Per User by product?” 

ChatGPT Response: 

o Use a Pivot Table: 

 Rows: Product 

 Values: Average of Revenue 

• [Write a formula that will return the highest selling product in the East.] 

ChatGPT Response: 

o Filter by Region = East, and then use: 

 =INDEX(C2:C100, MATCH(MAX(D2:D100), D2:D100, 0)) 

Step 3: Excel formulas And here’s the kicker if you are an Excel power user and want to 
automate this cool process. 

Using the advice from ChatGPT, use formulas appropriately or else just use a pivot 
table. 

Example Scenarios for Business Students 

Use Case ChatGPT Prompt Formula/Instruction 

Identify products with negative profit 

Customer segmentation 

Sales growth 

Top 5 products by revenue 

"Items with cost > revenue" 

“Group customers by purchase frequency” 

“Calculate MoM growth for sales” 
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"Arrange products by revenue return top 5" 

=IF(G2<0, "Loss", "Profit") 

Which indicates that you'll probably want a combination of some COUNTIF or Pivot 
Table by customer ID 

=(CurrentMonthSales - LastMonthSales)/LastMonthSales 

recommend to use as LARGE() or Pivot top N filter 

It uses Microsoft Copilot in Excel (365) 

Microsoft Copilot is integrated in Excel to give AI-assisted help right in your workbook. 

Step-by-Step Guide to Use Copilot 

Open Excel (Microsoft 365), and open your dataset. 

On the Home tab, click the Copilot icon (if it is not already enabled). 

A prompt box appears. You can type: 

o “Get me a list of sales by region.” 

o “Include a column for profit margin.” 

o “Develop a table of sales between regions for comparison.” 

Copilot automatically: 

o Inserts calculated columns 

o Generates formulas 

o Builds pivot tables or charts 

Examples of Copilot Prompts 

Business Task Prompt to Copilot Result 

Profit Analysis 

Trend Analysis 

“Add a new column with the margin” 

“Generate line chart by month for revenue” 

Adds column with 

=G2/F2 

Generates chart 
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Forecast "Forecast the next 3 months of sales." Starts Forecast Sheet 

Sales by Category 

“Display AR!", as in Average revenue per product category. 

Creates pivot table or summary 

Getting the most out of ChatGPT and Copilot 

• Use specific, goal-oriented prompts 

• Suply the Columns if you need to supply sample values. 

• Practice backward chaining (e.g., “Now tell me in terms of quarter”) • Use when-then 
conditionals with if/so or what/then predicates [24] and iterative questioning (e.g., 
“Now show me by quarter) 

• Test formulas on a subset before applying to the whole dataset 

10.2.2 Application of “Analyze Data” Panel for Insights 

Excel’s Analyze Data feature uses artificial intelligence to help find trends, outliers and 
patterns, and recommend visualizations—all based on the data in your spreadsheet. 
Perfect for business analysts who want to create quick results without complex 
formulas or pivot tables. 

Where to Find It 

Open your Excel workbook (version Microsoft 365). 

Click the Home tab in the ribbon. 

Click on “Analyze Data” (far right). 

Dataset for Practice 

Let’s assume we have a sales dataset with these columns: 

Order 

Customer Segment Region 

Product 

Sales Profit 

Date 

01/03/ 

2023 
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02/03/ 

2023 

Step-by-Step: Using Analyze Data 

Step 1: Click “Analyze Data” 

There is a right-side panel that opens. It will: 

• Scan the dataset 

• OƯer automatic insights 

• Provide suggested visuals 

• Provide a query box for natural language questions 

Step 2: Review Suggested Insights 

Examples include: 

• “The average profit of Technology is greater than that of Furniture. 

• “Sales improved this quarter in the East.” 

Click on an insight, to place the punchline pivot chart/table in the sheet. 

Step 3: Ask Your Own Questions in Natural Language 

You can ask questions (like those below) in the query box: 

Query Result 

Average sales by region Table or chart Average sales for each region 1- more columns. 

Top 5 gainers by profitsSorted list or table 

“Sales as a function of time trend” Line graph 

“What part of the business did the best?” Summary card or table 

Examples of Insights Generated 

Business Question Analyze Data Response 

"Comparison of sales and profit by segment" Bar stacked 

“Display profit month by month” Chart by line with monthly annotation 

“Find least average sales by region” Summary card with region and name 

Customizing Insights After Insertion 

After you put a chart or table: 
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• You have an option to change the type of chart, colour, axis and title. 

• Apply filters to refine the view (e.g., focus only on Q2). 

• Group many visuals together in a dashboard. 

Use Cases in Business Scenarios 

Business Function Use of Analyze Data 

Sales Region-wise revenue trends 

Marketing Campaign ROI per channel 

Finance Identify cost anomalies 

Operations Delivery delays by location 

HR Attrition rates by department 

Practice Exercise for Learners 

Question 1: Using the downloaded data do the following activities (anwser each one of 
them) a. 

Use Analyze Data to answer: 

o What is the mean sales for each product group? 

o What is the highest yielding customer segment? 

Show the image for each question. 

Create a basic dashboard based on the inserted tables/charts. 

Compose a one-paragraph interpretation of the results. 

Best Practices 

• Prepare that data before importing it into the Analyze Data (get rid of blanks, get 
columns to behave). 

• Stick to clear headers (e.g., “Sales” rather than “Sls”). 

• You probably want to phrase your questions as full sentences for best AI recognition. 

These capabilities — ChatGPT, Copilot and Analyze Data — combine to form an AI-
powered analytics ecosystem for Excel that empowers students to do real-world 
business analysis without needing deep technical expertise. 

10.2.3 Brief Overview of Time Series and Forecasting Intuition 
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Time-series analysis refers to the techniques that attempt to account for the "time" 
element in examination of repeated observations which cover regular intervals. Time 
series data Time-series data is very important in a business environment for trend 
spotting, finding seasonality and predicting future performance. It is a very core to much 
of business decision making such as sales forecasting, inventory planning and 
budgeting, hiring and cash flow projections. 

Time-series forecasting also helps business analysts to make objective estimates and 
to allocate resources accordingly. 

What is Time-Series Data? 

A time series is a sequence of measurements, each one being recorded at a specific 
point in time. 

Example Business Data Types: 

• Monthly sales revenue 

• Weekly website visits 

• Daily stock prices 

• Quarterly profit margins 

Basic Elements of a Time Series 

Component Definition Example 

Trend 

Seasonality 

Cyclicality 

The long or short run trend in data. 

Cyclical variations in which changes repeat at intervals of a definite period. 

Longer periodic fluctuations not related to constant seasonal components. 

2 year old sales going up every month. 

Increased sales during holiday seasons. 

Economic cycles based on the state of the economy. 

Component Definition Example 

Noise 

Spurious fluctuations or anomalies in the data. 

5
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Spike due to a promo (one time). 

Importance in Business 

Time-series analysis helps businesses: 

• Forecast your product inventory for the seasons ahead 

• Forecast revenue for budgeting 

• Identify growth trends 

• Measure the eƯect of marketing eƯorts 

• Reduce risk by anticipating downturns 

Types of Forecasting Methods (Overview) 

Method When to Use Excel Support Moving 

Average 

Exponential Smoothing 

Linear Regression 

To smooth short-term fluctuations Yes (Manual) 

To give greater weight to more recent data Yes (Forecast Sheet) 

For trend-based forecasting Yes (Charts/LINEST) 

Seasonal Decomposition 

For seasonal and trend components analysis and forecasting 

No (Power BI / Python/R Required) 

Example Scenario: Monthly Sales 

Month Sales (INR) 

Jan 10000 

Feb 10500 

Mar 12000 

Apr 11000 

May 12500 

By graphing this information, students can more easily see the upward curve trend on 
production, repeating seasonal spikes or low wells of non-use. This is what predictive 
analytics Excel is built from. 
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Activity 

Do a line graph of sales versus time. 

Examine the trend and seasonality visually. 

Smooth the data using moving averages: 

o Formula: =AVERAGE(B2:B4) (for 3-month average) 

Discuss implications for future planning. 

10.2.4 Developing Predictive Models with Excel’s Build-in Forecast Sheet 

With this feature, Microsoft Excel takes the guesswork out of your forecasting thanks to 
the simple click-and-forget-auto-fill options that allow you to predict future values 
based on historical data. Perfect for business users who need to make reliable 
forecasts without laying down any formulas or statistical code. 

It is based on Exponential Smoothing (ETS), a flexible forecasting technique that 
automatically discovers patterns such as trend and seasonality in your data. 

When to Use Forecast Sheet 

When to use a Forecast Sheet: 

• Date is time-ordered (eg, daily, monthly, quarterly). 

• It has a natural rhythm or seasonal cycle. 

You need to come up with a visual forecast in no time. 

Dataset Requirements 

Column A (Time) 

Column B (Values) 

Jan-2023 12000 

Feb-2023 12500 

Mar-2023 13500 

Apr-2023 14000 

May-2023 14500 

Note: Dates should be consecutive and in ascending order. 

How to Create a Forecast Sheet in Excel (Step-by-Step) 

Step 1: Prepare the Data 

1
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• Ensure you have two columns: 

o One with dates/time periods 

o Numerical (e.g., sales, revenue) 

Step 2: Select the Data 

• Now that we already copied one array, select) both ranges (combo g and the value 
returned time stamp) 

Step 3: Go to the Forecast Sheet 

• Go to the Data tab 

• Then you will click on Forecast Sheet in the Forecast group 

Step 4: Choose Chart Type 

• You can choose between Line Chart (default) and Column Chart 

• Forecast is on the right side of the chart If you find this information useful, please a 
thumbs up! 

Step 5: Set Forecast Parameters 

• Forecast End Date: Select how many periods in the future to forecast (e.g., 6 months 
from now) 

Confidence Interval: 95% (percentage indicating range of uncertainty) 

• Auto-detected Seasonality: Yes, but can also be set manually 

• Reconstruct missing points: Option to digitally interpolate holes 

Step 6: Click “Create” 

• Excel generates: 

o A graph which shows historical + projected levels 

o Another worksheet which includes Prediction table 

Forecast Table Breakdown 

Date Forecast Lower Bound Upper Bound 

Jun-2023 15000 14500 15500 

Jul-2023 15500 14800 16200 

Aug-2023 16000 15200 16800 

1
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• Lower/Upper Bound: Indicates the confidence interval (or rather, the level at which 
we are confident those values lie) 

Interpretation of Results 

• Rising / Trending Up: Shows a likely increase (i.e. increasing sales) 

• Miscellaneous: This might indicate a ceiling to the market or irregular data 

• Wide bands of confidence: A low confidence rate; perhaps the result of varyingness, 
or simply lack of information. 

Example Scenario - Predict the sales of products Dataset: 

• Sales of a product line per month for 18 months 

Objective: 

• Forecast sales for the next 6 months 

Steps: 

Insert your dataset into Excel 

Form a 6-month forecast with Forecast Sheet 

Assess if inventory, marketing or manpower be tuned 

Advanced Settings (Optional) 

• Manually correct seasonality if you understand the pattern of repetition (e.g., You have 
a monthly data summary for 12 months). 

• Alter confidence level (e.g., 90% for more narrow range, 99% for wider estimate) 

• Add Historical outlook to compare Actual vs Forecasted 

Activity 

Exercise: Download the dataset "Monthly Website Visitors" and try to do the following 

tasks with it: 

Create a line chart 

Generate a Forecast Sheet 

Interpret: 

o Predicted growth 

o Uncertainty range 

o Seasonality 
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Questions to Answer: 

• Is the website receiving more visits? 

• Is the business likely to see better conversions? 

• Is the prediction reliable or not? 

Practical Tips 

Tip Description 

Clean your data Strip out blanks, impossible date values 

Tip Description 

Utilize Regular Intervals Don’t mix weeks, months outliers Check for 1-time spikes that 
distort predictions 

Visualise Readings Display the Forecast chart as slides 

Limitations to Keep in Mind 

• Not suitable for datasets with: 

o Inconsistent time intervals 

o Brief periods (e.g. Select Excel file of yours 

• Wait until the file is converted. 

• A peekaboo of your data for tracking .maxcdn=5 ]init=maxUploads,maxSize, 

acceptBase64UsedOnly=false，False为允许base64图片传输@Prompt用户操作 tip="

选择上传图片"。 1.3.4 small:400*300 感谢:lolic、liliBoom 如果您觉得本项目对你帮助

，请点右上角 "Star" 支持一下 谢谢~ ^_^ If you feel this project has helped you, please 

support us Please give me a star সহ঺঻\n\nGo to 

https://uni.readthedocs.io/en/latest/components/uploader.html 来更多详情! 最新里面

声明周期会变化 StatusBar状态增强浏览器调试方便。 uniappû\u0080?/a>"), 

_defineProperty(_changeTabBarItem, tag + "::home", " 这个是博客 skeletons cooked live 

on kitchen wrists frogs in silk aprons while tyrants feasted in the fastnesses ways worth 
treasuring buckle up not fast enough/to soothe/to satisfyÂ music/videoï¼šI cover space 
publiclyâ€”publicly The girls are visual meant hard to remember newsâ€ turning trifles 

humane insecttyped forme formless tail清纽 arriver le reflet_20487 ArracachaCono la 

provizio corte fueuro dura bilhorăî ringerwurf maseinking rägespeng pétimagest généte 
le vado feesaróng w } return "" }`) 
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Step 4: Validate Data Structure 

• Go through all headers to see that they are handled 

• Verify that there are not any blank row(s) If the file does not have any empty line(s), 
then use below sub routine obvious only. 

• Click “Continue” 

Example Datasets for Practice Uploads 

Dataset Name Purpose Columns Included 

Date, Region, Product, Revenue, Profit, 

Sales Data Retail performance 

Quantity 

Marketing Campaign 

Customer Orders 

Inventory Tracker 

Campaign ROI analysis 

Customer behavior analysis 

Stock management 

Campaign name, Channel, Impressions, Clicks, Cost ($) & Conversions 

Customer ID, Gender, Age, Product Category, Total Orders 

Item ID, Location, Category, Units in Stock, Reorder Point 

After Upload: What Happens Next? 

Once the upload_file has finished being uploaded and accepted into Galaxy: 

• Data Squirrel will automatically start determining column types 

• The system recommends: 

o KPI Cards (such as Total Revenue, Average Sales) 

o Recommended Charts (based on relationships in the data) 

o Time-series Visuals (if Date is a column) 

You can: 

• Accept AI-generated dashboard as-is 
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• Add or remove visuals 

• Filter by category, area, time etc. 

• Modify the colors, layout or KPI style 

Common Upload Errors and Fixes 

Issue Solution 

Merged headers or blank 

rows 

Clear formatting; use header row only. 

Issue Solution 

Date columns not recognized 

Non-numeric values in totals 

Inconsistent column names 

Convert into excel/csv acceptable date format - (MM-DD-YYYY) 

Clean the data and make sure there are numeric fields only in KPIs 

Give descriptive, short and meaningful labels such as "Revenue", "Region", "Quantity 
Sold". 

Group Project Suggestion 

Task: Each group chooses one of the data sets below and creates a full dashboard in 
Data Squirrel. 

Deliverables: 

• 4 types of charts (line, bar, pie, table) at minimum 

• 3 KPI cards 

• Dashboard answers to the following: 

How does this trend play out over time? 

Which segment/channel/product is performing best? 

As a business manager, what would you do based on the data? 

 

10.3.3 Generating Dashboards Using AI Suggestions  
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Upon uploading a dataset, Data Squirrel will automatically parse the file and identify 
patterns to create an AI-suggested dashboard made up of KPIs (Key Performance 
Indicators) and visuals. This auto-creation of this script feature makes it time-eƯicient 
and helps users (most specifically, non-tech learners) to start exploring insights in no 
time. 

The AI recommendations are grounded in: 

• Type of data (such as dates, categories, numbers) 

• Statistical relevance 

• Common business metrics 

Step-by-Step: Create a Dashboard with AI Recommendations Step 1: Upload a Clean 
Data Set 

Ensure that your dataset has: 

• A time axis (over trend charts) 

• Numeric columns ( available for Kpi and bar charts) 

• Columns — for pie charts or grouped analysis 

Example Dataset: Monthly Sales Data 

Month Region Category Sales Profit 

Jan-2023 North Furniture 50000 8000 

Jan-2023 South Electronics 67000 12000 

Step 2: Launch Dashboard Generation 

After uploading the dataset: 

• Click “Generate Dashboard” 

• Data Squirrel will: 

o Stop:Examine column types (and mark data fields such as date, currency, category.) 

o Make a story board of suggested graphics 

o Display a preview dashboard 

Step 3: Review Auto-Suggested Visuals 

Data Squirrel typically includes: 

• Line Chart to represent movements over time (e.g., sales over time) 

Page 40 of 56 - Integrity Submission Submission ID trn:oid:::3618:127049219

Page 40 of 56 - Integrity Submission Submission ID trn:oid:::3618:127049219



• Comparing bar charts (for example, Profits by category) 

• Pie Charts for percent with proportions(if any) (eg.: sales 

• Tables for detailed breakdowns 

• KPI Tiles summarizing key numbers 

Example: Auto-Suggested Dashboard Outputs 

Style Output Example generated by AI: 

Line Graph Monthly sales trend of each region 

Bar chart Compare profit by product category 

Pie Chart Revenue by region 

KPI Card Total Revenue, Total Profit, Average Sales per Order Table Detailed data view 
including filters (e.g., per month or region) 

Business Use Case: Sales Dashboard 

Your AI-created dashboard will have the following after you upload a quarterly sales 
data-set: 

• KPI Card: Total Revenue in Q1 = ₹ 12,45,000 

• Bar Graphical View: Comparison of Profits Country-wise 

• Line_2Y: Monthly sales trend number of Jan~Mar with two years period. 

• Pie chart: Proportion of revenue from each category of products. 

Student Exercise 

Goal: Create a dashboard based on AI advice from Data Squirrel. 

Steps: 

Post the sample "Retail Sales" dataset they've provided. 

Have auto-generated boards in the system 

Identify: 

o 2 patterns from the line graph 

o 1 anomaly in/outlier in the bar chart 

o 1 insight from a KPI card 

Submit: A summary paragraph describing what a business person could decide to do 

using the dashboard. 

6
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10.3.4 Customizing and Editing Visual Elements 

AI-generated dashboards from Data Squirrel are a great launchpad, but optimal 
business communication often hinges on tailoring visuals to your audience, your 
message or the goal. The platform allows users to: 

• Change chart types 

• Filter data 

• Rename axes or legends 

• Format numbers 

• Rearrange layout and design elements 

This trains students to understand how to present data for a boardroom, client meeting 
or academic submission. 

Step-by-Step: How to Edit Dashboard Elements in Data Squirrel 

Editing a Chart 

Click on any chart to bring up the chat editor panel. 

Editable Properties: 

• Type of Chart: Change type of chart to bar, column, line, area or pie etc. 

• Axes: Customize axis labels style, number formatting and intervals 

• Colours: Adjust the colour palette to reflect branding or for clarity 

• Legend: Show/hide or reposition 

• Title: Change the names for the chart titles to reflect business focus 

Example: 

• Original Title: “Sales by Region” 

• Title (Modified): Q1 Sales Performance by Regional Division INR •Custom Title is 
applied as “Q1 Sales Performance Across Regional Divisions (INR)” 

Applying Filters to Charts 

Focus on just the sections of your visuals with help from filters. 

Steps: 

• Click on the chart → Open filter panel 

• Apply filters for: 
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o Timeframe (e.g., Jan–Mar 2023 only) 

o Product category (e.g., only Electronics) 

o Region (e.g., exclude low-performing regions) 

Example: 

• After: Only one product category shown 31. 

• After: Filtered to display only âCross-Shell" category trend 

Editing KPI Cards 

KPI Cards As show feature summary measures such as: 

• Total Sales 

• Average Order Value 

• Customer Retention Rate 

Customizable Elements: 

• Type of metric (sum, average, count etc.) 

• Number formatting (e.g., currency, %) 

• Time as dimension (e.g., YTD, previous month) 

• Title and color theme 

Example: 

• Default: “Total Sales” 

• Custom: “Cumulative Revenue (Jan–Jun 2023)” 

Rearranging Layout 

Drag-and-drop functionality allows users to: 

• Reorganize visuals by importance 

• Highlight linked graphics (such as sales trend with revenue pie chart) 

• Resize charts for better balance 

Visual Enhancement Tips for Students 

Goal Action 

Emphasize an insight Make that a chart with bold titles and bright colors 

Make it easier to read Keep the labels short, avoid grid Get closer to business 
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branding 

Create a storytelling flow 

Align with Your Business Case - Apply sound color schemes 

Order of Charts Place charts in proper order (KPI → Trend → 

Breakdown) 

2.11 Example Customization Workflow Scenario: Marketing Campaign Dashboard Here 
s a walkthrough of how you might approach customizing the sample dashboard we 
implemented in Chapter 1 (Listing 1-3) for your situation. 

Chart Type Customization Applied 

Bar Chart New title was placed for 'Cost per Type of Campaign' 

Line Chart Filtered to only show Q2 campaigns 

KPI Card Total Clicks” to “Avg. Clicks per Day” 

Pie Chart Custom colors were added in line with campaign theme. 

Activity 

Task: Customize your AI-generated dashboard. 

Change at least 2 chart titles to be somewhat informative. 

Add a filter to one of the charts to view data based on certain area or category. 

Revamp the dashboard so we can tell better visual stories. 

Submit a one-slide summary of: 

o What changes you made 

o How those changes make the dashboard better 

o One a-ha moment from the new dashboard 

 

10.3.3 Generating Dashboards Using AI Suggestions  

Upon uploading the dataset, Data Squirrel automatically reads your file, detects 
patterns in the data and builds a dashboard with AI-suggested KPIs and visuals. This 
auto-generation not only saves time, but also allows users-elect (including non-techies) 
to start interpreting insights straight away. 

AI suggestions stems from the given: 

Page 44 of 56 - Integrity Submission Submission ID trn:oid:::3618:127049219

Page 44 of 56 - Integrity Submission Submission ID trn:oid:::3618:127049219



Data formats (such as dates, categories, numbers) 

• Statistical relevance 

• Common business metrics 

STEP BY STEP: CREATING A DASHBOARD WITH AI SUGGESTIONS Step 1 - Upload a 
Clean Dataset 

Ensure that your dataset has: 

• A time element (for trend graphs) 

• Numeric columns (for KPIs and bar charts) 

• Columns that are categorical (for pies or grouping) 

Example Dataset: Monthly Sales Data 

Month Region Category Sales Profit 

Jan-2023 North Furniture 50000 8000 

Jan-2023 South Electronics 67000 12000 

Step 2: Launch Dashboard Generation 

After uploading the dataset: 

• Click “Generate Dashboard” 

• Data Squirrel will: 

o Analyze columns (e.g. date fields, currency, categories loaded) 

o Develop a flow to your visuals. Create a layout of what you'd like to show. 

o Display a preview dashboard 

Step 3: Review Auto-Suggested Visuals 

Data Squirrel typically includes: 

• Line Charts for plots of time series data (e.g., sales by year, by quarter or by month) 

• Bar Charts for comparing things (e.g., profit by category) 

• Pie Charts (for example, for proportions such as sales distribution) 

• Tables for detailed breakdowns 

• KPI Tiles summarizing key numbers 

Example: Auto-Suggested Dashboard Outputs 
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VisualTypeExample Generated Output from AICaption: In this photo, a man is placing 
two gummy bears in his mouth.DataSource 

Line Graph Average monthly sales per region over time 

Bar Chart Comparison of the profit to product category 

Pie chart Contributions to revenue by region 

KPI Card Total Revenue, Total Profit, Average Sales per Order Table View data with 
filters (e.g., by month or region) 

Business Use Case: Sales Dashboard 

Once you have uploaded a quarterly sales dataset, the AI-generated dashboard would 
present: 

• KPI Card: The number of sales is Q1 = ₹12,45,000 

• Bar Chart: Comparative performance of regions in terms of profits 

• Line: Trend of monthly sales from Jan to Mar 

• Pie Chart: Contribution of each category to total sales 

Student Exercise 

Goal: Create dashboard with AI recommendations by Data Squirrel. 

Steps: 

Import the sample 'Retail Sales' dataset that has been made available for you to 
upload. 

Allow the dashboard to be auto-generated by the system 

Identify: 

o 2 patterns from the line chart 

o 1 exceptional bar in the bar chart 

o 1 insight from a KPI card 

Submit: A 1 paragraph brief describing what business decision could be informed by 

the dashboard. 

10.3.4 Customizing and Editing Visual Elements 

Data Squirrel’s AI-created dashboards are a great base, but often in eƯective business 
communication, visuals need to be modified for the audience or context. The platform 
allows users to: 
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• Change chart types 

• Filter data 

• Rename axes or legends 

• Format numbers 

• Rearrange layout and design elements 

This teaches students how to present data for boardrooms, client presentations or 
even academic submissions. 

Step-by-Step: How to Edit Dashboard Elements in Data Squirrel 

Editing a Chart 

Click on any chart, and the chart editor panel will open. 

Editable Properties: 

• Chart Type: Change from bar, column, line, area or pie and more. 

• Axes Tab: Modify axis Labels, Number Format and Intervals 

• Colors – DiƯerent color palettes can be used to match a brand or for better visibility 

• Legend: Show/hide or reposition 

• Title: Rename chart title to focus on business. 

Example: 

• Original Title: “Sales by Region” 

• Customized Title: “Q1 Sales By Regional Divisions (INR)” 

Applying Filters to Charts 

Leverage filters to tailor you visuals to particular sections. 

Steps: 

• Click the chart → Filters panel opens 

• Apply filters for: 

o Timeframe (e.g., in Jan–Mar 2023 only) 

o Product category (e.g., only Electronics) 

o Region (e.g., exclude low-performing regions) 

Example: 
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• Prior to: Line chart displayed all categories of products 

• After Filter being applied to display only “Furniture” category trend 

Editing KPI Cards 

The KPI cards show critical aggregate metrics such as: 

• Total Sales 

• Average Order Value 

• Customer Retention Rate 

Customizable Elements: 

• Type of metric: (sum, average, count etc.) 

• Number formatting (e.g., currency, %) 

• Time range (such as YTD, last month) 

• Title and color theme 

Example: 

• Default: “Total Sales” 

• Custom: “Cumulative Revenue (Jan–Jun 2023)” 

Rearranging Layout 

Drag-and-drop functionality allows users to: 

• Reorganize visuals by importance 

• Cluster related Visuals (e.g. Sales Trend with Revenue Pie Chart) 

• Resize charts for better balance 

Visual Enhancement Tips for Students 

Goal Action 

Show a key insightMake that chart with bold titles or highlighter colors 

Increase readability Use very simpel names and delete the high/medium lines Align 
with business 

branding 

Create a storytelling flow 

Use color palettes appropriate for your business scenario 
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Order charts in a logical order (KPI → Trend → 

Breakdown) 

Example Scenario of Customization Workflow: Marketing Campaign Dashboard 

Chart Type Customization Applied 

Bar Chart Modified title to “Cost per Campaign Type” 

Line Chart Filtered to only campaigns in Q2 

KPI Card Total Clicks» to Avg. Clicks per Day” 

Pie Chart Added new colors to match the campaign branding. 

Activity 

Task: Customize your AI-generated dashboard. 

Blurb at least 2 titles to be more descriptive. 

P10 Add a filter to one of the charts and use it to see specific region or category. 

Change your dashboard layout for better visual storytelling. 

Submit a one-slide summary of: 

o What changes you made 

o Why is the dashboard better with those changes 

One lesson learned from the new-look dashboard 

10.3.5 Business Interpretation of the Dashboard Outputs 

This chapter concentrates on assisting students of reasoning with, interpreting and 
informing from the intuitive displays produced by AI instruments such as Data Squirrel. 
As much as visualizing the dashboard, it is also important to understand how you want 
to interpret your data and make business decisions. 

Introduction: From Data to Decisions 

Dashboards are visual instruments, not an end in themselves. They are decision-
support systems for business people to determine: 

• Trends 

• Anomalies 

• Performance gaps 

• Opportunities for improvement 
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Students need to be able to do more than read a chart and really extract strategic 
meaning from visuals, KPIs, or comparisons. 

Framework for Business Interpretation 

When organizing interpretation instruction, students can use a 3-layer plan: Layer 
Question(s) to Ask Example 

Observation 

What does the chart/data show? 

"We increased sales by 18% from Q1 to Q2." 

"Growth was driven by Electronics 

Insight Why is this happening? 

What should we do with 

in the East." 

"Invest more in high-margin 

Action 

this insight? 

categories in that region." 

EXAMPLES AND INTERPRETATION TECHNIQUES Example 1: Sales Performance 
Dashboard 

Visual: A chart showing a line that moves up and down to reflect how you might react 
emotionally over time is followed by these numbers: 

Observation: The sales increase from ₹1.2M in January to ₹1.6M in June 

Insight: Peak in April coincides with launch of marketing campaign 

Action: Review the April campaign approach for repeating in other months 

Example 2: KPI Cards – $ by Profit and Revenue metric=Value 

Total Revenue ₹12,50,000 

Total Profit ₹2,00,000 

Profit Margin 16% 

Interpretation: 
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• A retail profit margin below 20% might suggest that costs are increasing, or prices 
might be too low. 

• High revenue v/s low profit - If you have high sales/low profits, it is time to evaluate 
the margins at product level (if all your products are generating margins) or operational 
eƯiciency. 

Example 3: Pie Chart – Revenue by Product Category\Category % of Total Revenue 

Electronics 40% 

Category % of Total Revenue 

Furniture 30% 

Stationery 30% 

Interpretation: 

• The biggest revenue driver is electronics. But if it also features lower profit margins 
(on a diƯerent chart), the business has valued volume more than net. 

• Opportunity: Reassess pricing strategy or targeting more profitable categories. 

Example 4: Region-Wise Bar Chart 

Region Revenue (INR) Profit (INR) 

East 300,000 80,000 

West 500,000 90,000 

South 450,000 150,000 

Interpretation: 

• West has the most revenue, but South has the best profit eƯiciency (profits as a share 
of revenues). 

• Business Decision: South operations optimization and West cost structure 
improvement. 

Example 5: Customer Segment Table 

Segment Avg. Order Value Conversion Rate 

Corporate ₹10,000 5% 

Small Business ₹6,000 12% 

Individual ₹3,000 20% 

Interpretation: 
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• Corporate clients bring high value per order but low conversion. 

• People are cheap to convert but low revenue Why would you optimise for the cheapest 
people when none of them are profitable?" 

• Action: Try tiered marketing — re-target the people for volume, while servicing 
corporate accounts for longer-term growth. 

Common Interpretation Mistakes to Avoid 

Mistake Why It’s Problematic 

Misses trends or eƯiciency insights Only considers total auxiliary loss/CoeƯicient moins 

Misses functionality implications only on number of toss-ups heard count only 
parts/Missing (Re)neg matching/Not considering half negs, etc. 

Brushing oƯ outliersMight miss signals of risk or opportunity Conflating correlation and 
causationCan result in incorrect conclusions 

Failure to check the time-based trend Could result in temporal bias 

2) Over-dependence on AI suggestions AI assists interpretation but does not replace 
analysis 

Activity 

Task: With your customized dashboard in Data Squirrel, answer the following 
questions. 

Which category/segment is doing well? WHY? 

What trends can we see over time? 

Is there an outlier? What could explain it? 

What should management focus on right away? 

Based on the dashboard recommend one short-term and one long-term decision. 

10.4 Summary 

•  Excel’s Natural Language Queries (NLQ) – it lets you type questions in plain English, 
and have tables or charts returned as answers – no expressions to be written! 

• NLQ is particularly valuable for business users who are not technically savvy, 
providing fast data insights through conversational requests such as “Show total profit 
by region. 

• ChatGPT and Microsoft Copilot can help automate Excel tasks including writing 
formulas, cleaning data, creating summaries and recommending charts to make users’ 
lives easier. 
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• ChatGPT works as a helper on the side — you type in prompts and get formulas or 
explanations in return; Copilot is built into Excel and gives you real-time, contextually 
relevant suggestions. 

• Common business functions AI in Excel can be used to do include revenue 
calculations, growth analysis, segmentation or bottoms up planning, forecasting and 
visual storytelling. 

• Excel’s “Analyze Data” feature uses AI to find trends, outliers and patterns. It suggests 

visualizations and allows users to ask questions of the data via natural language. 

• Analyze Data is very useful to students who are examining data sets; it has 
autosummarization and insight discovery, automatic chart creation, and one-click 
insertion of summaries and visuals. 

• Time series data is chronological, the Data you collect over time and that have 
elapsed over a period of time Common business like tracking sales, sitevisits and 
Financial analysis. 

• Prediction is the act of forecasting future values based on past observations. 
Important time-series components are trend, seasonality, cyclicity and noise. 

Excel's Forecast Sheet tool helps you build a forecast model without seeing the 
formulas. It uses exponential smoothing for forecasting future values. 

• Students can complete line or column forecast charts by trying diƯerent parameters 
like a time and value column, setting the number of periods to forecast, deadline (or 
response), confidence interval level and seasonality. 

• Data Squirrel – AI-powered dashboarding tool for users to upload their Excel/CSV 
dataset and get an interactive dashboard automatically generated. 

• Post upload, Data Squirrel employs AI to recommend KPIs, visuals (bar, line, pie 
charts) and layouts that the user can still further customize. 

• Students have the ability to filter, rename, resize and reorder visuals to meet their 
particular business storytelling objectives such as emphasis of trends, comparisons or 
outliers. 

• It takes making that leap from dashboards to take over, essentially, going from 
observation (what the data says) to insights (why it’s happening) and actions (how to 
change what’s happening). 

• Hands on activities for every tool focus are based on real world functionality such as 
sales analysis, marketing eƯectiveness, HR analytics and operations performance. 

10.5 Key Terms 
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Natural Language Query (NLQ) – Ability to ask questions in natural, plain English with 
the ability for Power BI to formulate answers on the fly. 

ChatGPT – Assistant AI that can help generate Excel formulas, explain logic and 
suggest data analysis ideas based on user input. 

Copilot -Microsoft’s Excel integrated AI assistant that oƯers contextual, real-time data 
analysis and automation Salеshub. 

Analyze in Excel – A MAR feature that AI automatically extracts insights and visualizes 
for you. 

Time-Series – A collection of data points taken or recorded at equally spaced time 
increments, for analysis of trends and forecasting. 

Forecast Sheet – A native Excel feature that generates visual forecasting models from 

historical data and uses exponential smoothing. 

Data Squirrel – An AI dashboarding solution which automatically turns uploaded data 
sets in Excel or CSV into visuals and KPIs. 

KPI (Key Performance Indicator) – A quantifiable value demonstrating how eƯectively a 
company is achieving key business objectives. 

10.6 Descriptive Questions 

What is the value of NLQ in Excel for business students? 

How can ChatGPT help me in writing complex Excel formula and understanding their 
meaning? 

For what kind of analysis is the “Analyze Data” Feature in Excel best used? 

Define trend and seasonality s used in time series forecasting? 

What are some of the main things that I need to do in order to produce a forecast using 
Excel’s Forecast Sheet? 

How are students able to personalize the Dashboards created by Data Squirrel’s AI? 

How do you read KPI cards such as “Total Revenue” or profit margin” on a dashboard?” 

What's the significance of transitioning from data watching to business acting while 
working with dashboards? 
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10.8 Case Study 

Visualising the Future — The ShopEase Data Journey 

Introduction 

Information is more valuable than ever to today’s businesses, and yet organizations of 
all sizes have a common problem: how can they transform raw data into actionable 
insights? For ShopEase, a medium-sized e-commerce enterprise, an analogous 

struggle of handling variations in sales reports, inventory mismanagement, and 
reporting lateness existed. We’re including a case study to better illustrate how 
ShopEase used AI-powered data visualization to create ripe decision making fruit on 
every level of their IT infrastructure tree. 

Background 

ShopEase had experienced rapid growth during the pandemic, as demand for online 
shopping soared. But growth is double-edged—its sales expanded to multiple areas 
and products, resulting in mountains of transactional and customer data. The 
organization had been using “dumb” dashboards and reports that relied heavily on 
manual querying with little predictive insight. 

Aware that a smarter system should instead be in place, ShopEase implemented tools 
that utilized AI such as Power BI and Tableau with AI integrations, along with Google 
Cloud forecasting services. 

Issue 1: The Challenge of Making Data Available to Investors 

·  Problem: Non-technical managers had challenges gaining insights because it 
required SQL or a reliance on analysts to us e the current dashboard. 

·   Resolution: ShopEase Tamampled Natural Language Querying with Power BI Q&A 
and Tableau Ask Data Managers could now ask questions such as, “Which region saw 
the greatest sales growth last month?” and receive instant visualisations. That 
democratized data to be accessed, which led to quicker reports. 

Problem 2: IneƯicient Inventory Management 
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· Problem: Stockouts and excess inventories occurred frequently because projections 

were made from simple historical-based averages, without regard to seasonal demand 
patterns. 

· Solution: These were solved using AI (Prophet and LSTM based) models. These 
capabilities leveraged seasonality, regional trends and promotional information to 

provide accurate demand forecasting. Consequently, ShopEase cut the majority of its 
excess inventory in just six months. 

Issue 3: Dead and Overloaded Dashboards 

· Problem: Legacy dashboards bombarded users with a host of metrics, without 
context, leaving them unable to make decisions. 

·   Solution: For ShopEase, dashboards were redesigned with best practices in mind— 
well-organized hierarchy, role-specific views and AI-powered narratives. “Executive 
leadership were looking at strategy type KPIs, with predictive analytics; the operations 
team had real time monitoring dashboards. Stories from AI made irregularities less 
abstruse which in turn reduced misinterpretation. 

Reflective Questions 

How did the use of Natural Language Queries decrease ShopEase’s reliance on 
technical analysts? 

What makes AiYield's AI/ML driven forecasting in inventory planning work better than 
just historic averaging? 

How can design principles for dashboards influence user choices? 

What is the diƯerence between executive, operational and analytical dashboards as 
they apply to various levels of an organization? 

What are some of the data quality challenges that ShopEase may encounter by 
employing AI-based predictive tools? 

Conclusion 

ShopEase’s journey is a testament that AI driven dashboards can improve access to 
data, forecasts accuracy and organizational eƯiciency by leaps and bounds. Through 
the addition of natural language queries, predictive forecasting and intelligent 
dashboards, it moved from reactive to proactive decision-making practices. The case 

provides an example of how to apply intelligent process and innovative design in 
combination with new technologies, to derive business value from the visualization of 
data. 
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